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Disclaimers

Alcatel-Lucent products are intended for commercial uses. Without the appropriate network design 
engineering, they must not be sold, licensed or otherwise distributed for use in any hazardous 
environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft 
navigation or communication systems, air traffic control, direct life-support machines, or weapons 
systems, in which the failure of products could lead directly to death, personal injury, or severe physical 
or environmental damage. The customer hereby agrees that the use, sale, license or other distribution 
of the products for any such application without the prior written consent of Alcatel-Lucent, shall be at 
the customer's sole risk. The customer hereby agrees to defend and hold Alcatel-Lucent harmless from 
any claims for loss, cost, damage, expense or liability that may arise out of or in connection with the 
use, sale, license or other distribution of the products in such applications.

This document may contain information regarding the use and installation of non-Alcatel-Lucent 
products. Please note that this information is provided as a courtesy to assist you. While Alcatel-Lucent 
tries to ensure that this information accurately reflects information provided by the supplier, please refer 
to the materials provided with any non-Alcatel-Lucent product and contact the supplier for 
confirmation. Alcatel-Lucent assumes no responsibility or liability for incorrect or incomplete 
information provided about non-Alcatel-Lucent products.

However, this does not constitute a representation or warranty. The warranties provided for 
Alcatel-Lucent products, if any, are set forth in contractual documentation entered into by 
Alcatel-Lucent and its customers.

This document was originally written in English. If there is any conflict or inconsistency between the 
English version and any other version of a document, the English version shall prevail.
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Alcatel-Lucent License Agreement

SAMPLE END USER LICENSE AGREEMENT

1. LICENSE
1.1 Subject to the terms and conditions of this Agreement, Alcatel-Lucent grants 

to Customer and Customer accepts a nonexclusive, nontransferable license to 
use any software and related documentation provided by Alcatel-Lucent 
pursuant to this Agreement ("Licensed Program") for Customer's own internal 
use,  solely in conjunction with hardware supplied or approved by 
Alcatel-Lucent.  In case of equipment failure, Customer may use the Licensed 
Program on a backup system, but only for such limited time as is required to 
rectify the failure.

1.2 Customer acknowledges that Alcatel-Lucent may have encoded within the 
Licensed Program optional functionality and capacity (including, but not 
limited to, the number of equivalent nodes, delegate workstations, paths and 
partitions), which may be increased upon the purchase of the applicable license 
extensions.

1.3 Use of the Licensed Program may be subject to the issuance of an application 
key, which shall be conveyed to the Customer in the form of a Supplement to 
this End User License Agreement. The purchase of a license extension may 
require the issuance of a new application key.

2. PROTECTION AND SECURITY OF LICENSED PROGRAMS
2.1 Customer acknowledges and agrees that the Licensed Program contains 

proprietary and confidential information of Alcatel-Lucent and its third party 
suppliers, and agrees to keep such information confidential.  Customer shall 
not disclose the Licensed Program except to its employees having a need to 
know, and only after they have been advised of its confidential and proprietary 
nature and have agreed to protect same.

2.2 All rights, title and interest in and to the Licensed Program, other than those 
expressly granted to Customer herein, shall remain vested in Alcatel-Lucent or 
its third party suppliers.  Customer shall not, and shall prevent others from 
copying, translating, modifying, creating derivative works, reverse 
engineering, decompiling, encumbering or otherwise using the Licensed 
Program except as specifically authorized under this Agreement.  
Notwithstanding the foregoing, Customer is authorized to make one copy for 
its archival purposes only.  All appropriate copyright and other proprietary 
notices and legends shall be placed on all Licensed Programs supplied by 
Alcatel-Lucent, and Customer shall maintain and reproduce such notices on 
any full or partial copies made by it.

3.  TERM
3.1 This Agreement shall become effective for each Licensed Program upon 

delivery of the Licensed Program to Customer.
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3.2 Alcatel-Lucent may terminate this Agreement: (a) upon notice to Customer if 
any amount payable to Alcatel-Lucent is not paid within thirty (30) days of the 
date on which payment is due; (b) if Customer becomes bankrupt, makes an 
assignment for the benefit of its creditors, or if its assets vest or become subject 
to the rights of any trustee, receiver or other administrator; (c) if bankruptcy, 
reorganization or insolvency proceedings are instituted against Customer and 
not dismissed within 15 days; or (d) if Customer breaches a material provision 
of this Agreement and such breach is not rectified within 15 days of receipt of 
notice of the breach from Alcatel-Lucent. 

3.3 Upon termination of this Agreement, Customer shall return or destroy all 
copies of the Licensed Program.  All obligations of Customer arising prior to 
termination, and those obligations relating to confidentiality and nonuse, shall 
survive termination.

4.  CHARGES
4.1 Upon shipment of the Licensed Program, Alcatel-Lucent will invoice 

Customer for all fees, and any taxes, duties and other charges.  Customer will 
be invoiced for any license extensions upon delivery of the new software 
application key or, if a new application key is not required, upon delivery of 
the extension. All amounts shall be due and payable within thirty (30) days of 
receipt of invoice, and interest will be charged on any overdue amounts at the 
rate of 1 1/2% per month (19.6% per annum).

5.  SUPPORT AND UPGRADES
5.1 Customer shall receive software support and upgrades for the Licensed 

Program only to the extent provided for in the applicable Alcatel-Lucent 
software support policy in effect from time to time, and upon payment of any 
applicable fees.  Unless expressly excluded, this Agreement shall be deemed to 
apply to all updates, upgrades, revisions, enhancements and other software 
which may be supplied by Alcatel-Lucent to Customer from time to time.

6.  WARRANTIES AND INDEMNIFICATION
6.1 Alcatel-Lucent warrants that the Licensed Program as originally delivered to 

Customer will function substantially in accordance with the functional 
description set out in the associated user documentation for a period of 90 days 
from the date of shipment, when used in accordance with the user 
documentation.  Alcatel-Lucent's sole liability and Customer's sole remedy for 
a breach of this warranty shall be Alcatel-Lucent's good faith efforts to rectify 
the nonconformity or, if after repeated efforts Alcatel-Lucent is unable to 
rectify the nonconformity, Alcatel-Lucent shall accept return of the Licensed 
Program and shall refund to Customer all amounts paid in respect thereof.  This 
warranty is available only once in respect of each Licensed Program, and is not 
renewed by the payment of an extension charge or upgrade fee.
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6.2 ALCATEL-LUCENT EXPRESSLY DISCLAIMS ALL OTHER 
WARRANTIES, REPRESENTATIONS, COVENANTS OR CONDITIONS 
OF ANY KIND, WHETHER EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION, WARRANTIES  OR REPRESENTATIONS OF 
WORKMANSHIP, MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, DURABILITY, OR THAT THE OPERATION 
OF THE LICENSED PROGRAM WILL BE ERROR FREE OR THAT THE 
LICENSED PROGRAMS WILL NOT INFRINGE UPON ANY THIRD 
PARTY RIGHTS.

6.3 Alcatel-Lucent shall defend and indemnify Customer in any action to the 
extent that it is based on a claim that the Licensed Program furnished by 
Alcatel-Lucent infringes any patent, copyright, trade secret or other intellectual 
property right, provided that Customer notifies Alcatel-Lucent within ten (10) 
days of the existence of the claim, gives Alcatel-Lucent sole control of the 
litigation or settlement of the claim, and provides all such assistance as 
Alcatel-Lucent may reasonably require.  Notwithstanding the foregoing, 
Alcatel-Lucent shall have no liability if the claim results from any modification 
or unauthorized use of the Licensed Program by Customer, and Customer shall 
defend and indemnify Alcatel-Lucent against any such claim.

6.4 Alcatel-Lucent Products are intended for standard commercial uses.  Without 
the appropriate network design engineering, they must not be sold, licensed or 
otherwise distributed for use in any hazardous environments requiring fail safe 
performance, such as in the operation of nuclear facilities, aircraft navigation 
or communication systems, air traffic control, direct life-support machines, or 
weapons systems, in which the failure of products could lead directly to death, 
personal injury, or severe physical or environmental damage.  The Customer 
hereby agrees that the use, sale, license or other distribution of the Products for 
any such application without the prior written consent of Alcatel-Lucent, shall 
be at the Customer's sole risk.  The Customer also agrees to defend and hold 
Alcatel-Lucent harmless from any claims for loss, cost, damage, expense or 
liability that may arise out of or in connection with the use, sale, license or 
other distribution of the Products in such applications.

7.  LIMITATION OF LIABILITY
7.1 IN NO EVENT SHALL THE TOTAL COLLECTIVE LIABILITY OF 

ALCATEL-LUCENT, ITS EMPLOYEES, DIRECTORS, OFFICERS OR 
AGENTS FOR ANY CLAIM, REGARDLESS OF VALUE OR NATURE, 
EXCEED THE AMOUNT PAID UNDER THIS AGREEMENT FOR THE 
LICENSED PROGRAM THAT IS THE SUBJECT MATTER OF THE 
CLAIM.  IN NO EVENT SHALL THE TOTAL COLLECTIVE LIABILITY 
OF ALCATEL-LUCENT, ITS EMPLOYEES, DIRECTORS, OFFICERS OR 
AGENTS FOR ALL CLAIMS EXCEED THE TOTAL AMOUNT PAID BY 
CUSTOMER TO ALCATEL-LUCENT HEREUNDER.  NO PARTY SHALL 
BE LIABLE FOR ANY INDIRECT, SPECIAL OR CONSEQUENTIAL 
DAMAGES, WHETHER OR NOT SUCH DAMAGES ARE 
FORESEEABLE, AND/OR THE PARTY HAD BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

7.2 The foregoing provision limiting the liability of Alcatel-Lucent's employees, 
agents, officers and directors shall be deemed to be a trust provision, and shall 
be enforceable by such employees, agents, officers and directors as trust 
beneficiaries.
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8.  GENERAL
8.1 Under no circumstances shall either party be liable to the other for any failure 

to perform its obligations (other than the payment of any monies owing) where 
such failure results from causes beyond that party's reasonable control.

8.2 This Agreement constitutes the entire agreement between Alcatel-Lucent and 
Customer and supersedes all prior oral and written communications.  All 
amendments shall be in writing and signed by authorized representatives of 
both parties.

8.3 If any provision of this Agreement is held to be invalid, illegal or 
unenforceable, it shall be severed and the remaining provisions shall continue 
in full force and effect.

8.4 The Licensed Program may contain freeware or shareware obtained by 
Alcatel-Lucent from a third party source.  No license fee has been paid by 
Alcatel-Lucent for the inclusion of any such freeware or shareware, and no 
license fee is charged to Customer for its use.  The Customer agrees to be 
bound by any license agreement for such freeware or shareware. CUSTOMER 
ACKNOWLEDGES AND AGREES THAT THE THIRD PARTY SOURCE 
PROVIDES NO WARRANTIES AND SHALL HAVE NO LIABILITY 
WHATSOEVER IN RESPECT OF CUSTOMER'S POSSESSION AND/OR 
USE OF THE FREEWARE OR SHAREWARE.

8.5 Alcatel-Lucent shall have the right, at its own expense and upon reasonable 
written notice to Customer, to periodically inspect Customer's premises and 
such documents as it may reasonably require, for the exclusive purpose of 
verifying Customer's compliance with its obligations under this Agreement.

8.6 All notices shall be sent to the parties at the addresses listed above, or to any 
such address as may be specified from time to time.  Notices shall be deemed 
to have been received five days after deposit with a post office when sent by 
registered or certified mail, postage prepaid and receipt requested.

8.7 If the Licensed Program is being acquired by or on behalf of any unit or agency 
of the United States Government, the following provision shall apply:  If the 
Licensed Program is supplied to the Department of Defense, it shall be 
classified as "Commercial Computer Software" and the United States 
Government is acquiring only "restricted rights" in the Licensed Program as 
defined in DFARS 227-7202-1(a) and 227.7202-3(a), or equivalent.  If the 
Licensed Program is supplied to any other unit or agency of the United States 
Government, rights will be defined in Clause 52.227-19 or 52.227-14 of the 
FAR, or if acquired by NASA, Clause 18-52.227-86(d) of the NASA 
Supplement to the FAR, or equivalent.  If the software was acquired under a 
contract subject to the October 1988 Rights in Technical Data and Computer 
Software regulations, use, duplication and disclosure by the Government is 
subject to the restrictions set forth in DFARS 252-227.7013(c)(1)(ii) 1988, or 
equivalent.

8.8 Customer shall comply with all export regulations pertaining to the Licensed 
Program in effect from time to time. Without limiting the generality of the 
foregoing, Customer expressly warrants that it will not directly or indirectly  
export, reexport, or transship the Licensed Program in violation of any export 
laws, rules or regulations of Canada, the United States or the United Kingdom.
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8.9 No term or provision of this Agreement shall be deemed waived and no breach 
excused unless such waiver or consent is in writing and signed by the party 
claimed to have waived or consented.  The waiver by either party of any right 
hereunder, or of the failure to perform or of a breach by the other party, shall 
not be deemed to be a waiver of any other right hereunder or of any other 
breach or failure by such other party, whether of a similar nature or otherwise.

8.10 This Agreement shall be governed by and construed in accordance with the 
laws of the Province of Ontario.  The application of the United Nations 
Convention on Contracts for the International Sale of Goods is hereby 
expressly excluded.
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Preface

The Preface provides general information about the 5620 Service Aware Manager 
documentation suite, including this guide. 

Prerequisites

Readers of the 5620 SAM documentation suite are assumed to be familiar with the 
following:

• 5620 SAM software structure and components
• 5620 SAM GUI operations and tools
• typical 5620 SAM management tasks and procedures
• device and network management concepts

5620 SAM documentation suite

The 5620 SAM documentation suite describes the 5620 SAM and the associated 
network management of its supported devices. Contact your Alcatel-Lucent support 
representative for information about specific network or facility considerations. 

Table 1 lists the documents in the 5620 SAM customer documentation suite. 

Table 1  5620 SAM customer documentation suite

Guide Description

5620 SAM core documentation

5620 SAM Release 
Description

The 5620 SAM Release Description provides information about the new features 
associated with a 5620 SAM software release.

(1 of 4)
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5620 SAM Planning Guide The 5620 SAM Planning Guide provides information about 5620 SAM scalability and 
recommended hardware configurations.

5620 SAM System 
Architecture Guide

The 5620 SAM System Architecture Guide is intended for technology officers and network 
planners to increase their knowledge of the 5620 SAM software structure and 
components. It describes the system structure, software components, and interfaces of 
the 5620 SAM. In addition, 5620 SAM fault tolerance, security, and network management 
capabilities are discussed from an architectural perspective.

5620 SAM | 5650 CPAM 
Installation and Upgrade 
Guide

The 5620 SAM | 5650 CPAM Installation and Upgrade Guide provides OS considerations, 
configuration information, and procedures for the following:
• installing, upgrading, and uninstalling 5620 SAM and 5650 CPAM software in 

standalone and redundant deployments
• 5620 SAM system migration to a different system
• conversion from a standalone to a redundant 5620 SAM system

5620 SAM User Guide The 5620 SAM User Guide provides information about using the 5620 SAM to manage the 
service-aware IP/MPLS network, including GUI basics, commissioning, service 
configuration, and policy management.
The 5620 SAM User Guide uses a task-based format. Each chapter contains:
• a workflow that describes the steps for configuring and using the functions
• detailed procedures that list the configurable parameters on the associated forms

5620 SAM management information specific to LTE network elements is covered in the 
5620 SAM LTE ePC User Guide and 5620 SAM LTE RAN User Guide.
5620 SAM management information specific to 1830 PSS network elements is covered in 
the 5620 SAM Optical User Guide.

5620 SAM Integration 
Guide 

The 5620 SAM Integration Guide provides procedures to allow the 5620 SAM to integrate 
with additional components.

5620 SAM Supervision 
Module User Guide

The 5620 SAM Supervision Module User Guide provides information about how to 
configure and use the web-based 5620 SAM Supervision Module for fault management 
and at-a-glance network element monitoring.

5620 SAM Scripts and 
Templates Developer Guide

The 5620 SAM Scripts and Templates Developer Guide provides information that allows 
users to develop, manage, and execute CLI-based or XML-based scripts or templates.
The guide is intended for developers, skilled administrators, and operators who are 
expected to be familiar with the following:
• CLI scripting, XML, and the Velocity engine
• basic scripting or programming
• 5620 SAM functions

5620 SAM Parameter Guide The 5620 SAM Parameter Guide provides:
• parameter descriptions that include value ranges and default values
• parameter options and option descriptions
• parameter and option dependencies
• parameter mappings to the 5620 SAM-O XML equivalent property names

There are dynamic links between the procedures in the 5620 SAM User Guide and the 
parameter descriptions in the 5620 SAM Parameter Guide.
Parameters specific to LTE network elements are covered in the 5620 SAM LTE Parameter 
Reference.
Parameters specific to 1830 PSS network elements are covered in the 5620 SAM Optical 
Parameter Reference.

5620 SAM Statistics 
Management Guide

The 5620 SAM Statistics Management Guide provides information about how to configure 
performance and accounting statistics collection and how to view counters using the 
5620 SAM. Network examples are included.

Guide Description

(2 of 4)
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5620 SAM Maintenance 
Guide

The 5620 SAM Maintenance Guide provides procedures for:
• generating baseline information for 5620 SAM applications
• performing daily, weekly, monthly, and as-required maintenance activities for 

5620 SAM-managed networks

5620 SAM Troubleshooting 
Guide

The 5620 SAM Troubleshooting Guide provides task-based procedures and user 
documentation to:
• help resolve issues in the managed and management networks
• identify the root cause and plan corrective action for:

• alarm conditions on a network object or customer service
• problems on customer services with no associated alarms

• list problem scenarios, possible solutions, and tools to help check:
• network management LANs
• network management platforms and operating systems
• 5620 SAM client GUIs and client OSS applications
• 5620 SAM servers
• 5620 SAM databases

5620 SAM Alarm Reference The 5620 SAM Alarm Reference provides a description of all alarms supported on the 
5620 SAM, including LTE and optical alarms, the raising and clearing conditions of each 
alarm, and the remedial action to fix the problem. The reference is organized by network 
element type.

5620 SAM Glossary The 5620 SAM Glossary defines terms and acronyms used in all of the 5620 SAM 
documentation, including 5620 SAM LTE documentation.

5620 SAM Network 
Element Compatibility 
Guide

The 5620 SAM Network Element Compatibility Guide provides release-specific information 
about the compatibility of managed devices in 5620 SAM releases. This document is 
updated regularly; always consult the latest version on OLCS as described in 
Documentation and resources on the web.

5620 SAM LTE documentation

5620 SAM LTE Release 
Description

The 5620 SAM LTE Release Description provides information about the LTE features 
associated with the release.

5620 SAM LTE ePC User 
Guide 

The 5620 SAM LTE ePC User Guide describes how to discover, configure, and manage LTE 
ePC devices using the 5620 SAM. The guide is intended for LTE ePC network planners, 
administrators, and operators and is to be used in conjunction with other guides in the 
5620 SAM documentation suite where management of ePC devices does not differ from 
other network elements. 
Alcatel-Lucent recommends that you review the entire 5620 SAM LTE ePC User Guide 
before you attempt to use the 5620 SAM in your LTE network.

5620 SAM LTE RAN User 
Guide 

The 5620 SAM LTE RAN User Guide describes how to discover, configure, and manage 
the Evolved NodeB, or eNodeB, using the 5620 SAM. The guide is intended for LTE RAN 
network planners, administrators, and operators and is to be used in conjunction with 
other guides in the 5620 SAM documentation suite where management of RAN devices 
does not differ from other network elements.
Alcatel-Lucent recommends that you review the entire 5620 SAM LTE RAN User Guide 
before you attempt to use the 5620 SAM in your LTE network.

5620 SAM LTE Parameter 
Reference 

The 5620 SAM LTE Parameter Reference provides a list of all LTE ePC and LTE RAN 
parameters supported in the 5620 SAM. 

5620 SAM-O documentation

5620 SAM XML OSS 
Interface Developer Guide

The 5620 SAM XML OSS Interface Developer Guide provides information that allows you 
to:
• use the 5620 SAM XML OSS interface to access network management information
• learn about the information model associated with the managed network
• develop OSS applications using the packaged methods, classes, data types, and 

objects necessary to manage 5620 SAM functions

Guide Description

(3 of 4)
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Obtaining customer documentation

You can obtain 5620 SAM customer documentation:

• from the product
• on the web 

On-product documentation
The 5620 SAM on-product customer documentation is delivered in HTML and PDF. 
Choose Help→User Documentation from the 5620 SAM client GUI to open the help 
system in a web browser.

The help system opens to the User Documentation Index, which provides a summary 
of and links to all 5620 SAM customer documents. 

Click on the Using the help system tab on the User Documentation Index page to find 
usage tips for navigating and searching within the on-product customer 
documentation.

You can return to the User Documentation Index at any time by clicking on the Home 
icon, shown in Figure 1.

5620 SAM 3GPP OSS 
Interface Developer Guide

The 5620 SAM 3GPP OSS Interface Developer Guide describes the components and 
architecture of the 3GPP OSS interface to the 5620 SAM. It includes procedures and 
samples to assist OSS application developers to use the 3GPP interface to manage LTE 
devices.

5620 SAM 3GPP OSS 
Interface Compliance 
Statements

The 5620 SAM 3GPP OSS Interface Compliance Statements document describes the 
compliance of the 5620 SAM 3GPP OSS interface with the 3GPP standard.

5620 SAM optical documentation

5620 SAM Optical User 
Guide

The 5620 SAM Optical User Guide describes how to discover, configure, and manage 
optical devices using the 5620 SAM. The guide is intended for optical network planners, 
administrators, and operators and is to be used in conjunction with other guides in the 
5620 SAM documentation suite where management of optical devices does not differ from 
other network elements.
Alcatel-Lucent recommends that you review the entire 5620 SAM Optical User Guide 
before you attempt to use the 5620 SAM in your network.

5620 SAM Optical 
Parameter Reference

The 5620 SAM Optical Parameter Reference provides a list of all optical device parameters 
supported in the 5620 SAM.

5650 CPAM documentation

5650 CPAM User Guide The 5650 CPAM User Guide describes how to capture, inspect, visualize, and troubleshoot 
IGP and BGP topologies using the 5650 CPAM.

7701 CPAA Hardware 
Revision 1 Setup and 
Software Installation 
Instructions

The 7701 CPAA Hardware Revision 2 Setup and Software Installation Instructions 
describes the hardware setup and software installation for the 7701 CPAA Hardware 
Revision 1, the route analyzer component of the 5650 CPAM. 

7701 CPAA Hardware 
Revision 2 Setup and 
Software Installation 
Instructions

The 7701 CPAA Hardware Revision 2 Setup and Software Installation Instructions 
describes the hardware setup and software installation for the 7701 CPAA Hardware 
Revision 2, the route analyzer component of the 5650 CPAM. 

Guide Description

(4 of 4)
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Figure 1  Home icon

Documentation and resources on the web
The 5620 SAM customer documentation is available for download in PDF format 
from the Alcatel-Lucent Customer Support Center: 
http://www.alcatel-lucent.com/myaccess. If you are a new user and require access to 
this service, please contact your Alcatel-Lucent support representative.

In addition to the guides listed in Table 1, Release Notices and other documents not 
delivered on-product are posted to this site.

5620 SAM product alerts

Product technical alerts are used to communicate important information to customers 
about released loads. You can view and subscribe to product alerts for the 5620 SAM 
from the Alcatel-Lucent Customer Support Center. 

Working with PDFs

You can download PDFs of individual guides from the Alcatel-Lucent Customer 
Support Center, or you can choose to download a zip of all PDFs for a particular 
release.

You can use the Search function of Acrobat Reader (File→Search) to find a term in 
a PDF of any 5620 SAM document. To refine your search, use appropriate search 
options (for example, search for whole words only or enable case-sensitive 
searching). You can also search for a term in multiple PDFs at once, provided that 
they are located in the same directory. For more information, see the Help for 
Acrobat Reader.

Cross-book hotlinks, for example, from a parameter name in the 5620 SAM User 
Guide to a description of that parameter in the 5620 SAM Parameter Guide, work 
only if both PDF files are in the same directory.

Documentation conventions

Table 2 lists the conventions that are used throughout the documentation.

Note �  Users of Mozilla browsers may receive an error message 
when opening the PDF files in the 5620 SAM documentation suite. 
The offline storage and default cache values used by the browsers are 
the cause of the error message.

Alcatel-Lucent recommends changing the Mozilla Firefox offline 
storage or Mozilla 1.7 cache value to 100 Mbytes to eliminate the 
error message.

http://www.alcatel-lucent.com/myaccess
https://alerts.alcatel-lucent.com/alerts/alerts.cgi?fn=ListProductAlerts;Product=1-0000000002372;AlertClass=
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Table 2  Documentation conventions

Procedures with options or substeps
When there are options in a procedure, they are identified by letters. When there are 
substeps in a procedure, they are identified by Roman numerals.

Example of options in a procedure

At step 1, you can choose option a or b. At step 2, you must do what the step 
indicates.

1 This step offers two options. You must choose one of the following.

a This is one option.

b This is another option.

2 You must perform this step.

Example of substeps in a procedure

At step 1, you must perform a series of substeps within a step. At step 2, you must 
do what the step indicates.

1 This step has a series of substeps that you must perform to complete the step. You 
must perform the following substeps.

i This is the first substep.

ii This is the second substep.

iii This is the third substep.

2 You must perform this step.

Convention Description Example

Key name Press a keyboard key Delete

Italics Identifies a variable hostname

Key+Key Type the appropriate consecutive keystroke sequence CTRL+G

Key�Key Type the appropriate simultaneous keystroke sequence CTRL�G

* An asterisk is a wildcard character, which means �any 
character� in a search argument.

log_file*.txt

↵ Press the Return key ↵

� An em dash indicates there is no information. �

→ Indicates that a cascading submenu results from selecting a 
menu item

Policies→Alarm 
Policies
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Measurement conventions
Measurements in this document are expressed in metric units and follow the Système 
international d’unités (SI) standard for abbreviation of metric units. If imperial 
measurements are included, they appear in brackets following the metric unit. 

Table 3 lists the measurement symbols used in this document.

Table 3  Bits and bytes conventions

Important information
The following conventions are used to indicate important information:

Measurement Symbol

bit b

byte byte

kilobits per second kb/s

Warning �  Warning indicates that the described activity or situation 
may, or will, cause equipment damage or serious performance 
problems.

Caution �  Caution indicates that the described activity or situation 
may, or will, cause service interruption.

Note �  Notes provide information that is, or may be, of special 
interest.
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1.1 Overview of the 1830 PSS

The 5620 SAM supports the 1830 PSS product family of devices which includes:

• 1830 PSS-32–central office device
• 1830 PSS-16–end office device
• 1830 PSS-4–edge device platform
• 1830 PSS-1–edge aggregation devices that collect lower rate signals for input to 

the 1830 PSS network. These include:
• 1830 PSS-1 GBE edge device
• 1830 PSS-1 MD4H edge device
• 1830 PSS-1 AHP amplifier

See the chapter 5620 SAM 10.0 compatibility with 1830 PSS in the 5620 SAM 
Network Element Compatibility Guide for more information on supported releases 
for the 1830 PSS devices.

The 1830 Photonic Service Switch (PSS) product family provides increased network 
flexibility and operational automation using zero-touch, transparent photonic 
networking. Photonic networks use simplified and accelerated operations to 
transform WDM into true transport networking with advanced flexibility, 
performance, automation, and integration.

1830 PSS-32 central office device/1830 PSS-16 end office device
The 1830 PSS-32 and 1830 PSS-16 are closely related shelves that provide 
multi-service and multi-reach solutions. The shelves are referred to collectively as 
the 1830 PSS-32/1830 PSS-16. They are scalable optical transport platforms for 
regional and metropolitan network transport and services delivery. 

• The 1830 PSS-32 central office device provides a 32-slot platform for core, 
central office applications.

• The 1830 PSS-16 end office device provides a 16-slot platform that can be used 
for end office or smaller core office applications.

For specific information about the hardware and capabilities supported by the 
shelves, see the Alcatel-Lucent 1830 Photonic Service Switch 32/16 Product 
Information and Planning Guide for more information.

The 1830 PSS-32 is designed as a highly modular metropolitan WDM platform to 
cost-effectively meet the requirements of initial network demands while 
simultaneously ready for upgrade to meet future demands. At the same time, it 
employs advanced “Zero Touch Photonics” management and control features, 
simplifying WDM system management so that it approaches the ease-of-use 
associated only with SDH/SONET technology.

The 1830 PSS-32 network consists of single, standalone NE, or two or more 
interconnected NEs that provide SDH/SONET/GigE aggregation and transport, 
10G, FC (R1.1), or transponderless wavelength services in a metropolitan or regional 
networking environment.
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The 1830 PSS-32 and 1830 PSS-16 support bidirectional transmission over a single 
fiber. These devices can be configured to support applications using CWDM filters. 
Each bidirectional transmission requires different CWDM wavelengths in each 
direction. Bidirectional transmissions over a single fiber is supported with the 
following filters and OTs:

See the Alcatel-Lucent 1830 Photonic Service Switch 36/32/16 Product Information 
and Planning Guide and the Alcatel-Lucent 1830 Photonic Service Switch 36/32/16 
(PSS-36/PSS-32/PSS-16) User Provisioning Guide for more information.

1830 PSS-4 edge device platform
The 1830 PSS-4 edge device platform is designed for installation near the edge of the 
metropolitan networks. The edge device platform is designed to provide a flexible, 
power saving, OTN-based solution for metro and access applications. The target 
application provides OTN based multiple service aggregation for CWDM and 
DWDM networks. The application can also be configured to provide an FOADM 
terminal, and in-line amplifier solution for the 1830 PSS-32 networks. The platform 
supports non-switched and electrical switched configurations, and ensures full 
interworking and compatibility with other 1830 PSS product platforms.

The 1830 PSS-4 supports bidirectional transmission over a single fiber. See the 
Alcatel-Lucent 1830 Photonic Service Switch 36/32/16 Product Information and 
Planning Guide and the Alcatel-Lucent 1830 Photonic Service Switch 36/32/16 
(PSS-36/PSS-32/PSS-16) User Provisioning Guide for more information. 

See the Alcatel-Lucent 1830 Photonic Service Switch 4 (PSS-4) User Guide for more 
information.

1830 PSS-1 GBE edge device
The 1830 PSS-1 GBE edge device is a 1-Rack-Unit (1-RU) device for installation in 
19-in., ANSI, or ETSI racks. The device is based on a 12xGBE optical transponder 
that supports optional coarse wavelength division multiplexing (CWDM) filters.

The 1830 PSS-1 GBE edge device provides an optimized WDM access platform that 
includes the following features:

• 1-RU height
• dc power (ac power adapter available)
• standard or temperature-hardened versions

• standard 1830 PSS-1 GBE 
• hardened 1830 PSS-1 GBEH 

• Black & White (B&W), CWDM, or DWDM optics
• in-band management using GCC
• stackable as a single NE

• SFC-2
• SFC-4
• SFC-8
• 4DPA4

• 11STAR1
• 11STAR1A
• 11STMM10
• 11DPE12(E)
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• alignment with the 1830 PSS service cards and operations
• support for single-fiber bidirectional transmission

See the 1830 Photonic Service Switch 1 (PSS-1) GBEH Edge Device User Guide for 
more information.

1830 PSS-1 MD4H edge device
The 1830 PSS-1 MD4H edge device is a 1-RU device for installation in 19-in., 
ANSI, or ETSI racks. The MD4H designation represents the device as a multiservice 
dual module unit with 4 client ports per module, which is temperature hardened. The 
device is based on two 1830 PSS-32 4DPA4 optical transponders, which are 
remapped into an external device that also supports optional CWDM filters.

The 1830 PSS-1 MD4H edge device provides an optimized WDM access platform 
that includes the following features:

• 1-RU height
• dc power (ac power adapter available)
• standard or temperature-hardened versions
• Black & White (B&W), CWDM, or DWDM optics
• in-band management using GCC
• alignment with the 1830 PSS service cards and operations
• support for single-fiber bidirectional transmission

See the Alcatel-Lucent 1830 Photonic Service Switch 1 (PSS-1) MD4H Edge Device 
User Guide for more information.

1830 PSS-1 AHP amplifier
The 1830 PSS-1 AHP is a 1-RU edge device that supports a specially adapted 
amplifier. Two 1830 PSS-1 AHP devices can be used to provide a low cost in-line 
amplifier, or ILA, for the 1830 PSS. The 1830 PSS-1 AHP amplifier software 
provides the following enhanced capabilities:

• multi-shelf NE management
• IP routing (OSPF) over OSC links
• wave key assignment distribution over OSPF LSAs
• automatic/manual power management between devices
• keyed-unkeyed DWDM OCH XC provisioning and OCH trail management
• DCM shelf/card/port management

See the Alcatel-Lucent 1830 Photonic Service Switch 1 (PSS-1) AHP Amplifier User 
Guide for more information.
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1.2 Component configuration

Before you can use the 5620 SAM to manage one or more 1830 PSS devices, the 
required 1830 PSS modules and quantities must be included in the 5620 SAM 
software license. See the chapter 5620 SAM component configuration of the 
5620 SAM User Guide for information about viewing and updating the license 
information.

1.3 About this guide

This guide provides information about how to access the 5620 SAM to configure and 
manage the 1830 PSS network. The 5620 SAM guides describe the GUI operations 
associated with each function, and indicate whether the function is available, using 
the OSSI. See the 5620 SAM XML OSS Interface Developer Guide for information 
about using the OSSI to perform a 5620 SAM function. This guide is intended for 
optical network planners, administrators, and operators and is to be used in 
conjunction with other guides in the 5620 SAM documentation suite where 
management of optical devices does not differ from other network elements. 
Procedures that are unique to managing the 1830 PSS are included in this document 
and make reference to configurable parameters described in the 5620 SAM Optical 
Parameter Reference.

This document describes the features, and configurations, for the 1830 PSS-32, 
1830 PSS-16 and 1830 PSS-4 as well as their hardware components, NEs, and 
networks. See the Alcatel-Lucent 1830 Photonic Service Switch 36/32/16 Product 
Information and Planning Guide and the Alcatel-Lucent 1830 Photonic Service 
Switch 4 (PSS-4) User Guide for more information.

A high-level overview of the 1830 PSS-1 edge devices is included. For more 
information about the 1830 PSS-1 edge devices, see the Alcatel-Lucent 
1830 Photonic Service Switch 1 (PSS-1) GBEH Edge Device User Guide, the 
Alcatel-Lucent 1830 Photonic Service Switch 1 (PSS-1) MD4H Edge Device User 
Guide, and the Alcatel-Lucent 1830 Photonic Service Switch 1 (PSS-1) AHP 
Amplifier User Guide.

This guide contains the following volumes:

• Getting started—contains the following general and system management 
1830 PSS information:

• a system overview
• features supported
• GUI map management
• user security

• Device management—contains information about device functions that are not 
directly related to networking, such as the following:

• device support
• preparing devices for 5620 SAM management
• 5620 SAM device and equipment management functions

• Network management—contains the following information about network 
functions:

• general routing and forwarding
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• Service management—contains information about managing customer services, 
such as the following:

• service creation and configuration
• customer and subscriber management
• service verification, troubleshooting, and root-cause analysis
• scheduling of routine, service-related operations

• Maintenance—contains information about fault and alarm management.

1.4 1830 PSS reference documentation

See the following documents for more information about the 1830 PSS:

• Alcatel-Lucent 1830 Photonic Service Switch 1 (PSS-1) GBEH Edge Device User 
Guide

• Alcatel-Lucent 1830 Photonic Service Switch 1 (PSS-1) MD4H Edge Device 
User Guide

• Alcatel-Lucent 1830 Photonic Service Switch (PSS-1) AHP Amplifier User Guide
• Alcatel-Lucent 1830 Photonic Service Switch 4 (PSS-4) User Guide
• Alcatel-Lucent 1830 Photonic Service Switch User Provisioning Guide
• Alcatel-Lucent 1830 Photonic Service Switch Product Information and Planning 

Guide
• Alcatel-Lucent 1830 Photonic Service Switch Maintenance and 

Trouble-Clearing Guide
• Alcatel-Lucent 1830 Photonic Service Switch 32/16 (PSS-32/PSS-16) 

Installation and System Turn-Up Guide
• Alcatel-Lucent 1830 Photonic Service Switch (PSS) Safety Guide
• Alcatel-Lucent 1830 Photonic Service Switch (PSS) Command Line Interface 

Guide
• Alcatel-Lucent 1830 Photonic Service Switch (PSS) TL1 Commands and 

Messages Guide
• Alcatel-Lucent 1830 Photonic Service Switch (PSS) Engineering and Planning 

Tool User Guide
• Alcatel-Lucent 1830 Photonic Service Switch (PSS) Commissioning and Power 

Balancing Tool User Guide
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2.1 1830 PSS features for 5620 SAM Release 10.0

Table 2-1 lists the features and functions added in the 5620 SAM, Release 10.0 for 
1830 PSS support. See the 5620 SAM User Guide for more information about 
non-1830 PSS features and functions.

Table 2-1 5620 SAM Release 10.0 1830 PSS features

Feature Description Reference 

Release 10.0 R7 1830 PSS features
No Optical features have been added in this release.

Release 10.0 R6 1830 PSS features
No Optical features have been added in this release.

Release 10.0 R5 1830 PSS features

Automatic power 
adjustment using 
WR8-88

The 5620 SAM supports automatic power adjustment for a 
service involving a drop shelf OT of an 1830 PSS or SR that is 
connected to the WR8-88 card in a ROADM or AnyDirection 
configuration.

See Procedure 12-16.

Optical transport 
service support for 
7950 XRS

The 5620 SAM supports optical transport services between 
two 7950 XRS through one or more interconnected 1830 PSS.

See section 12.1.

Resync indicator icon Some of the read-only parameters in the 5620 SAM are 
represented by the resync icon that is beside the parameter. 

See Resynchronization of 
objects in section 8.4.

QoS policy support for 
11QPE24 cards

The 5620 SAM supports the following QoS policies on 
11QPE24 cards:
• Service Ingress
• Access Egress
• Network
• Network Queue
• Port Scheduler

See section 5.8 and 5.9. See the 
5620 SAM Optical Parameter 
Reference and the 5620 SAM 
User Guide.

11DPE12A card service 
support

The 5620 SAM supports the following enhancements on 
11DPE12A cards:
• Push-Pop for QinQ service stack-VLAN tagging 

configuration
• ESNCP 
• configuration of SyncE
• line SVID and VLAN protection

See Procedures 8-4 and 12-1.

LAG support The 5620 SAM provides equipment level support for the 
creation of LAGs on the following cards:
• 11DPE12A
• 11QPE24

See Procedures 8-18 and 8-19.

MVAC service support The 5620 SAM allows you to create a service by selecting the 
following on the MVAC:
• A end - MVAC client port
• Z end - MVAC client port

See Procedure 12-1 for 
information about optical 
transport service creation.

Power management The 5620 SAM allows you to terminate the automatic power 
adjustment process in the power graph window.

See Procedure 12-16

(1 of 9)
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OPS protection for the 
100 Gb/s OT cards

The 5620 SAM supports OPS service creation on the 
1830 PSS-32, Release 5.1 or later, for the following 100 Gb/s 
OT cards:
• 112SNX10
• 112SNA1 
• 112SCA1 
• 112SCX10 

See Procedure 12-1 for 
information about optical 
transport service creation.

ESNCP support on 
11DPE12 and 11DPE12E

The 5620 SAM supports lines-side ESNCP on the 11DPE12 and 
the 11DPE12E cards only when there are more than two line 
ports. The ADM supports this configuration.

See Procedure 12-1 for 
information about optical 
transport service creation.

New performance 
statistics counters

The following performance statistics counters are added in 
the 5620 SAM:
• FECVL
• FEESL
• FESESL
• FEUASL

See the 5620 SAM Statistics 
Management Guide.

SVAC card service 
support

The 5620 SAM allows you to create service by selecting the 
client port, C1 of the SVAC card as the termination point:
• A end - SVAC client port
• Z end - SVAC client port

See Procedure 12-1 for 
information about optical 
transport service creation.

SubGigE Full Rate 
service support on 
11DPE12E cards

The 5620 SAM supports the SubGigE Full Rate service on 
11DPE12E cards.

See Procedure 12-1 for 
information about optical 
transport service creation.

MVAC8B cards service 
support

The 5620 SAM supports the following protection types on 
MVAC8B card:
• Unprotected 
• OPS Protected 

The 5620 SAM allows you to create service using any 
combination of the following cards:
• MVAC
• MVAC8B 
• SVAC

See chapter 8.
See the 5620 SAM Optical 
Parameter Reference.

Optical channel usage The 5620 SAM allows you to view the optical channel usage. See Procedure 12-22
See the 5620 SAM Optical 
Parameter Reference.

Multipoint transport 
service 

The 5620 SAM supports the creation of the following 
multipoint transport services on the 11DPM12 card based on 
the type of protection:
• Unprotected 
• ESNCP

The 5620 SAM supports the addition and deletion of 
termination points on the drop and continue sites of the 
protected and the unprotected multipoint transport service. 
The 5620 SAM also supports the addition and deletion of drop 
sites on an unprotected multipoint transport service.

See Procedures 12-2, 12-3, and 
12-4
See the 5620 SAM Optical 
Parameter Reference.

Service discovery 
without XC

The 5620 SAM supports service creation, deletion, and 
discovery without XCs.

See Procedures 12-1 and 12-11. 
See the 5620 SAM Optical 
Parameter Reference.

Feature Description Reference 
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Electrical SDIs for 
4DPA4 and 11DPM12 on 
1830 PSS-4

The 5620 SAM allows provisioning of the pluggable module 
type �User� to support the electrical HDSDI and SDSDI for 
4DPA4, and the electrical HDSDI, SDSDI and 3GSDI for 
11DPM12 on the 1830 PSS-4.

See the 5620 SAM Optical 
Parameter Reference.

Display laser bias 
current and laser 
temperature

The 5620 SAM displays the real-time laser bias current and 
laser temperature on TMN for the cards listed below. The 
values for the parameters can be refreshed by clicking 
Resync.
• A2325A
• AHPLG
• AHPHG
• 11QPA4
• 43STX4P
• 11STAR1
• 43STA1P
• 11DPE12E
• 11DPM12
• AM212

See the 5620 SAM Optical 
Parameter Reference.

Transmission card 
support

The 5620 SAM supports the following transmission cards:
• 11STAR1A
• MVAC8B
• 43SCX4E
• 43SCGE1
• 11QPE24
• 11QPEN4
• WR2-88
• WR8-88AF
• 11DPE12A

See chapter 8.
See the 5620 SAM Optical 
Parameter Reference.

GCC0 channel type 
support on client and 
line ports

The 5620 SAM supports GCC0 channel type on client and line 
ports on the 11STAR1 card.

See Procedure 8-10. 
See the 5620 SAM Optical 
Parameter Reference.

11STAR1A card support The 5620 SAM supports Y-Cable, OPSA protection switching 
and provisioning on the 11STAR1A card on the 1830 PSS-16 
and the 1830 PSS-32 devices.

See chapters 8 and 12.
See the 5620 SAM Optical 
Parameter Reference.

 CWDM-FOADM support The 5620 SAM supports provisioning, discovery and 
topological view of CWDM-FOADM in the 1830 PSS-1 GBEH 
and MD4H devices.

See section 12.1.

Y-cable support The 5620 SAM supports Y-cable on the 1830 PSS-16 and 
1830 PSS-32 devices for the following working and protection 
OT cards:
• 43SCX4E (double width variant card) - supports only 

1830 PSS-32 device
• 11QPEN4

See chapters 8 and 12.

11QPEN4 card support The 5620 SAM supports Y-Cable, OPS, E-SNCP protection 
switching and provisioning on the 11QPEN4 card on the 
1830 PSS-4, 1830 PSS-16, and 1830 PSS-32 devices.

See chapters 8 and 12.

11QPE24 card support The 5620 SAM supports the following services on the 11QPE24 
card on the 1830 PSS-4, 1830 PSS-16, and 1830 PSS-32 
devices: 
• performance monitoring
• fault management for Ethernet
• OTN and FDB management

See chapter 8. See section 12.5 
for information about port 
mirroring. 
See the 5620 SAM User Guide

Feature Description Reference 
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Extension shelves The 5620 SAM supports up to eight extension shelves on the 
1830 PSS-16.

See chapter 8.

SyncE support The 5620 SAM supports the configuration of SyncE, with SSM 
enabled on the 11DPE12E card that is installed on the 
1830 PSS-16, and 1830 PSS-32, Release 5.0 or later.
The 5620 SAM supports the configuration of SyncE, with SSM 
enabled on the 11DPE12A and the 11QPE24 cards that are 
installed on the 1830 PSS-4, 1830 PSS-16, and 1830 PSS-32, 
Release 5.1 or later.

See Procedure 8-4. See the 
5620 SAM Optical Parameter 
Reference.

L2 ACL management The 5620 SAM supports L2 ACL management on the 11QPE24 
card on the 1830 PSS-4, 1830 PSS-16 and 1830 PSS-32 
devices.

See the 5620 SAM User Guide.

Ethernet ring 
protection (G.8032) 

The 5620 SAM supports ethernet ring protection on the 
11QPE24 card on the 1830 PSS-32, 1830 PSS-16 and 
1830 PSS-4 devices. The 5620 SAM supports the automatic 
creation of control and data services for Ethernet (G.8032) 
rings. The following functionality is supported on the ERP:
• Ethernet ring element 
• Ethernet ring path endpoints
• Global ethernet ring
• Global path elements
• Service provisioning using G8032 for ethernet rings

See section 11.2. See the 
5620 SAM User Guide. See the 
5620 SAM Parameter Guide.

IGMPv2 snooping The 5620 SAM supports IGMPv2 snooping on the 11QPE24 card 
on the 1830 PSS-32, 1830 PSS-16 and 1830 PSS-4 devices.

See chapter 10. See the 
5620 SAM User Guide. 

Ethernet services The 5620 SAM supports the provisioning of Ethernet point to 
point and multipoint transport services accross the transport 
network and port mirroring and creation of VPLS services on 
the 11QPE24 card on the 1830 PSS-32, 1830 PSS-16 and 
1830 PSS-4 devices. 

See section 12.5.

Ethernet OAM The 5620 SAM supports Ethernet OAM functions on the 
11QPE24 card on the 1830 PSS-32, 1830 PSS-16 and 
1830 PSS-4 devices.

See section 13.3.

Release 10.0 R4 1830 PSS features
No Optical features have been added in this release.

Release 10.0 R3 1830 PSS features
No Optical features have been added in this release.

Release 10.0 R2 1830 PSS features
No Optical features have been added in this release.

Release 10.0 R1 1830 PSS features

Transmission card 
support

The 5620 SAM supports the following transmission cards:
• AM2125A
• AM2318A
• ITLU
• MESH4
• MVAC - supports sVOA 
• WR8-88A
• 112SNA1
• 112SNX10
• 11DPM12
• 43SCX4
• 43SCA1

See Table 8-3. 
See the 5620 SAM Optical 
Parameter Reference.

Feature Description Reference 
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Dedicated card support The 5620 SAM supports the following dedicated cards on the 
1830 PSS-32:
• PFDC60 (AM2) DC Power Filter (60A) on the shelf

See Table 8-4. 
See the 5620 SAM Optical 
Parameter Reference.

7750 SR card support The 5620 SAM supports the following cards on the 7750 SR: 
• 8-Port 10GE XFP IMM B (non-DWDM) 
• 40GE OTU3 Long Reach DWDM Tunable IMM 

The service flows from:
• SR to SR
• PSS to SR
• SR to PSS

See Procedure 8-8, 12-1, and 
chapter 10.

Shelf support The ITLU (Unidirectional interleaver shelf) is supported on 
the 1830 PSS-32 and 1830 PSS-16.

See chapter 8.

Optical intrusion 
detection

The AM2318A and the AM 2125B cards support optical 
intrusion detection

See Procedure 8-4.

Multi-area OSPF Multi-area OSPF is supported on the 1830 PSS-16 and 
1830 PSS-32, Release 3.6.5 or later. You can create up to 
three OSPF areas in addition to the default backbone area. 
The areas can be modified and deleted.

See Procedures 10-1, 10-2, and 
10-3.

Y-cable support The 5620 SAM supports Y-cable protection on the following 
cards:
• 11DPE12 (1830 PSS-4 only), 11DPM12, 11QPA4
• 11STAR1, 11STGE12, 11STMM10
• 112SCX10, 112SNX10
• 43SCX4, 43STA1P, 43STX4, 4DPA4

See Procedure 12-1.

40G coherent 
SONET/SDH client and 
40G coherent 
Add/Drop pack 

The 5620 SAM supports client rates for the SDH and SONET 
mode on the 43SCX4 and 40G on the Add/Drop pack on the 
43SCA1 card.

See chapter 8.
See chapter 12.
See the 5620 SAM Optical 
Parameter Reference. 

40G Mux Coherent 
8GFC

The 5620 SAM supports the 40G Mux Coherent 8GFC client 
rate on the 43SCX4 card.

See chapter 8.
See the 5620 SAM Optical 
Parameter Reference.

Dual stage multiplexing The 5620 SAM supports dual stage multiplexing on the 
1830 PSS-16 and 1830 PSS-32 shelves for keyed and unkeyed 
services for the following cards:
• 4DPA4 to 11STMM10
• 4DPA4 to 11DPM12
• 11DPM12 to 43STX4P
• 11DPM12 to 43SCX4
• 11DPM12 to 112SCX10 
• 11DPM12 to 112SNX10 

See Procedure 12-5.
See the 5620 SAM Optical 
Parameter Reference.

ESNCP service creation The 5620 SAM supports ENSCP service creation for the 
following cards and configurations:
• 4DPA2 service provisioning
• 4DPA4 FlexMux configurations
• 11QPA4 service configurations
• 11DPE12 Fullrate, QinQ service configurations
• 11DPM12 - Provisioning and management of ESNCP 

protection on all supporting service configurations
• 1830 PSS-1MD4H configurations
• 1830 PSS - 1GBE configurations

See Procedure 12-1 and 12-7 to 
create an APS group.
See the 5620 SAM Optical 
Parameter Reference.

Feature Description Reference 
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ESNCP Regen The 5620 SAM supports ENSCP Regen services. See Procedure 12-1.
See the 5620 SAM Optical 
Parameter Reference.

OPS service creation The 5620 SAM supports OPS service creation for the following 
cards and configurations:
• 11QPA4 

See Procedure 12-1.
See the 5620 SAM Optical 
Parameter Reference.

Unidirectional service 
support

The 5620 SAM supports unidirectional services for the 
following protection types:
• ESNCP
• Y-Cable
• OPS protected
• Diverse Route
• Unprotected

The 5620 SAM supports unidirectional services for the 
following amplifier cards:
• AM2125A
• AM2125B
• AM2318A

See Procedure 12-1.
See the 5620 SAM Optical 
Parameter Reference.
See Table 8-3 for information on 
cards supported.

Single fiber 
bidirectional service 
support

The 5620 SAM supports bidirectional services on the 
1830 PSS-4,1830 PSS-16 and 1830 PSS-32 devices, for the 
following filter and OT card types:
• SFC-2
• SFC-4
• SFC-8
• 4DPA4
• 11STAR1
• 11STMM10
• 11DPE12(E)

See Procedure 12-6.
See the 5620 SAM Optical 
Parameter Reference.

Auto-disable a CIT port The 1830 PSS automatically disables the CIT interface on the 
1830 PSS-16 and 1830 PSS-32 to prevent unauthorized local 
access. 

To auto-disable the CIT port see 
Procedure 8-11.

Stale or invalid 
external optical link

The topology map on the 5620 SAM GUI enables you to view 
stale or invalid external optical links.

See section 5.1.

Display optical services 
riding on external or 
internal optical links

The Physical topology map on the 5620 SAM GUI enables you 
to display optical services riding on external or internal 
optical links.

See Procedure 12-13.

Service topology map 
view

When an 1830 PSS NE is moved on the topology map, the 
associated ports are moved with the NE.

See section 3.1.

Creation of a service 
template by clicking 
Apply or OK

The 5620 SAM supports creation of a service template by 
clicking Apply or OK before you can add optical sites and 
termination points.

To create a service template, 
see Procedure 12-1.

Backup and restore 
enhancement

The 5620 SAM supports enhancements on the backup and 
restore policy.

See Procedure 5-2.

The CIR and EIR are 
supported on the 
11DPE12 and 11DPE12E 
cards

The 5620 SAM supports enhanced provision rates on the CIR 
and the EIR on the 11DPE12 and 11DPE12E cards.

See Procedure 12-1 and the 
5620 SAM Optical Parameter 
Reference.

Feature Description Reference 
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1830 PSS-4 support in 
Releases 3.6 and 3.6.5

Releases 3.6 and 3.6.5 of the 1830 PSS-4 device support: 
• Extended Temperature Range at the NE level
• Expected PF Amps at the Shelf level
• Assigned Rate when FE is supported on the 11DPE12 and 

11DPE12E cards

The 1830 PSS-4, Release 3.6.5 supports the following cards:
• 4DPA2
• AM2125A
• AM2125B
• AM2318A
• MVAC

See chapter 8.
See the 5620 SAM Optical 
Parameter Reference.

Create, delete, and 
modify ODU trails

The 5620 SAM supports the listing of ODU and OCH trails and 
the creation, deletion and modification of ODU trails. OCH 
trails are created automatically when ODU trails are created. 
It also supports the inclusion of constraints for sites and ports 
of ODU trails in a service path. This is also supported on 
non-OT and non PSS ports.

See Procedure 12-19 to create 
an ODU trail, Procedure 12-20 to 
delete an ODU trail, Procedure 
12-21 to modify an ODU trail. 
See the 5620 SAM Optical 
Parameter Reference.

Full Rate LO-ODUk 
Service provision and 
discovery

The 5620 SAM supports provisioning and discovery of the 
LO-ODUk service on the 11DPM12 card.

See chapter 12.

Timeslot management 
of LO-ODUk

The 5620 SAM supports both automatic and manual 
configuration of timeslots for the LO-ODUk on the 11DPM12 
card.

See Procedure 12-10 to 
configure timeslots manually for 
LO-ODUk. 
See the 5620 SAM Optical 
Parameter Reference. 

Create and delete 
ODUk cross connects on 
line and client ports

The 5620 SAM supports the creation of ODUk cross connects 
by associating line and client ports at the card and port level. 
The 5620 SAM supports the deletion of the ODUk cross 
connects on line and client ports.

See Procedure 12-23 and 12-24 
and the 5620 SAM Optical 
Parameter Reference.

11DPM12 - video client 
service

The 5620 SAM supports the 3GSDI client rate for the video 
client service on the 11DPM12 cards.

See Procedure 12-10 to 
configure these rates and the 
5620 SAM Optical Parameter 
Reference.

11DPM12 - FC The 5620 SAM supports the FC 400 client rate for a service 
created on the 11DPM12 card.

See Procedure 12-10 to 
configure these rates and the 
5620 SAM Optical Parameter 
Reference.

11DPM12 services with 
OPTSG mode

The 5620 SAM supports services with Client rates - 
OC3/STM1, OC12/STM4 with special OPTSG mode to 
efficiently transport these lower rate signals on the WDM. 
Multiple clients can be multiplexed onto intermediate 
ODU1PTF containers, which results in being multiplexed onto 
ODU1 containers on the line side.

See Procedure 12-1 and 12-10 to 
create a service and configure 
timeslots.

WTOCM support on ILA The 5620 SAM supports optional WTOCM on an ILA on the 
1830 PSS-1 AHP. The Monitored Port Tx parameter can be 
configured on the Port Specifics tab for a SIG and line port.

See the 5620 SAM Optical 
Parameter Reference.

Script Manager The 5620 SAM supports creation, execution and scheduling of 
CLI and velocity scripts on the 1830 PSS.

See Procedure 7-1. See the 
5620 SAM Optical Parameter 
Reference.

Feature Description Reference 
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Power management The 5620 SAM supports technology dependent target powers: 
• Displays OCH technology types for each NE that includes 

WTOCM correction values
• Displays target power offsets by technology type for the 

ingress and egress direction on amp line ports
• Displays received technology type for an OCH cross 

connect
• Allows the user to set technology types for an OCH cross 

connect

See section 5.7. See the 
5620 SAM Optical Parameter 
Reference.

Optical services on the 
OCH cross connect and 
on ports

You can view optical services on an OCH cross connect and 
on ports.

See Procedure 12-13. 

License for Mesh4, 
WR8-88A cards, and all 
cards supported in this 
release

The 5620 SAM supports license keys for Mesh4, WR8-88A 
cards, and all cards supported in this release.

See section 1.2. See the 
5620 SAM User Guide.

4x25 CFP support on 
the 112SCA1 card

The 5620 SAM supports the pluggable module type on the 
112SCA1 card (dual rate). The Pluggable Module Type and 
the Assigned Rate parameters can be configured on the Port 
Specifics tab for a client and line port.

See Procedure 8-10. See the 
5620 SAM Optical Parameter 
Reference.

CWDM, DWDM and 
Black & White 
regeneration 
configurations

The 5620 SAM supports provisioning and discovery of the 
following regeneration configurations:
• CWDM and Black & White 
• DWDM and Black & White
• DWDM and CWDM
• DWDM and CWDM

See section 12.1 and Procedure 
12-1 to configure regeneration 
services. See the 5620 SAM 
Optical Parameter Reference.

Administrative and 
Operational states

The 5620 SAM supports Administrative Up and Down and 
Operational states for the different services.

See section 12.7. See the 
5620 SAM Optical Parameter 
Reference.

ROADM OADM and Mesh 
(Degree 2+)

The 5620 SAM supports optical add or drop multiplexer in 
linear networks.

See section 8.5.

One�device 
Anydirection and 
Two�device 
Anydirection 
configurations 

The 5620 SAM supports One�device Anydirection and 
Two�device Anydirection configurations on the 1830 PSS. It 
supports provisioning, discovery and topological views for 
protected and unprotected services.

See section 8.6 and Procedure 
12-1.

Active Path 
identification

The 5620 SAM supports active paths on A to Z and Z to A 
directions on a protected service.

See Procedure 12-8. 

SyncE support on 
11DPE12E cards

The 5620 SAM supports the configuration of SyncE on 
11DPE12E cards installed on 1830 PSS-4 Release 3.6, and 
1830 PSS-4 Release 3.6.5 with SSM enabled, and on 
1830 PSS-16 and 1830 PSS-32 Release 3.6 and later.

See Procedure 8-4. See the 
5620 SAM Optical Parameter 
Reference.

11DPE12E 
enhancements

The 5620 SAM supports the configuration of line SVID and 
VLAN protection on the 11DPE12E OT card.

See Procedure 12-1.

Power adjustments on 
OT configurations

The 5620 SAM supports service auto power adjustments for 
1830 PSS OT configurations.

See section 12.9. See the 
5620 SAM Optical Parameter 
Reference.

NE software upgrade When a 1830 PSS device needs a software upgrade or 
downgrade to applicable software version, you can use the 
5620 SAM to perform an on-demand or scheduled NE software 
upgrade using a software upgrade policy.

See sections 5.5 and 5.6.

Release 10.0 R1 1830 PSS enhancements

Feature Description Reference 
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Enable PM TCA alerts The 5620 SAM supports TCA alerts when the Enable PM TCA 
Alerts flag is turned on.

See Procedure 8-17. 

Power graph 
enhancements

Enhanced the Service Path form on which the power graph is 
displayed.

See Procedure 12-14 and 12-16.

Unmanage an NE Unmanaging the NE will unmanage all optical transport 
services associated with it. If the service is re-discovered the 
name of the service will revert to the default name.

See section 5.1.

Assign port rate on 
optical links

You can assign a port rate to an existing optical link if a rate 
has not already been assigned.

See Procedure 8-8.

Feature Description Reference 
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3.1 5620 SAM network topology maps

This section describes the network topology and grouping in the 5620 SAM that 
applies to the 1830 PSS. The 5620 SAM uses map windows to visually represent 
network objects and paths. For the 1830 PSS, the 5620 SAM supports physical 
network topology maps. Each map displays network objects and information, and 
provides contextual menus to open forms that display additional information. See the 
5620 SAM User Guide for more information about network topology.

Service topology map
A service topology map is available from the Manage Services form. To view the 
map from the Manage Services form, choose Manage→Service→Services from the 
5620 SAM main menu. Choose Optical Transport Service from the drop-down menu 
and list services by clicking on the Search button. The list of optical transport 
services are displayed. Select a service and click on the Properties tab, the properties 
form of the selected service opens. Click on the More Actions button and select 
Topology View, the service is displayed on the topology map. In this view if a 
particular NE is moved on the map, the associated ports are moved along with the 
NE.

Physical topology map
When the 5620 SAM client GUI starts, the physical topology map is open in the 
working panel by default. The default view displays the interconnections between IP 
and optical devices. The 5620 SAM allows you to filter the view to display only 
optical interconnections or IP interconnections. Procedure 3-1 and 3-2 describes how 
to view the optical interconnections and the IP interconnections on the physical 
topology map. See the 5620 SAM Parameter Guide for descriptions of the 
parameters. For more information about network topology maps, see the 5620 SAM 
User Guide.

3.2 Procedures to view optical and IP interconnections

Procedure 3-1  To view optical interconnections only

1 Open a physical topology map.

2 Click on the Filter button. The Topology Filter - Physical Topology form opens.

3 Choose Optical Link from the Object Filters to Add, drop-down menu.

4 Click on the Add object filter icon. The selected Optical Link Filter panel is 
displayed.

5 Choose Endpoint A Type from the Attribute drop-down menu.

6 Choose EQUALS from the Function drop-down menu.

7 Choose Port from the Value drop-down menu.

8 Click on the Add to Filter icon. The Endpoint A Type is displayed on the Filter 
panel. 
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9 Choose AND from the Operators drop-down menu. Repeat steps 5 to 8 to add 
Endpoint B Type. Endpoint B Type is also displayed on the Filter panel.

10 Click on the Save button, the Save Filter dialog box is displayed. 

11 Enter a Filter Name and Description and click on the Save button. The filter is 
saved.

12 Choose Network Element from the Object Filters to Add drop-down menu.

13 Click on the Add object filter icon. The selected Network Element panel is 
displayed.

14 Choose Chassis Type from the Attribute drop-down menu.

15 Choose EQUALS from the Function drop-down menu.

16 Choose the desired 1830 PSS chassis from the Value drop-down menu. 

17 Click on the Add to Filter icon. The Chassis Type is displayed on the Filter panel.

18 Choose AND from the Operators drop-down menu. Repeat steps 12 to 17 to add 
the different 1830 PSS chassis types.

19 Click on the Save button, the Save Filter dialog box is displayed. 

20 Enter a Filter Name and Description and click on the Save button. The filter is 
saved.

21 Click on the Apply button to apply the Optical Link filter. The Topology Filter - 
Physical Topology form closes and the map view is refreshed to display only 
devices with optical interconnections.

Procedure 3-2  To view IP interconnections only

1 Open a physical topology map.

2 Click on the Filter button. The Topology Filter - Physical Topology form opens.

3 Choose Physical Link from the Object Filters to Add drop-down menu.

4 Click on the Add object filter icon. The selected Physical Link Filter panel is 
displayed.

5 Choose Chassis Type from the Attribute drop-down menu.

6 Choose NOT EQUAL from the Function drop-down menu.

7 Choose the desired 1830 PSS chassis from the Value drop-down menu.

8 Click on the Add to Filter icon. The 1830 PSS chassis is displayed on the Filter 
panel. 

9 Choose OR from the Operators drop-down menu to add other 1830 PSS chassis 
types. Repeat steps 5 to 7. The 1830 PSS chassis is displayed on the Filter panel.
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10 Click on the Save button, the Save Filter dialog box is displayed. 

11 Enter a Filter Name and Description and click on the Save button. The filter is 
saved.

12 Click on the Apply button to apply the Physical Link filter. The Topology Filter - 
Physical Topology form closes and the map view is refreshed to display only 
devices with IP interconnections.
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4.1 User security overview

The 5620 SAM provides security functions for user groups, devices, and paths.

4.2 5620 SAM user and user group security

You can use the 5620 SAM to configure user accounts, user groups, and spans of 
control that define the 5620 SAM objects that users can view and manage. For more 
information about user security in the 5620 SAM, see the 5620 SAM User Guide.

Span of control
Span of control allows you to assign access permissions to a functional group of 
5620 SAM server objects; for example a group of NEs or services.

You can use the 5620 SAM to create a span of control, or to copy an existing span of 
control and modify the list of associated objects to create a span of control. The 
objects that are in a span of control, or that can be added to a span of control, are 
called span objects. The 5620 SAM has several pre-defined spans of control. Each 
new 5620 SAM object, for example, a discovered NE, is added to the corresponding 
pre-defined span of control. Optical objects, such as the wavelength service on the 
1830 PSS, are added to the Default Transport Span.

For more information about span of control see the 5620 SAM User Guide. 

You can filter the objects that a map or list displays, based on the user span of control. 
By default, the GUI displays only the objects that are in the View Access and Edit 
Access spans of control of the user. See the 5620 SAM User Guide for more 
information.

Note �  The administrator can restrict access of certain operators to 
equipment and services in their own domain, for example, transport 
or data.
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5.1 Device management overview

The 1830 PSS device must be commissioned and pre-configured before the 
5620 SAM can manage the device. When the pre-configuration is complete, the 
5620 SAM can discover the device. See the chapter Device discovery of the 
5620 SAM User Guide for more information about operations related to device 
discovery.

To manage or unmanage an NE, see the Device discovery procedures of the 
5620 SAM User Guide for more information. 

All unmanaged NEs are displayed on the topology map of the 5620 SAM GUI as a 
single unmanaged NE icon. See the section Indicators and icons of the 5620 SAM 
User Guide for more information. 

Procedure 5-1  To view an invalid or stale optical link

1 In the topology map double-click on the optical link which links to the Unmanaged 
NEs icon.

2 The Physical Link Group List - UnmanagedNEs form displays a list of invalid or stale 
optical links, for example, optical links from a managed NE to an Unmanged NE in 
5620 SAM.

3 Select an invalid or stale optical link and click on the Properties tab, the Optical 
Link [Edit] form opens. Information about the Managed and UnManaged NEs are 
displayed. The unManaged NE EndPoint attribute displays the links that leads to 
the unmanaged NE.

5.2 Out-of-band and in-band management

The 5620 SAM supports in-band and out-of-band management of devices for the 
1830 PSS.

Out-of-band management

When you configure a device for out-of-band management only, management traffic 
between the 5620 SAM and the 1830 PSS device is transmitted through the 
management port of the device. The 5620 SAM sends management traffic to the 
management IP address of the 1830 PSS device.

When you configure a device for in-band and out-of-band management, one method 
provides redundancy for the other method. If the IP addresses are the same, 
redundancy is not supported. The out-of-band connection is called the primary 
connection and the in-band connection is called the secondary connection.

Note �  Unmanaging the NE will unmanage all optical transport 
services associated with it. If the service is re-discovered the name of 
the service will revert to the default name.
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See the chapter Device commissioning and management of the 5620 SAM User 
Guide for out-of-band management support.

In-band management

The network management system can manage an 1830 PSS-32 network by 
connecting to a single 1830 PSS-32 NE that is called a GNE. The GNE provides 
management connectivity to the other 1830 PSS-32 NEs in the network. The GNE 
communicates externally using an IP address. Non-GNE nodes are only in-band to 
each other. The network system does not specifically manage or configure the GNE.

SONET, SDH, and OTN architectures support DCC and GCC, which are in-band 
channels that can be used for management. IP over DCC/GCC is an in-band 
management channel which can be used if a device is connected to a TRX-24000 
client port. 

Figure 5-1 shows NE 1 as the Gateway NE for the ring, interconnecting the cards 
which support OSC ports between the NEs provides inter-NE communication for 
network management. 

See the Alcatel-Lucent 1830 Photonic Service Switch 36/32/16 
(PSS-36/PSS-32/PSS-16) Installation and System Turn-Up Guide for more 
information.
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Figure 5-1  In-band management

Prerequisites

You must configure the following on the 1830 PSS for a gateway NE with static 
routes: 

• OAMP IP address
• OAMP IP address subnet mask
• Default route gateway IP address (which is redistributed)
• NE loopback IP address and subnet mask
• SNMP source to be set to Loopback IP only

The non-gateway NEs require the following: 

• NE loopback IP address and mask
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Although the 1830 PSS NEs do not exchange routing information with operating 
organization routers, an operating organization router that is attached to the gateway 
NE requires the following: 

• The operating company router must have auto-negotiation enabled, or should be 
running in 10Mpbs half-duplex mode

• static route for the NE loopback IP address subnet

To configure the 1830 PSS to use in-band, out-of-band, or in-band and out-of-band 
polling at the intervals specified in a mediation policy, see the chapter Device 
commissioning and mangement of the 5620 SAM User Guide for more information 
about in-band and out-of-band polling intervals. See the chapter Device discovery of 
the 5620 SAM User Guide for information about configuring mediation policies.

5.3 Switching modes between SONET and SDH

The 1830 PSS can be set to SONET or SDH mode using the CLI command. You 
cannot change the SONET or SDH mode using the 5620 SAM GUI. If you switch 
modes between SONET and SDH, and the mode value is changed, you would need 
to do a full manual resync of the NE in the 5620 SAM GUI.

When the mode is changed using a tnSysSonetSdhMode CLI command, the 
5620 SAM recognizes the NE mode change and raises an alarm. The alarm must be 
manually cleared by the user. See the 5620 SAM User Guide to clear alarms.

5.4 Procedure to backup and restore files on the 1830 PSS NEs

Encrypted file transfer
Database backup and restore support SFTP /TFTP data transfer. The NE 
communicates with an external SSH server running on the database backup and 
software repository machine. The 5620 SAM runs on the same machine. 

Any previous configurations supported in the CLI are valid for configuration 
software or configuration database. The option is available in the transfer protocol 
field, and must be used to initiate an SFTP-based transfer. 

For software and database downloads, the applications running on the NE are SSH 
or SFTP clients which connect to an external SSH server. Authentication is password 
based only. Public key-based authentication is not supported. As a result, you can 
initiate SFTP-based database and software download operations even when an 
encryption key is not generated. 

For more information on backup and restore, see the 5620 SAM User Guide.

Caution �  If the NE mode is changed to SONET or SDH, the 
configurations on the shelf, card, and port NE are lost. After the NE 
is re-started, the new mode must be reconfigured.
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Procedure 5-2  To create a 1830 PSS backup/restore policy

When the 5620 SAM performs a device configuration backup/restore, the 1830 PSS 
transfers files to and from the 5620 SAM server. See the 5620 SAM Optical Parameter 
Reference and the 5620 SAM Parameter Guide to configure the parameters.

1 Choose Administration→NE Maintenance→Backup/Restore from the 5620 SAM 
main menu. The Backup/Restore form opens with the Backup/Restore Policy tab 
displayed.

2 Click on the Create button. The Backup Policy (Create) form opens.

3 Specify whether backup functionality is enabled.

a Enable the Enable Backup parameter.

b Disable the Enable Backup parameter. Go to step 8.

4 Configure the following parameters:

• Policy ID
• Auto-Assign ID
• Name 
• Policy Type (1830 PSS Node)

5 Configure the following parameters in the Backup Triggering panel:

• Scheduled Backup Scheme 
• Scheduled Backup Interval 
• Scheduled Backup Sync Time 
• Scheduled Backup Threshold (operations)

6 Configure the parameters in the Backup Purging panel:

• Auto-Purge Scheme 
• Number of Backups 
• Maximum Backup Age (days)

Note �  The default backup policy is automatically assigned to 
5620 SAM-managed NEs that do not have an assigned backup policy.
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7 Configure the parameters in the PSS Backup/Restore Settings panel: 

• SFTP User ID
• SFTP Password
• Transfer Protocol

• SFTP
• TFTP

• Server IP
• File Transfer Server Port (default)
• Root Directory
• File Compression

8 Click on the OK button to save the backup policy. The Backup Policy (Create) form 
closes.

9 Assign the policy to the 1830 PSS, as required.

i Choose the new policy in the list and click on the Properties button. The 
Backup Policy (Edit) form opens.

ii Click on the Backup/Restore Policy Assignment tab.

iii Choose one or more NEs in the Unassigned Sites list and click on the right 
arrow key to move NEs to the Assigned Sites list.

iv Click on the OK button. The Backup Policy (Edit) form closes and a dialog box 
appears.

v Click on the Yes button. The policy is assigned to the NEs.

vi Click on the Copy button to make a copy of the Backup Policy. 

10 Close the Backup/Restore form.

Note �  If SFTP is selected as the Transfer Protocol, the SFTP User ID, 
SFTP Password, and the Server IP parameter values need to be 
authenticated. 

Note 1 � To use SFTP, an SSH server must be configured using port 22. 
The 5620 SAM uses port 69 for TFTP file transfers.

Note 2 � The root directory displays the server path where the file is 
transferred after the policy is created.
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5.5 Managing NE software upgrades

When a 1830 PSS device needs a software upgrade or downgrade to applicable 
software version, you can use the 5620 SAM to perform an on-demand or scheduled 
NE software upgrade using a software upgrade policy. You can create and configure 
multiple software upgrade policies and assign them to multiple NEs. You cannot 
delete a software upgrade policy that is assigned to an NE. The information in a 
software upgrade policy includes the following:

• whether to activate the software after transferring it to the NE
• whether to reinitialize the NE after the upgrade

During a software upgrade, the 5620 SAM performs checks to ensure that the new 
software is compatible with the device type and that the required files are present. 
The 5620 SAM does not initiate a device software upgrade unless the necessary 
conditions are in place. You can use the 5620 SAM to roll back a software upgrade 
to the previous version in the event of an upgrade failure.

For more information on software upgrades, see the Alcatel-Lucent 1830 Photonic 
Service Switch 36/32/16 (PSS-36/PSS-32/PSS-16) User Provisioning Guide and the 
5620 SAM User Guide.

5.6 Procedures to manage NE software upgrades

Use the following procedures to perform 1830 PSS software upgrades.

Procedure 5-3  To import device software image files to the 
5620 SAM database

1 Copy or move the device software to a directory that is accessible to the 
5620 SAM.

2 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens with the Software Upgrade Policy 
tab displayed.

3 Click on the Software Images tab.

4 Click on the PSS Software Images tab.

Note �  The directory must contain a valid and complete set of device 
software files.
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5 Perform one of the following:

a To import image files from a local server, perform the following:

i Click on the Import button. The Select import PSS Software window 
appears.

ii Navigate to directory that contains the software image, select the 
image, and click on the Open button. The Import Image dialog box 
appears.

iii Click on the Yes button to proceed. Once the import is complete, an 
entry for the image appears in the list.

b To import 1830 PSS software from a remote location with FTP support, 
perform the following:

i Click on the Remote Path button. The Remote Path dialog box appears.

ii Click on the Yes button to continue. The Software Directory Path dialog 
box appears.

iii Enter the complete Remote Software Path, for example, 
/dir/dir/1830 PSS XX-software version, and click on the OK button. 
Once the remote path import is complete, an entry for the image 
appears in the list.

6 Close the Software Upgrade form.

Procedure 5-4  To create a software upgrade policy

The 5620 SAM uses a 1830 PSS-specific software upgrade policy to download 1830 PSS 
software. A default 1830 PSS software upgrade policy is created when the 5620 SAM 
initializes.

Perform this procedure to create a policy that can be used to perform an on-demand 
or scheduled device software image upgrade. Contact your Alcatel-Lucent technical 
support representative for information about downgrades.

1 Perform Procedure 5-3 to import the required device software image.

2 Ensure that the following conditions are present.

• Appropriate FTP accounts are configured and available on the devices.
• The device configuration files are backed up.

3 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens.

Note �  The remote system address is the server IP that is configured 
on the policy of the associated NE.
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4 Click on the Create button. The Software Upgrade Policy (Create) form opens.

5 Choose the 1830 PSS Node option from the Policy Type drop-down menu.

6 Configure the following parameters:

• Auto-Assign ID
• Policy ID
• Name

7 Configure the parameters in the PSS Based Setting panel, as required.

8 Configure the following parameters, as required:

• Force Upgrade
• Node Backup

9 Click on the Apply button. The Software Upgrade Policy (Create) form refreshes 
with additional tabs and the form name changes to Software Upgrade Policy 
(Edit).

10 Close the Software Upgrade Policy (Edit) form. The new policy is displayed on the 
Software Upgrade form.

Procedure 5-5  To assign a software upgrade policy to an 1830 PSS

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens.

2 Select a software upgrade policy from the list and click on the Properties button. 
the Software Upgrade Policy (Edit) form opens.

3 Click on the Software Upgrade Policy Assignment tab. The Software Upgrade 
Policy (Edit) Filter form opens.

4 Configure the filter parameters, if required. Click on the OK button.

5 Select one or more NEs in the Unassigned Sites list and click on the right-pointing 
arrow to move them to the Assigned Sites list.

6 Click on the OK button. A dialog box appears.

7 Click on the Yes button. The policy is assigned to the NEs.

8 Close the Software Upgrade Policy (Edit) form.

9 Close the Software Upgrade form.

Note �  Make sure that Backup is configured before selecting the Node 
Backup option. See the Alcatel-Lucent 1830 Photonic Service Switch 
36/32/16 (PSS-36/PSS-32/PSS-16) User Provisioning Guide for more 
information.



5 �  1830 PSS device management

Alcatel-Lucent 5620 Service Aware Manager, Release 10.0 R7 January 2013 5-11
3HE 06986 AAAG TQZZA Edition 01
Optical User Guide

Procedure 5-6  To perform an immediate software upgrade

Before you proceed with this procedure, ensure that the required software images are 
imported to the 5620 SAM database, see Procedure 5-3, and that the node is assigned 
to the appropriate software upgrade policy, see Procedure 5-5.

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens.

2 Choose the appropriate 1830 PSS software upgrade policy.

3 Click on the Software Images tab.

4 Click on the PSS Software Images tab.

5 You can perform the node level upgrade steps as separate tasks using the audit, 
load and activate functionalities, as one task using the auto upgrade functionality, 
or as a scheduled task.

a To perform the node level upgrade steps as separate tasks go to step 6.

b To perform the node level upgrade steps as a single task go to step 7.

c To perform the node level upgrade steps as a scheduled task go to 
Procedure 5-7.

6 To perform the audit, load, and activate steps as separate tasks, proceed as 
follows:

i To audit the 1830 PSS software image, proceed as follows:

• Choose the appropriate 1830 PSS software image from list and click on the 
Audit button. The Confirm Audit settings dialog box appears.

• Choose an option from the Audit Settings drop-down menu and click on 
the OK button. The Audit - Select Sites form opens.

• Select the node that you wish to audit and click on the OK button. The 
Audit - Select Sites form closes.

• Click on the Software Upgrade Status tab to view the status of the audit 
as it progresses. Verify that the software is successfully audited before 
you go to step ii.

Note �  If you select the Default Audit Settings option, the policy level 
settings will be used.
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ii To load audited software onto the device, proceed as follows:

• Click on the Load button. The Load - Select Sites form opens displaying a 
list of nodes with successfully audited software.

• Select the node where you wish to load the software and click on the OK 
button. The Load dialog box appears.

• Click on the Yes button to proceed.

• Click on the Software Upgrade Status tab to view the status of the load as 
it progresses. Verify that the audited software is successfully loaded 
before you go to step iii.

iii To activate software that has been loaded onto the node, proceed as follows:

• Click on Activate button. The Activate - Select Sites form opens with a list 
of nodes that are ready to be activated displayed.

• Select the node where you wish to activate the software and click on the 
OK button. The Activate dialog box appears, informing you that activation 
will result in a warm reboot of the NE.

• Click on the Yes button to proceed.

iv To go step 8.

7 To perform the audit, load, and activate steps as a single task, proceed as follows:

i Choose the appropriate 1830 PSS software image from list and click on the 
Auto Upgrade button. The Confirm Audit settings dialog box appears.

ii Choose an option from the Audit Settings drop-down menu and click on the 
OK button. The AutoUpgrade - Select Sites form opens.

iii Select the node that you wish to upgrade and click on the OK button. The 
Audit - Select Sites form closes.

iv Click on the Software Upgrade Status tab to view the progress.

Note �  The load operation may take considerable time to complete.

Note �  The activate operation may take considerable time to 
complete.

Note �  If you select the Default Audit Settings option, the policy level 
settings will be used.
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8 Perform one of the following:

a To commit the activated software release to the node, proceed as follows:

i Click on Commit button. The Commit - Select Sites form opens with a 
list of nodes that are supported for the selected software image.

ii Select the node where you wish to commit the activated software 
release and click on the OK button. The Commit dialog box appears.

iii Click on the Yes button to proceed.

b To revert the node to the previously committed software release, proceed as 
follows:

i Click on Revert button. The Revert - Select Sites form opens with a list 
of nodes that are supported for the selected software image.

ii Select the node where you wish to revert the software release and click 
on the OK button. The Revert dialog box appears.

iii Click on the Yes button to proceed.

9 Close the Software Upgrade form.

Note �  You can commit the active release at any time after the 
software release has been activated.

Note �  You can revert to a previously committed software release at 
any time.
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Procedure 5-7  To schedule an automatic software upgrade

Perform this procedure to schedule the node level upgrade steps to occur 
automatically. See the 5620 SAM User Guide for information about creating schedules. 
Before you proceed make sure that the required software images are imported to the 
5620 SAM database, see Procedure 5-3, and that the node is assigned to the appropriate 
software upgrade policy, see Procedure 5-5.

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens with the Software Upgrade Policy 
tab displayed.

2 Select the appropriate software upgrade policy. 

3 Click on the Software Images tab.

4 Select a software image in the list and click on the Schedule button. The Confirm 
Audit Settings dialog box appears.

5 Choose an option from the Audit Settings drop-down menu and click on the OK 
button. The AutoUpgrade - Select Sites form opens.

6 Select the node that you wish to upgrade and click on the OK button. The Select 
Schedule - Select Schedule form opens.

7 Select a schedule in the list and click on the OK button. The Schedule Upgrades 
dialog box appears. See the 5620 SAM User Guide for information about creating 
schedules.

8 Click on the Yes button. The 5620 SAM schedules the upgrade.

Note �  The 5620 SAM performs the upgrade according to the 
configuration in the software upgrade policy that is assigned to the NE.

Note �  If you select the Default Audit Settings option, the policy level 
settings will be used.
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9 To complete the software upgrade, perform one of the following:

a To commit the activated software release to the node, proceed as follows:

i Click on Commit button. The Commit - Select Sites form opens with a 
list of nodes that have activated software displayed.

ii Select the node where you wish to commit the activated software 
release and click on the OK button. The Commit dialog box appears.

iii Click on the Yes button to proceed.

b To revert the node to the previously committed software release, proceed as 
follows:

i Click on Revert button. The Revert - Select Sites form opens with a list 
of nodes that have activated software displayed.

ii Select the node where you wish to revert the software release and click 
on the OK button. The Revert dialog box appears.

iii Click on the Yes button to proceed.

10 Close the Software Upgrade form.

Procedure 5-8  To view the status of a software upgrade

1 Choose Administration→NE Maintenance→Software Upgrade from the 5620 SAM 
main menu. The Software Upgrade form opens with the Software Upgrade Policy 
tab displayed.

2 Select the Software Upgrade Status tab.

3 Select the node from the list and click on the Properties button. The Software 
Upgrade Status (View) forms opens displaying 1830 PSS software upgrade script 
information and the current upgrade status.

5.7 Power Management on the 1830 PSS

Power management is set on the 5620 SAM GUI to improve transmission 
performance.

The 1830 PSS supports both auto and manual power management of the technology 
types. Auto-power managed networks have restricted topologies, but can be 
commissioned and the NE automatically adjusts power levels. Manual-power 
managed networks supports more flexible topologies, but the power levels and the 
commissioning can be set. For protection configurations, the working and protection 
lines can be both auto-power managed, both manual-power managed, or one 
auto-power and one manual-power managed.
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TOADM and ROADM configurations support auto power management, and 
FOADM configurations support manual power management. There are some 
FOADM configurations that do support auto power management. 

Technology Types
The 5620 SAM supports the creation and modification of the unreserved technology 
type and viewing of the reserved technology type.

There are two technology types:

• Reserved types are discovered on the node
• Unreserved types are discovered on the 5620 SAM

You can delete a technology type if:

• It is not a reserved type. Reserved types have OTU Bit Rate or Encoding which 
is equal to 1-1000, 9001-10000

• It is not associated with a cross connect
• OTU Bit Rate and Encoding do not match the AZ and ZA OTU Bit Rate and 

Encoding and the AZ and ZA received OTU Bit Rate and Encoding on a cross 
connect

Procedure 5-9  To create an unreserved technology type

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE.

3 Right-click on the NE and choose Properties from the contextual menu. The 
Network Element [Edit] form opens with the General tab displayed.

4 Click on the NE Specifics tab.

5 Choose the Technology Types tab.

6 Click on the Create button. The Technology Type [Create] form opens. Configure 
the parameters:

• Bit Rate Key
• Bit Rate Description
• Encoding Key
• Encoding Description
• WTOCM Calibration

Note 1 � The 5620 SAM does not allow creation of a technology 
type if the Bit Rate Key and the Encoding Key exists.

Note 2 � The 5620 SAM does not support modification of the 
WTOCM Calibration for reserved enumerated values 9001-10000.
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7 Click on the OK button. The Technology Type [Create] form closes.

8 Click on the Close Window button. The Network Element [Edit] form closes.

Procedure 5-10  To set the technology type on OCH cross connects 
on the 1830 PSS

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE.

3 Right-click on the NE and choose Properties from the contextual menu. The 
Network Element [Edit] form opens with the General tab displayed.

4 Click on the NE Specifics tab.

5 Choose the OCH Cross Connect tab. Select a Cross Connect and click on the 
Properties tab.

6 The OCH Cross Connect [Edit] form opens.

7 Choose Select in the User Technology AZ panel or the User Technology ZA panel. 
The Select Bit Rate / Encoding AZ or ZA OCH Cross Connect form opens. 

8 Select the technology type that you want to associate with the cross connect and 
click on the OK button.

9 Click on the OK button. The Technology Type [Create] form closes.

10 Click on the Close Window button. The Network Element [Edit] form closes.

Note 1 � The Received Technology type is automatically received by 
the cross connect depending on the type of technology, either CWDM or 
DWDM.

Note 2 � The 5620 SAM does not allow creation of a technology type if 
the Bit Rate Key and the Encoding Key exists.
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Procedure 5-11  To view and set target power offsets on the 1830 PSS

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE→Shelf→Card→Port.

3 Right-click on the port and choose Properties from the contextual menu. The 
Physical Port [Edit] form opens with the General tab displayed.

4 Click on the Port Specifics tab and choose Target Power Offset tab to configure 
the target power offset for each channel in each direction.

5 Choose Properties, the Power Offset [Edit] form appears.

6 Configure the Target Power Offset (dB) parameter.

7 Click on the OK button. The Target Power Offset tab is displayed.

8 Click on the Apply button to save the changes. A dialog box is displayed.

9 Click in the Yes button to save the changes.

10 Click on the Close Window button. The Physical Port [Edit] form closes.

5.8 Policies supported on the 1830 PSS

Note 1 � The following ports support target power offset:

• A2325A, AHPHG, AHPLG, ALPHG, AM2017B and AM2325B LINE ports
• AM2125A, AM2125B, AM2318A and RA2P LINEIN ports (Ingress only)
• AM2125A, AM2125B and AM2318A LINEOUT ports (Egress only)

Note 2 � Target power offset depends on the ingress and egress 
direction of the port.

See the Alcatel-Lucent 1830 Photonic Service Switch 36/32/16 
(PSS-36/PSS-32/PSS-16) User Provisioning Guide for more information.

Note 1 � You can create and distribute global policies to the 
1830 PSS using the 5620 SAM policy distribution framework. You 
cannot distribute to a specific 11QPE24 card, the global policy is 
distributed to all 11QPE24 cards on the 1830 PSS node. See the 
5620 SAM User Guide for more information.

Note 2 � You can create, modify, or delete local policies on the 
Policies tab of the 11QPE24 card properties form. See section 5.9.
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QoS policies
The 5620 SAM supports the following types of 1830 PSS QoS policies:

• Access Ingress
• Port Access Egress 
• Network 
• Network Queue 
• Port Scheduler 

For QoS policies procedures, see QoS policies chapter in the 5620 SAM User Guide.

Table 5-1 describes the types of 1830 PSS 11QPE24 QoS policies and the policy 
characteristics.

Table 5-1 1830 PSS QoS policies

Policy type Applied to Description Menu Option

7210 and 1830 
Access Ingress

Access SAP Defines up to 18 forwarding class meters 
and meter parameters for traffic 
classification.
Defines match criteria to map flows to 
the meters based on any one of the 
criteria (IP or MAC).

Policies→QoS→SROS QoS→Access 
Ingress→7210 and 1830 Access Ingress 
See Procedure �To configure a 7210 SAS 
or 1830 PSS access ingress policy� in the 
5620 SAM User Guide for information 
about how to configure the global policy.

7210 and 1830 
Network

Uplink port Defines ingress dot1p to forwarding class 
mapping and profile state. 
Defines the egress queuing parameters 
associated with each forwarding class.

Policies→QoS→SROS 
QoS→Network→7210 and 1830 Network.
See Procedure �To configure a 7210 SAS 
or 1830 PSS network policy� in the 
5620 SAM User Guide for information 
about how to configure the global policy.

7210 and 1830 
Network

Network 
port 

Defines ingress dot1p or DSCP value 
mapping to forwarding classes. 
Defines unicast meters. Only unicast 
meters with range 1-8 are allowed.
Defines the egress forwarding class to 
dot1p or DSCP value markings.
Remarking of QoS bits.

Policies→QoS→SROS 
QoS→Network→7210 and 1830 Network.
See Procedure �To configure a 7210 SAS 
or 1830 PSS network policy� in the 
5620 SAM User Guide for information 
about how to configure the global policy.

7210 and 1830 
Network Queue

Uplink port Defines forwarding class mappings to 
network queues and queue 
characteristics for the queues

Policies→QoS→SROS QoS→Network 
Queue→7210 and 1830 Network Queue. 
See Procedure �To configure a 7210 SAS 
or 1830 PSS network queue policy� in the 
5620 SAM User Guide for information 
about how to configure the global policy.

7210 and 1830 
Port Scheduler

Access and 
uplink ports

Defines the parameters for the port 
scheduler

Policies→QoS→SROS 
QoS→Scheduler→7210 and 1830 Port 
Scheduler. 
See Procedure �To configure a 7210 SAS 
or 1830 PSS port scheduler policy� in the 
5620 SAM User Guide for information 
about how to configure the global policy.
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5.9 Procedures to create local 1830 PSS QoS policies

The following procedures describe how to create local 1830 PSS Qos policies on the 
11QPE24 card.

Procedure 5-12  To create a local 1830 PSS access ingress policy

1 Choose Equipment from the view selector in the navigation tree. The navigation 
tree displays the Equipment view.

2 Locate and expand the 1830 PSS on which you need to create the access ingress 
policy.

3 Expand the shelf icon on which the 11QPE24 card is located.

4 Right-click on the 11QPE24 card icon and choose Properties from the contextual 
menu. The Card Slot (Edit) form opens with the General tab displayed.

5 Click on the Policies tab. The Access Ingress tab is displayed.

6 Click on the Create button. The SAP Access Ingress, Local Policy (Create) form 
opens with the General tab displayed.

7 Configure the parameters:

8 Click on the Meter tab.

i Click on the Create button. The Meter, SAP Access Ingress (Create) form 
opens with the General tab displayed.

ii Configure the parameters:

• ID
• Rate Mode
• MultiPoint

iii Click on the CIR/PIR tab and configure the parameters.

• CIR Adaptation
• PIR Adaptation
• CIR (kbps)
• PIR (kbps)

iv Click on the OK button to save the changes. A dialog box appears. 

v Click on the OK button. The Meter, SAP Access Ingress (Create) form closes.

• ID
• Auto-Assign ID
• Displayed Name

• Description
• Scope
• Number of QoS Classifiers
• Default FC
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9 Click on the Forwarding Classes tab. 

i Click on the Create button. The Forwarding Class, SAP Access Ingress (Create) 
form opens.

ii Configure the parameters:

• Forwarding Class
• Meter ID
• Multicast Meter ID
• Broadcast Meter ID
• Unknown Meter ID

iii Click on the OK button to save the changes. A dialog box appears. 

iv Click on the OK button. The Forwarding Class, SAP Access Ingress (Create) 
form closes.

10 Perform one of the following:

a Click on the IP Match Criteria tab to configure IP match criteria.

i Click on the Create button. The IP Match, SAP Access Ingress (Create) 
form opens.

ii Configure the parameters:

• ID
• Displayed Name
• Description
• Forwarding Class
• DSCP

iii Click on the OK button to save the changes. A dialog box appears. 

iv Click on the OK button. The IP Match, SAP Access Ingress (Create) form 
closes.

b Click on the MAC Match Criteria tab.

i Click on the Create button. The MAC Match, SAP Access Ingress (Create) 
form opens.

ii Configure the parameters:

iii Click on the OK button to save the changes. A dialog box appears. 

iv Click on the OK button. The MAC Match, SAP Access Ingress (Create) 
form closes.

• ID
• Displayed Name
• Description
• Forwarding Class

• Source MAC
• Destination MAC
• Dot1p
• Ether Type
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11 Click on the Ok button to save the policy. The SAP Access Ingress, Local Policy 
(Create) form closes.

12 Close the Card Slot (Edit) form. 

Procedure 5-13  To create a local 1830 PSS network policy

1 Choose Equipment from the view selector in the navigation tree. The navigation 
tree displays the Equipment view.

2 Locate and expand the 1830 PSS on which you need to create the network policy.

3 Expand the shelf icon on which the 11QPE24 card is located.

4 Right-click on the 11QPE24 card icon and choose Properties from the contextual 
menu. The Card Slot (Edit) form opens with the General tab displayed.

5 Click on the Policies tab. The Access Ingress tab is displayed.

6 Click on the Network tab.

7 Click on the Create button. The Network Policy, Local Policy (Create) form opens 
with the General tab displayed.

8 Configure the parameters:

9 Click on the Egress Forwarding Classes tab. 

10 Choose a forwarding class and click on the Properties button. The Egress 
Forwarding Class, Network Policy (Create) form opens.

11 Configure the parameters:

• Dot1p In Profile
• Dot1p Out Profile

12 Click on the OK button. The Egress Forwarding Class, Network Policy (Create) form 
closes and a dialog box appears.

13 Click on the OK button.

14 Map the dot1p tag of the ingress traffic to the ingress queue ID, if required.

i Click on the Ingress Dot1p tab.

ii Click on the Create button. The Network Ingress Dot1p, Network Policy 
(Create) form opens.

• Nw Mgr ID
• Auto-Assign ID
• ID
• Auto-Assign ID
• Displayed Name

• Description
• Scope
• Default FC
• Default FC Profile
• Remarking
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iii Configure the parameters:

• Dot1p
• Forwarding Class
• Profile

iv Click on the OK button to close the form. The policy form reappears with the 
newly created object displayed.

v Repeat step 13 for each new rule that you need to add. You can configure up 
to eight rules.

15 Click on the OK button.

16 Click on the Ok button to save the policy. The Network Policy, Local Policy 
(Create) form closes.

17 Close the Card Slot (Edit) form. 

Procedure 5-14  To create a local 1830 PSS port access egress policy

1 Choose Equipment from the view selector in the navigation tree. The navigation 
tree displays the Equipment view.

2 Locate and expand the 1830 PSS on which you need to create the port access 
egress policy.

3 Expand the shelf icon on which the 11QPE24 card is located.

4 Right-click on the 11QPE24 card icon and choose Properties from the contextual 
menu. The Card Slot (Edit) form opens with the General tab displayed.

5 Click on the Policies tab. The Access Ingress tab is displayed.

6 Click on the Port Access Egress tab.

7 Click on the Create button. The Port Access Egress Policy, Local Policy (Create) 
form opens with the General tab displayed.

8 Configure the parameters:

• ID
• Auto-Assign ID
• Displayed Name
• Description
• Scope

9 Click on the Queues tab.

10 Choose a queue and click on the Properties button. The PortAccessEgressQueue 
(Edit) form opens with the General tab displayed.
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11 Configure the parameters:

• ID
• Displayed Name
• Description

12 Click on the CIR/PIR tab and configure the parameters:

• CIR Adaptation
• PIR Adaptation
• CIR (kbps)
• PIR (kbps)

13 Click on the OK button. A dialog box appears.

14 Click on the OK button. The PortAccessEgressQueue (Edit) form closes. 

15 Repeat steps 10 to 14 to configure additional queues.

16 Click on the Forwarding Classes tab. 

17 Click on the Create button. The Network Egress Forwarding Class (Create) form 
opens. 

18 Configure the parameters:

• Forwarding Class
• In Profile
• Out Profile

19 Click on the OK button. A dialog box appears.

20 Click on the OK button. The Network Egress Forwarding Class (Edit) form closes. 

21 Click on the OK button. The Port Access Egress Policy, Local Policy (Create) form 
closes and a dialog box appears.

22 Click on the OK button.

23 Close the Card Slot (Edit) form. 

Procedure 5-15  To create a local 1830 PSS port scheduler policy

1 Choose Equipment from the view selector in the navigation tree. The navigation 
tree displays the Equipment view.

2 Locate and expand the 1830 PSS on which you need to create the port scheduler 
policy.

3 Expand the shelf icon on which the 11QPE24 card is located.

4 Right-click on the 11QPE24 card icon and choose Properties from the contextual 
menu. The Card Slot (Edit) form opens with the General tab displayed.



5 �  1830 PSS device management

Alcatel-Lucent 5620 Service Aware Manager, Release 10.0 R7 January 2013 5-25
3HE 06986 AAAG TQZZA Edition 01
Optical User Guide

5 Click on the Policies tab. The Access Ingress tab is displayed.

6 Click on the Port Scheduler tab.

7 Click on the Create button. The Port Scheduler, Local Policy (Create) form opens 
with the General tab displayed.

8 Configure the parameters:

• Displayed Name
• Description
• Mode

9 Click on the OK button. The Port Scheduler, Local Policy (Create) form closes and 
a dialog box appears.

10 Click on the OK button.

11 Close the Card Slot (Edit) form. 

Procedure 5-16  To create a local 1830 PSS network queue policy

1 Choose Equipment from the view selector in the navigation tree. The navigation 
tree displays the Equipment view.

2 Locate and expand the 1830 PSS on which you need to create the network queue 
policy.

3 Expand the shelf icon on which the 11QPE24 card is located.

4 Right-click on the 11QPE24 card icon and choose Properties from the contextual 
menu. The Card Slot (Edit) form opens with the General tab displayed.

5 Click on the Policies tab. The Access Ingress tab is displayed.

6 Click on the Network Queue tab.

7 Click on the Create button. The Network Queue, Local Policy (Create) form opens 
with the General tab displayed.

8 Configure the parameters:

• Displayed Name
• Description

9 Click on the Queues tab.

10 Choose a queue and click on the Properties button. The NQueueEntry (Edit) form 
opens with the General tab displayed.
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11 Configure the parameters:

• ID
• Displayed Name
• Description

12 Click on the Select button in the Queue Management Policy panel. The Select 
Queue Management Policy form opens.

13 Choose a queue management policy and click on the OK button. The Select Queue 
Management Policy form closes and the queue policy information is displayed.

14 Configure the parameters in the Port Parent panel:

• Port Parent
• Weight
• CIR Level

15 Click on the CIR/PIR tab and configure the parameters:

• CIR Adaptation
• PIR Adaptation
• CIR (kbps)
• PIR (kbps)

16 Click on the OK button. A dialog box appears.

17 Click on the OK button. The NQueueEntry (Edit) form closes. 

18 Repeat steps 10 to 14 to configure additional queues.

19 Click on the OK button. A dialog box appears.

20 Click on the OK button. The Network Queue, Local Policy (Create) form closes and 
a dialog box appears.

21 Click on the OK button.

22 Close the Card Slot (Edit) form. 
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6.1 1830 PSS device discovery

The 5620 SAM discovers the 1830 PSS devices and reconciles their properties with 
the contents of the database. The 5620 SAM discovers the devices using SNMP. 
During the discovery process, the IP address used to discover a device is the 
Loopback IP address, also called the system ID, and the management is considered 
in-band. When the IP address used to discover the device is the management IP 
address of the device management port, the management is considered out-of-band. 
See chapter 5 for more information about in-band and out-of-band management.

To discover the 1830 PSS devices, you must use the 5620 SAM Discovery Manager 
to create discovery rules and scan the network as specified by the rules.

See Device discovery procedures in the 5620 SAM User Guide for more information 
about how to:

• discover devices
• manage and unmange a device
• configure NE mediation

6.2 SNMP management

The 1830 PSS-32/1830 PSS-16 supports the following SNMP functions:

• provisioning interface for equipment and parameters using SNMP v2c and v3
• alarm and trap reporting
• trap destination definition

For information about the 1830 PSS SNMP support, see the 1830 Photonic Service 
Switch 36/32/16 Product Information and Planning Guide and the 1830 Photonic 
Service Switch 36/32/16 User Provisioning Guide. For information about SSH 
security, see the chapter Device discovery of the 5620 SAM User Guide.

To configure admin SNMP users using the CLI or the WebUI, see the 1830 Photonic 
Service Switch (PSS-1) Command Line Interface Guide or the 1830 Photonic Service 
Switch 36/32/16 User Provisioning Guide, for more information.

Note �  Before device discovery, ensure that the SNMP Source 
attribute of the 1830 PSS device is set to Loopback IP only.

Note �  The 5620 SAM supports SNMP v1, v2c, and v3 to manage 
the 1830 PSS nodes.
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7.1 1830 PSS device CLI sessions

You can perform most NE management functions using the 5620 SAM client GUI. 
The functions that require CLI access to a managed NE include:

• validating GUI configuration actions
• configuring items that cannot be configured using the GUI; for example, creating 

a community on the NE
• troubleshooting using device debug files

The 5620 SAM client GUI provides CLI access to the managed NEs from the main 
menu, and from NE contextual menus in topology maps and navigation trees. See the 
chapter Device CLI sessions of the 5620 SAM User Guide and the 1830 Photonic 
Service Switch (PSS-1) Command Line Interface Guide for more information.

7.2 Workflow to configure and manage CLI scripts on the 
1830 PSS

This workflow describes the high-level task to create, run, and schedule CLI scripts for 
the 1830 PSS. Use the 5620 SAM GUI to:

1 create a CLI script

2 run a CLI script

3 schedule a CLI script

See Procedure 7-1 for more information.

7.3 1830 PSS CLI scripts

Perform Procedure 7-1 to create, run, and schedule an 1830 PSS CLI script. See the 
5620 SAM Optical Parameter Reference for more information about configuring 
parameters.

As a prerequisite to Procedure 7-1, you need to change the username and password 
in the mediation policy. See the 5620 SAM User Guide for more information about 
the mediation policy.
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Procedure 7-1  To create, run and schedule an 1830 PSS CLI script

1 Choose Tools→Scripts from the 5620 SAM main menu. The Script Manager form 
opens.

2 Choose CLI Script (Scripting) from the object drop-down menu and click on the 
Create button. The CLI Script [Create] form opens with the General tab displayed.

3 Configure the parameters:

Enable the Use Latest Version parameter to associate all of the targets of the 
script with the latest version of the CLI script.

You can set the Content Type parameter to one of the following:

• CLI
• Velocity

4 Specify the script target types.

i Click on the Add button in the NE Types panel. The Select Property - CLI 
Script form opens.

ii Choose Alcatel-Lucent 1830 PSS type and click on the OK button. The Select 
Property - CLI Script form closes, and the NE type is listed in the CLI Script 
[Create] form.

5 Click on the Apply button to apply the configuration.

6 Click on the Versions tab.

7 Click on the Create button to create a script. The Script Editor script_name form 
opens. 

Warning �  Scripts that are not correctly created or applied can cause 
serious damage to the network. Alcatel-Lucent recommends that 
system administrators clearly define user responsibilities for CLI script 
usage, and ensure that the scripts are verified and validated before they 
are run on devices in a live network.

• Auto-Assign Id
• Script ID
• Name
• Description
• Type

• Use Latest Version
• Save Results from Manual Execution
• State
• Continue on Command Failure
• Content Type

Note �  If you choose Velocity, you can import a script by clicking on 
the Import button in the right panel of the Script Manager form.
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8 Create a version for a set of commands that must be executed on the 1830 PSS. 
The following commands can be created:

• show version�displays the device software release information
• show xc brief �lists the cross-connects on the NE
• whoami�lists the user that is logged in to the NE

9 Click on the Targets tab.

10 Click on the Create button. The Target Configuration form opens.

11 Click on the Add button, to add the target on which the created script must be 
run. The Select Network Elements form opens. 

12 Choose the target and click on the OK button. The selected target is displayed on 
the Target Configuration form. 

13 Click on the OK button. The target is created and the CLI Script [Edit] form is 
displayed. 

14 Perform one of the following in the right panel to run the script:

a Click on the Execute button. The script is executed.

b Click on the Schedule button. The Script Scheduled Task [Create] form is 
displayed. 

15  Perform the following to schedule a script:

i Configure the parameters:

• Scheduled Task Name
• Scheduled Task Description
• Save Results
• Administrative State

ii From the Schedule panel, click on the Select button. The Select Schedule - 
Script Scheduled Task form opens. 

iii Click on the Create button. The SAM Schedule [Create] form is displayed. 

iv Configure the parameters in the Information, Time Settings, Schedule 
Settings, and Frequency Settings panel.

v Click on the OK button. The Select Schedule - Script Scheduled Task form 
opens. 

vi Select the schedule task and click on the Properties button. The Script 
Scheduled Task [Create] form opens. 

vii Click on the Apply button. The schedule is created and will run at the 
scheduled time.

viii After the schedule is created, the Schedule tab is displayed on the CLI Script 
[Edit] form which displays the schedule information.
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16 Click on the Show Results button to view the results of the executed script or the 
scheduled script.

17 Close the CLI Script [Edit] form.

18 Close the Script Manager list form.

Note �  The executed script is displayed as N/A in the Schedule 
column. The scheduled script displays the information about the 
Schedule manager and the script.
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8.1 Equipment management overview

The 5620 SAM equipment management interface consists of:

• a main menu
• contextual menus
• a navigation tree
• managed objects
• property forms to configure object parameters

The 5620 SAM is used to create, configure, and manage a device with the various 
child objects that need to be part of a network. Equipment, for example, the routers, 
which are at the top of the hierarchy, have properties that are configured using the 
CLI and are discovered when the 5620 SAM discovery process is run.

After the device is discovered, you use properties forms to configure specific 
parameters for the child objects of the discovered device, using the 5620 SAM 
navigation tree. See the Device Management section of the 5620 SAM User Guide 
for more information on device management.

8.2 Workflow to manage the 1830 PSS equipment using the 
navigation tree

This workflow is used to manage the 1830 PSS device using the navigation tree. For 
more information, see the Device Management section in the 5620 SAM User Guide.

1 Use the 5620 SAM to discover the 1830 PSS device.

2 From the Discovered NEs topology group in the Equipment view of the navigation 
tree, choose List from the contextual menu, or double-click on the Discovered NEs 
icon on the topology map to open the Discovered NEs form.

3 Drag and drop the 1830 PSS NE to the network icon in the equipment view of the 
navigation tree or to the topology map.

4 Open the contextual menu on the 1830 PSS device in the navigation tree and 
choose an option. See the 5620 SAM User Guide for a list of contextual menu 
options.

5 Perform any of the following, as required.

a Modify the device parameters, as required, using the Properties option from 
the contextual menu.

b Create card objects in the shelf using the Properties option from the 
contextual menu in the Equipment view. See section 8.8 for more 
information.
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c View the parameters of the port objects that were created automatically 
with the daughter card object using the Properties option from the 
contextual menu in the Equipment view. See section 8.9 for more 
information.

d Modify the parameters of the created objects, as required, using the 
Properties option from the contextual menu in the Equipment view.

8.3 Workflow to manage the 1830 PSS equipment 

This workflow is used to manage the 1830 PSS device. For more information, see the 
Device Management section in the 5620 SAM User Guide.

1 Verify that the 1830 PSS devices are configured before they are discovered by the 
5620 SAM.

2 Access the 1830 PSS device and begin configuration and management.

From the 5620 SAM, Manage→ Equipment→ Equipment, Manage Equipment form, 
network administrators and operators can:

• filter different views and information for the managed devices
• view and use a graphical representation of the shelf to configure equipment
• view objects and get statistical information about the NEs in their 

administrative domain
• view the services that traverse or terminate on equipment
• provision and pre-provision equipment to prepare the equipment for the 

creation of subscriber services
• view, configure, monitor the state of, and manage the following physical 

elements of the hardware:
• a managed device
• each device has one physical shelf
• internal and external storage devices (flash memory)
• physical links
• Current OLC State

• configure network and access policies for network objects, for example, 
ingress buffer policies for a port

• view and manage APS groups
• manage hardware fault conditions

8.4 Working with objects

Objects in the 5620 SAM are considered to have parent/child relationships that are 
contained within a hierarchy. For example, a card in a card slot is the parent object 
of a daughter card. The parameters for each object are configured for a specific 
function. The parameters can be managed to meet the needs of the service. Objects 
are created and managed using the properties forms from the contextual menus of the 
equipment view.
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The network is the top object in the navigation tree. The device object is the 
discovered device at the top of the hierarchy in the navigation tree, directly below the 
network icon. The child objects are created automatically in the navigation tree after 
the device is discovered.

Resynchronization of objects
The Resync option of the contextual menu specifies that SNMP MIB and CLI 
information bases are reread to synchronize them with the 5620 SAM, which also 
synchronizes the network management settings with the device. The changes in the 
values for some of the read-only parameters from the 1830 PSS are not updated 
automatically. These parameters are identified by the resync icon that is beside the 
parameters. To view the updated values of the parameters, click on the resync icon. 

8.5 Managing ROADM OADM and Mesh connections (Degree 2+)

The ROADM OADM (degree 2) faces both the east and west directions. Some traffic 
from the optical lines may be added or dropped and at least one single wavelength 
passed through transparently. This configuration can be used as an optical add or 
drop multiplexer in linear networks.

The WR8-88A supports up to degree 5 mesh connections without the need for 
additional mesh cards. For this connectivity, the mesh output port 
(MESHOUT{1-3}) of a WR8-88A card is connected directly to the add input port 
(ADDIN{1-8}) of another WR8-88A. Three mesh outputs are required for degree 5 
connectivity. See Table 8-1 for more information.

The ROADM OADM Mesh (degree 3 through 8) faces more than 2 line directions. 
Individual channels come in from one line and may be added or dropped or transit 
transparently to any one of the other lines.

See the Alcatel-Lucent 1830 Photonic Service Switch Product Information and 
Planning Guide for more information.

Table 8-1 ROADM�2 Degree 8 ROADM Connectivity

Note �  If the 1830 PSS-32 network contains WR8-88A and CWR 
cards, use the ‘Exclusion’ option in the Path Constraints tab, to 
accelerate the path search and transport service creation. See 
Procedure 12-1 for more information.

From Port To Port From To

WR1 DROPOUT � � ITLU+SFD

WR1 THRU Out � � WR2 THRU In

WR1 MESHOUT1 � � WR3 ADDIN3

WR1 MESHOUT2 � � WR4 ADDIN3

WR1 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR5 ADDIN3

WR1 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR6 ADDIN3

WR1 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN3

(1 of 3)
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WR1 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN3

WR2 DROPOUT � � ITLU+SFD

WR2 THRU Out � � WR1 THRU In

WR2 MESHOUT1 � � WR3 ADDIN4

WR2 MESHOUT2 � � WR4 ADDIN4

WR2 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR5 ADDIN4

WR2 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR6 ADDIN4

WR2 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN4

WR2 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN4

WR3 DROPOUT � � ITLU+SFD

WR3 THRU Out � � WR4 THRU In

WR3 MESHOUT1 � � WR1 ADDIN3

WR3 MESHOUT2 � � WR2 ADDIN3

WR3 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR5 ADDIN5

WR3 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR6 ADDIN5

WR3 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN5

WR3 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN5

WR4 DROPOUT � � ITLU+SFD

WR4 THRU Out � � WR3 THRU In

WR4 MESHOUT1 � � WR1 ADDIN4

WR4 MESHOUT2 � � WR2 ADDIN4

WR4 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR5 ADDIN6

WR4 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR6 ADDIN6

WR4 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN6

WR4 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN6

WR5 DROPOUT � � ITLU+SFD

WR5 THRU Out � � WR6 THRU In

WR5 MESHOUT1 � � WR1 ADDIN5

WR5 MESHOUT2 � � WR2 ADDIN5

WR5 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR3 ADDIN5

WR5 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR4 ADDIN5

WR5 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN7

WR5 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN7

WR6 DROPOUT � � ITLU+SFD

WR6 THRU Out � � WR5 THRU In

WR6 MESHOUT1 � � WR1 ADDIN6

WR6 MESHOUT2 � � WR2 ADDIN6

From Port To Port From To

(2 of 3)



8 �  1830 PSS equipment management

Alcatel-Lucent 5620 Service Aware Manager, Release 10.0 R7 January 2013 8-7
3HE 06986 AAAG TQZZA Edition 01
Optical User Guide

8.6 Managing One-device Anydirection and Two-device 
Anydirection configuration connections

One-device Anydirection configuration
For this configuration, the Add drop block and the connection block are on the same 
device. The configuration that can be used is the Mesh card (optional) with WR8, 
WR8-88A and CWR8-88 cards.

WR6 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR3 ADDIN6

WR6 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR4 ADDIN6

WR6 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR7 ADDIN8

WR6 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR8 ADDIN8

WR7 DROPOUT � � ITLU+SFD

WR7 THRU Out � � WR8 THRU In

WR7 MESHOUT1 � � WR1 ADDIN7

WR7 MESHOUT2 � � WR2 ADDIN7

WR7 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR3 ADDIN7

WR7 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR4 ADDIN7

WR7 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR5 ADDIN7

WR7 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR6 ADDIN7

WR8 DROPOUT � � ITLU+SFD

WR8 THRU Out � � WR7 THRU In

WR8 MESHOUT1 � � WR1 ADDIN8

WR8 MESHOUT2 � � WR2 ADDIN8

WR8 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT1 WR3 ADDIN8

WR8 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT2 WR4 ADDIN8

WR8 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT3 WR5 ADDIN8

WR8 MESHOUT3 MESH4 SIGIN MESH4 SIGOUT4 WR6 ADDIN8

From Port To Port From To

(3 of 3)

Note �  Service provisioning, discovery and topological views are 
supported for protected and unprotected services for One-device 
Anydirection and Two-device Anydirection configurations. See 
Procedure 12-1 for more information.
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Figure 8-1  Two-device Anydirection connectivity

Two-device Anydirection configuration
Two-device Anydirection configuration is supported on two devices for Add and 
Drop blocks at the terminal on one device and connection blocks on the other device. 
The following configurations are supported in the Add and Drop blocks and the 
connection blocks.

Two devices with no MESH4 card in Add path

With this configuration, the limitations in degrees are:

• N<=5 with configuration not allowing in–service upgrade to higher degrees
• N<=4 with configuration allowing in–service upgrade to higher degrees
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Figure 8-2  Two devices with no MESH4 card support

Two devices with one MESH4 card in Add path

This Add and Drop block allows a configuration up to degree 8+2.

Figure 8-3  Two devices with one MESH4 card support
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8.7 Procedures to manage shelves

The 1830 PSS-32 and 1830 PSS-16 shelves provide the framework for the 
configuration of the 1830 PSS-32 / 1830 PSS-16 NEs. A universal shelf provides 
card slots, fiber management trays, backplane, power distribution, and cooling for 
the NE. The NEs can be deployed in a shelf or expanded to multiple interconnected 
universal shelves.

The first universal shelf of an NE becomes the master shelf, which provides the 
management and control connections to the operations systems for the cluster of 
shelves in a multi-shelf NE. Expansion shelves connect to the master self using a 
protected internal LAN communication link. The shelves provide extended slot 
capacity managed by the database that resides in the master shelf.

The universal shelf is the basic building block for the 1830 PSS-32 NE. The shelf 
provides a framework for the active modules in a system (for example, the controller 
and interface cards).

Each universal shelf has a shelf ID number that can be configured using a physical 
mechanism (for example, a rotary dial) on the backplane. Up to eight bits of 
information can be set. The shelf ID determines the identity of each universal shelf 
in the cluster. The most significant bit of the rotary dial determines whether the shelf 
is the main shelf or an extension shelf.

Each shelf contains mandatory modules equipped; some of the shelves can also have 
optional modules equipped.

The mandatory equipment must be automatically provisioned regardless of whether 
the equipment is present. Each shelf includes the following mandatory equipment:

• one shelf controller (EC) in slot 1 or 18
• two power modules (PF)
• a fan module (FAN)

The user interface panel (USRPNL) is mandatory and can only reside on the main 
shelf. Mandatory equipment is provisioned without an AINS state. The AINS allows 
newly provisioned entities to be inserted at a later time without generating alarms. If 
mandatory equipment is not installed, alarms are generated.

A DCM enclosure can hold up to 16 DCMs. The system manages each DCM as a 
separate shelf.

See the Alcatel-Lucent 1830 Photonic Service Switch Product Information and 
Planning Guide and the Alcatel-Lucent 1830 Photonic Service Switch User 
Provisioning Guide for more information. See the 5620 SAM Optical Parameter 
Reference for more information on parameters.

1830 PSS-32 shelves
The 1830 PSS-32 system supports four types of shelves: Universal, DCM, ITLB, and 
ITLU. The 1830 PSS-32 universal shelf contains 32 replaceable slots.

The SFD44 (44-channel DWDM static filter) is modelled as an OMD shelf with a 
SFD44 card. Other shelves that can be configured from 5620 SAM are, SFD40, 
SFD40B, SFD44B and ITLB.
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The DCM and OMD shelves are passive module shelves that can contain DCMs and 
SFD44 modules. These modules provide dispersion compensation and the optical 
mux/demux function that is associated with core optics modules (line drivers and 
CWR8, respectively) that are installed in the universal shelf. Each 1830 PSS-32 NE 
includes up to 8 universal shelves, and up to 24 DCM and OMD shelves.

Each 1830 PSS-32 universal shelf contains 32 function card slots. Two additional 
slots are reserved for controller cards that are configured for redundant control. Two 
more slots are reserved for the power filter cards. The top of the shelf contains a fan 
tray for cooling, a customer interface panel, and two timing interface cards that 
provide a redundant connection to synchronization references. See the 
Alcatel-Lucent 1830 Photonic Service Switch Product Information and Planning 
Guide and the Alcatel-Lucent 1830 Photonic Service Switch User Provisioning 
Guide for more information. 

1830 PSS-16 shelves
In addition to the slots for the two power filters and two controller cards, the 
1830 PSS-16 shelf contains 16 function card slots. The 1830 PSS-16 supports four 
types of shelves: PSS 16, DCM, ITLB, ITLU. The slots at the top of the shelf can 
hold two function cards or the user interface panel on units that are used as main 
shelves. A fan tray for cooling is located at the bottom of the shelf. The 5620 SAM 
supports up to eight extension shelves. See the Alcatel-Lucent 1830 Photonic 
Service Switch Product Information and Planning Guide and the Alcatel-Lucent 
1830 Photonic Service Switch User Provisioning Guide for more information. 

1830 PSS-4 shelves
The 1830 PSS-4 provides a modular platform with four universal slots that can be 
used for cards that support ILAs and various FOADM and terminal configurations. 
The 1830 PSS-4 supports DCM shelves. The 1830 PSS-4 shelf is two RU high and 
can be mounted in EIA, ETSI, or WECO racks. See the Alcatel-Lucent 
1830 Photonic Service Switch 4 (PSS-4) User Guide for more information about the 
1830 PSS-4 shelves.

1830 PSS-1 AHP shelves
The 1830 PSS-1 AHP system supports two types of shelves: Universal and DCM. 

Working with shelves on the 1830 PSS
Shelf objects represent the hardware that is configured on a shelf. When you choose 
the shelf object in the navigation tree and click on Properties in the contextual menu, 
you can view the following information about the shelf:

• general information • statistics
• fan tray state and speed • dry contacts
• power supply tray statuses • faults
• LED statuses • port segregation
• card slots • software control module
• hardware environment information • software bank information
• timing • cross connects
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Procedure 8-1  To view/edit a shelf

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE→Shelf.

3 Right-click on the Shelf and choose Properties. The Shelf [Edit] form is displayed.

4 Click on the relevant tabs to view or edit shelf information.

See the 5620 SAM Optical Parameter Reference and the 5620 SAM Parameter Guide for 
more information.

Procedure 8-2  To configure a shelf

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE. 

3 Right-click on the NE and choose Configure Shelf. The Shelf, Configure Shelf, 
[Create] form opens.

4 Configure the parameters:

• Name
• Shelf Description
• Serial Number

Select: 

• Shelf Type 
• AINS Enabled
• Expected PF Amps
• Shelf ID

5 Click on the OK button. The Shelf, Configure Shelf, [Create] form closes.

See the 5620 SAM Optical Parameter Reference for more information.

Note �  During the creation of an ITLB shelf, one ITLB card slot is 
automatically provisioned.
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Procedure 8-3  To remove a shelf

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE. 

3 Right-click on the shelf and choose Remove Shelf. A dialog box opens. 

4 Click on View Dependencies, an Information form displays the dependencies that 
will affect the removal of the shelf.

5 Select �I understand the implications of this action� check box and click on Yes. 
The shelf is removed from the network object.

8.8 Procedures to manage card slots

This section describes the procedures for slot and card-level provisioning. The 
5620 SAM GUI supports view, modify, create, and delete card-level functions, and 
the pre-provisioning of a card in an empty slot. For transmission cards supported on 
the universal shelf, see Table 8-3 for more information. For dedicated cards required 
to boot the 1830 PSS, see Table 8-4 for more information. See the 5620 SAM Optical 
Parameter Reference for more information on parameters.

Procedure 8-4  To configure a card

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Select an empty slot from the equipment tree to provision a card. Choose 
Network→NE→Shelf→Card Slot (EMPTY), OK. 

3 Right-click on the Card Slot (EMPTY) and choose Configure Card. The Card Slot 
[Create] form opens.

4 Configure the parameters on the General tab:

• Assigned Card Type
• Assigned Card Sub Type
• Current OLC State
• Revert OLC State

Note 1 � You must use filler blanks in slots that are not used to 
ensure proper airflow and cooling.

Note 2 � To provision two-slot height cards and two-slot width 
cards, the adjacent slots must be empty.
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5 Configure the parameters on the Card Specifics tab for Amplifier cards. See the 
5620 SAM Optical Parameter Reference Guide for more information.

• Card Details panel
• Ethernet Loopback

• Temperature panel
• Optical Intrusion Detection

Prerequisite: To provision these parameters, an external topological link 
should be configured on a line port.

• Monitoring Enabled
• Baseline Span Loss (dB)
• Loss Threshold (dB)
• Polling Period (seconds)
• Clear Optical Intrusion Detected Alarm

6 To configure SyncE, configure the parameters on the Card Specifics tab. See the 
5620 SAM Optical Parameter Reference Guide for more information.

i Click on the Line Timing tab.

ii Choose a Line Reference from the list and click on the Properties button. The 
LineReference [Edit] form displays.

iii Configure the parameters. Table 8-2 lists the ports and line references for 
the 11DPE12A and the 11DPE12E cards.

Note �  Only 11DPE12A cards support Ethernet Loopback.

Note 1 � Only 11DPE12 cards support the following Card Rate Mode:

• FullRate
• SubRate
• QinQ

Note 2 � Only 11DPE12E cards support the following Card Rate Mode:

• QinQ

Note 3 � Only AM2318A and the AM 2125B cards support Optical 
Intrusion Detection.

Note �  The following cards that are installed on the 1830 PSS-4, 
1830 PSS-16, or 1830 PSS-32 NE support SyncE:

• 11DPE12A
• 11DPE12E
• 11QPE24
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Table 8-2 Line references and ports

iv Click on the OK button to save the changes. The LineReference [Edit] form 
closes.

v Click on the General tab.

vi Configure the parameters in the System Timing panel.

7 Click on the OK button to save the changes. The Card Slot [Create] form closes.

Procedure 8-5  To view or modify a card

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Right-click on the card to be modified and choose Properties. The Card Slot [Edit] 
form is displayed. 

3 Modify the parameters, as required. Click on the OK button to save the changes 
and exit the Card Slot [Edit] form.

Procedure 8-6  To remove a card

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Right-click on the card to be removed and choose Remove Card.

3 A dialog box opens. Select the �I understand the implications of this action� check 
box and click Yes. The card is removed from the navigation tree.

Cards Ports Line reference

11DPE12A C{1-12} Line Ref 0

C{1-12} Line Ref 1

L1 Line Ref 2

L2 Line Ref 3

11DPE12E C{1-4, 9-12} Line Ref 0

C{5-8} Line Ref 1

L1 Line Ref 2

L2 Line Ref 3
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Dry contacts
Dry contact refers to a contact of a relay that does not make or break a current. 
Usually another relay or device starts or stops the current. For example, a reed relay 
matrix switch is usually switched with all contacts dry. After the contacts are 
connected, a wire spring relay connects a supervisory scan point through which the 
current flows. 

Procedure 8-7  To configure 1830 PSS dry contact sensors

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE→Shelf→Card Slot (USRPNL - User Interface Panel)

3 Right-click on the card slot and choose Properties. The Card Slot (User Interface 
Panel) [Edit] form is displayed.

4 Click on the External Control tab. Choose a dry contact ID from the list. 
Double-click on the dry contact ID. The DryContact [Edit] form is displayed for the 
selected ID.

5 Configure the following parameters:

• Control Status (Choose one of the following options.)
• Operate
• Raman APR
• Release

• Control Type
• Slot ID (only if Raman APR is selected)

6 Click on the OK button. The DryContact [Edit] form closes. 

7 Click on the OK button. The Card Slot User Interface Panel [Edit] form closes.

8.9 Procedures to manage ports

The 5620 SAM supports a physical topology view that allows you to create a fiber 
connection by selecting two ports on the displayed shelves. The connection can be 
made between two ports on the same or different shelves. 

For an interface (that is a shelf, slot, or port), you can specify that the interface is:

• connected to another on the network element
• connected to an external within or outside of the 1830 PSS network
• unconnected

Note �  You can create a fiber connection only with ports that are not 
already part of a fiber connection. 
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To define the network topology, you first configure the fiber topology on each 
network element in the network. You can then connect the external interfaces on 
each of the network elements to create the network.

Procedure 8-8  To create an optical link between ports

1 Perform one of the following to create an optical link between two ports on the 
same shelf:

a Choose Create→Equipment→Optical Link.

b Click on Network→NE→Shelf→Card→Port (Select two ports, use the Ctrl key 
or the Shift key to select the second port) and right-click on the selected 
ports and choose Create Optical Link.

2 The Optical Link [Create] form opens.

3 Configure the parameters:

• Name
• Direction
• Endpoint A - Port
• Endpoint B- Port

4 If a rate has not been assigned to the endpoint A port, choose an option from the 
Assigned Rate drop-down menu in the Endpoint A - Port panel.

5 If a rate has not been assigned to the endpoint B port, choose an option from the 
Assigned Rate drop-down menu in the Endpoint B - Port panel.

6 Click on the OK button to save the changes and exit the Optical Link [Create] form.

Note �  When you choose two ports from the Equipment tree, the port 
properties are automatically populated for endpoint A and B. 
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Procedure 8-9  To delete an optical link

1 Perform one of the following to delete an optical link:

a Choose Manage→Equipment→Equipment. The Manage Equipment form 
opens.

i Choose Optical Link (Optical Specifics) from the Filter for Object Type 
drop-down menu.

ii Click on the Search button. The search result displays the connected 
ports.

iii Choose the optical link ports that you need to delete and click on the 
Delete button. The optical link between two ports is deleted.

b From the Physical Topology - Network view:

i Double-click on an optical link.

ii The Physical Link Group List form opens.

iii Choose the port that you need to delete

iv Click on the Delete button. 

2 The optical link between the selected ports is deleted.

Port properties
To configure time slots on ports, see Procedure 12-9 and the 5620 SAM User Guide 
for more information.

To configure a port on an 1830 PSS device based on the relevant port, follow 
Procedure 8-10. See the 5620 SAM Optical Parameter Reference for more 
information.

The CIT interface can be configured to auto-disabled after the 1830 PSS is installed. 
To auto-disable the CIT port see Procedure 8-11. See the Alcatel-Lucent 
1830 Photonic Service Switch User Provisioning Guide for more information.

Procedure 8-10  To configure a port

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Right-click on the device where you want to configure a port and select Properties 
from the contextual menu. The Network Element (Edit) form opens with the 
General tab displayed.

3 On the Network Element (Edit) form navigation tree, expand the Shelf icon.

4 Expand to the port level and click on a port object. The Physical Port (Edit) form 
opens with the General tab displayed.
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5 Configure the General tab parameters.

6 Configure the Port Specifics tab parameters based on the port that needs to be 
configured.

7 Click on the States tab and configure the Administrative State parameter.

8 Click on the other tabs in the properties form to view and edit additional port 
information.

9 Click on the OK button. The Physical Port (Edit) form closes.

Procedure 8-11  To auto-disable a CIT port on an EC card

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE→Shelf→Card Slot (EC: Equipment Controller Card)→Port 
CIT (Local Ethernet Port). 

3 Right-click on the Card and select Properties. The Physical Port [Edit] form opens. 

4 Click on the Port Specifics tab and select the Auto-Disable port Status panel.

5 Enter the 5620 SAM server IP in the Source IP field and click on Apply. The Disable 
Port Automatically check box is enabled. Select the check box and click on Apply. 
The CIT port is disabled for local access.

8.10 Performance monitoring overview

PM refers to the in-service, non-intrusive monitoring of transmission quality and 
equipment health. The 1830 PSS tracks the signal quality and equipment health 
through continuous collection and analysis of performance data. The user can 
retrieve current and past values for an overview of the health of the system. The PM 
capability applies to optical lines, channels, and equipment. The user has the ability 
to provision threshold parameters to the level of performance degradation.

Proactive maintenance refers to following up on a performance degradation before a 
failure and alarms are raised. Reactive maintenance refers to following up on a 
system alarm. Crossing a performance parameter threshold indicates a potential 
network quality or performance degradation while the transported services are not 
impacted. If performance degradation continues, alarms are raised to resolve or 
repair the problem.

Note �  As long as the 1830 PSS can reach the 5620 SAM server the CIT 
port remains in the disabled state. The 1830 PSS will check the 
communication link between the 5620 SAM server every 30 seconds. If 
the server is unreachable, the NE will wait for 300 seconds before the 
CIT port is enabled for local access.
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PM statistics are collected for all service cards and for all interface ports that perform 
OEO conversions or protection switching. The statistics are grouped by functional 
category. Each category has several monitored parameters for which you can 
configure TCAs. A threshold is the mechanism for generating a notification in 
response to changes in PM parameter values. The 1830 PSS allows you to provision 
performance parameter thresholds, which can be set by the user to indicate degraded 
performance. You can configure how much data is collected, how the data is stored, 
and how and when you are notified if generic thresholds levels are crossed. For 
information about performance management requirements see the Alcatel-Lucent 
1830 Photonic Service Switch User Provisioning Guide and the Alcatel-Lucent 
1830 Photonic Service Switch Product Information and Planning Guide.

PM process
The 1830 PSS provides the following PM processing functions:

• monitors and accumulates digital and analog parameters for a physical or logical 
access point 

• stores and manages history accumulation data; up to thirty three 15-minute and 
seven 24-hour accumulation registers can be stored

• validates threshold crossing processing
• manages threshold values by assigning to profile port entities
• uses free-running counters for monitored points

PM functions are performed on physical and logical points within the 1830 PSS 
devices that represent the boundary with other devices or an external system. A user 
can define and monitor QoS at individual points in which a local NE interacts with 
other network entities.

8.11 Performance statistics

The 5620 SAM can be configured to collect statistics counters from 1830 PSS 
devices and 5620 SAM servers. 

The 5620 SAM supports the following for 1830 PSS devices: 

• assign the default 1830 PSS Performance Management Policy to the 1830 PSS 
device and enable the policy by setting the Administrative State to Up.

• specify a retention period in the Statistics Policy which indicates the period after 
which the statistics records are removed from the database.

• collect scheduled statistics using TFTP to view historical statistics by selecting 
the required PM group and clicking on the Search button.

• collect on-demand statistics using SNMP polling to view historical and real-time 
statistics by clicking on the Collect or Collect All button.

Bins and intervals
The performance parameters groups obtained during the parameter processing are 
collected in registers over measurement periods of 15 minutes and 24 hours. The 
collection of registers associated with a PM group and collection period is called a 
bin. 
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On 1830 PSS device

The 15-minute bins collect data at quarterly time intervals (00,15,30, 45) of the 
1830 PSS clock. The 24-hour bins collect data from midnight to midnight based on 
UTC, not the local time. At the end of each 15-minute time interval, the contents of 
the 15-minute bin is transferred to the previous 15-minute bin. The 15-minute bins 
are then initialized to zero and a new record is initiated. Each PM group consists of 
thirty three 15-minute bins and seven 24-hour bins. When the storage capacity of 
thirty three 15-minute bins is reached, the oldest of the bins are dropped. The 24-hour 
bins operate in the same manner.

1830 PSS statistics storage on the 5620 SAM server

The 1830 PSS statistics are stored in the following directory on the 5620 SAM 
server: 

/opt/5620sam/server/nms/tftp_home/stats 

The files are retained for 24 hours by default. The bins can be cleared by configuring 
the number of bins to be cleared for each interval. See Procedure 8-14.

Statistics collection
The file-based statistics are collected from the files on the 1830 PSS devices using 
TFTP. The statistics are available for scheduled collection and enables viewing the 
historical statistics. 

The MIB-based statistics are collected from the 1830 PSS MIBs using SNMP 
polling. The statistics are available for on-demand collection and enables viewing the 
real-time and historical statistics.

Scheduled and on-demand statistics are stored in the 5620 SAM database for a 
configurable retention period, as specified in Procedure 8-13, and are available to the 
5620 SAM operators. When the retention period elapses, the statistics are removed 
from the database.

Statistics collected for real-time display are available only for the duration of the 
session and for the operator who initiates the session. Real-time statistics are not 
stored in the 5620 SAM database.

The 5620 SAM allows you to back up statistics data to another location. See 
procedure, “To back up the 5620 SAM database using the client GUI” in the 
5620 SAM User Guide for information about how to back up the 5620 SAM 
database. 

8.12 Workflow for performance statistics collection

1 Modify 1830 PSS Performance Management Policy to assign 1830 PSS devices to the 
policy and enable the policy by setting the Administrative State to Up. See 
Procedure 8-12.

2 Specify the retention time for a statistics record. See Procedure 8-13.
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3 Collect and display the statistics values in a current statistics record. See 
Procedure �To view on-demand statistics� in the 5620 SAM Statistics Management 
Guide for information about viewing on-demand statistics.

4 Configure real-time and historical statistics graph. See Procedure �To configure 
and plot a statistics graph� in the 5620 SAM Statistics Management Guide for 
information about creating a real-time and historical statistics graph.

5 Use the 5620 SAM-O interface to retrieve the performance statistics records from 
the 5620 SAM for processing by a third-party application. See the 
5620 SAM XML OSS Interface Developer Guide for information about using the 
5620 SAM-O to transfer statistics records from the 5620 SAM database to an OSS 
client application.

8.13 1830 PSS statistics procedures

Perform the procedures in this section to configure the 5620 SAM for 1830 PSS 
statistics collection. 

Procedure 8-12  To modify a 1830 PSS Performance Management 
Policy

1 Choose Tools→Statistics→Optical Performance Management Policies from the 
5620 SAM main menu. The Optical Performance Management Policies form opens.

2 Choose the default 1830 PSS performance management policy and click on the 
Properties button. The 1830 PSS Performance Management Policy [Edit] form 
opens with the 1830 PSS Performance Management Policy tab displayed.

3 Configure the parameter, Administrative State.

4 Click on the Apply button. A dialog box is displayed. 

5 Click on Yes to confirm the action.

6 Click on the 1830 PSS Elements tab.

7 Configure the filter criteria, if required, and click on the Search button to 
generate a list of 1830 PSS elements that are already assigned to the 1830 PSS 
performance management policy.

8 Click on the Assign 1830 PSSs button. The Assign and Assign Filter forms open.

9 Configure the filter criteria, if required, and click on the OK button to close the 
Assign Filter form and return to the Assign form.

10 Use the right and left arrows in the center of the form to move the 1830 PSS 
devices between the Unassigned PSSs panel and the Assigned PSSs panel, as 
required.

Note �  The default value for the Administrative State parameter is 
Down for an 1830 PSS Performance Management Policy. Set the 
Administrative State parameter to Up to activate statistics collection.
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11 Click on the Apply button to deploy the 1830 PSS performance management policy 
to the assigned PSS.

12 Click on the Cancel button to close the Assign form.

13 Click on the OK button to close the 1830 PSS Performance Management Policy 
(Edit) form.

14 Close the Optical Performance Management Policies form.

Procedure 8-13  To configure retention time for file-based statistics

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→1830 PSS→Shelf→Card Slot→Port.

3 Right-click on the Port and choose Properties from the contextual menu. The 
Physical Port [Edit] form opens with the General tab displayed.

4 Click on the Statistics tab. The Administrative State and Retention Time columns 
are displayed.

5 Choose an object type from the Select Object Type drop-down menu.

6 Click on the Statistics Policies button and choose the Statistics Policy from the 
drop-down list. The Statistics Policy form appears with the name of the selected 
Object Type. Configure the parameters:

• Retention Time (hours)
• Administrative State

7 Click on the Purge Statistics Records to purge all statistics records.

If these buttons are not visible, click on the More Actions button and choose the 
corresponding option from the drop-down menu.

8 Click on the OK button. A dialog box appears. Click on the Yes button to proceed, 
the Statistics Policy form closes.

9 Click on the OK button. The Physical Port [Edit] form closes.

Note �  Choose the PM-supported ports.
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Procedure 8-14  To clear the 1830 PSS bins

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Perform one of the following actions:

a For an EC card, choose Network→1830 PSS→Shelf→Card

b For other cards, choose Network→1830 PSS→Shelf→Port

3 Right-click on the card slot or port and choose Properties from the contextual 
menu.

4 The Card Slot/Physical port form opens. Click on the Card Specifics tab for the 
card and port Specifics tab for the port. Click on the Performance tab.

5 Choose a profile type, select a profile, and click on the Properties button. The TCA 
Profile Assignment form opens with the General tab displayed. 

6 Configure the number of bins for each interval and choose from the drop-down, 
the option to clear bins. You can also assign a profile ID for each interval. See 
Procedure 8-16 to assign a profile ID.

7 Click on the OK button. The TCA Profile Assignment form closes.

8 Click on the OK button. The Card Slot/Physical port form closes.

8.14 PM profile types supported for line ports on amplifier cards

Inter-device management and control information is communicated over the 
Amplifier. The Amplifier card line ports support their own statistics profiles. The 
Amplifier is a separate optical channel that operates at the STM-1/OC-3 rate of 155 
Mb/s. The Amplifier transfers management and control information between the ECs 
of two adjacent NEs, regardless of whether any of the DWDM payload channels are 
terminated between the two NEs. The channel transports IP and OSI PDUs. See the 
Alcatel-Lucent 1830 Photonic Service Switch Product Information and Planning 
Guide for more information.

8.15 Procedures for TCA profiles

The 5620 SAM supports all TCAs that are provided by the NE. The support includes 
configuring thresholds, distributing TCA profiles, and reporting on crossings (for 
example, raising and clearing of appropriate alarms). See the Alcatel-Lucent 
1830 Photonic Service Switch User Provisioning Guide for more information about 
TCA support on the 1830 PSS.
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TCA profiles

You can configure and assign a profile to an interval to monitor the value of each 
parameter in the active bin and raise a log event if a specific threshold level is 
reached. If a specified threshold is crossed, an alarm is raised.

You can configure each PM group with up to eight profiles, each profile can have 
different threshold levels. The 5620 SAM allows you to modify the TCA profiles. 
The threshold levels that you configure depend on the following factors:

• the interval length — for example, to gather statistics for an interface over 15m 
and 24h intervals you need to define two profiles: one that defines for the 15m 
interval and another for the 24h interval

• the service level of the traffic using the interface

Procedure 8-15  To configure thresholds for TCA profiles

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Tools→1830 PSS TCA Profiles to open a list of TCA profiles. The 1830 PSS 
TCA Profiles form opens.

3 Choose a profile type and a profile ID from 1 to 8 and click on the Properties 
button. The NE TCA Profiles [Edit] form opens.

4 Click on the TCA Thresholds tab to display a list of TCA variable names with their 
threshold values.

5 Choose a TCA variable name and click on the Properties button. The NE TCA 
Thresholds [Edit] form opens. 

6 Enter a threshold value and click on the OK button. The NE TCA Profiles [Edit] form 
is displayed. 

7 Click the OK button. A dialog box is displayed.

8 Click on the Yes button to accept the changes. 

Note 1 � These profiles are always on the 1830 PSS and cannot be 
deleted. Each profile contains a set of counters and parameters for 
which threshold values can be configured.

Note 2 � The global policy should be released for all discovered 
1830 PSS NEs. To modify only a specific NE, modify only local 
definitions. 

Note �  By default, profile ID 7 contains threshold values that can be 
applied to the 15m interval, and profile ID 8 contains threshold values 
that can be applied to the 24h interval.
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Procedure 8-16  To assign TCA profiles to an EC card or port

After the profiles are assigned to an EC card or a port, see Procedure 8-15 for more 
information.

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE→Shelf→Card or Port (EC: Equipment Controller Card).

3 Right-click on the card slot or port and choose Properties from the menu. The Card 
slot/Physical port form opens.

4 Click on the Card Specifics/Port Specifics tab and then click on the Performance 
tab.

5 Click on the Profile Type, choose a profile, and click on the Properties button. The 
TCA Profile Assignment form opens. 

6 Configure the parameters as required.

7 Click on the OK button. The TCA Profile Assignment form closes.

8 Click on the OK button. The Card Slot/Physical port form closes.

Configuring PM
The prerequisites to configure PM are:

• Determine the interfaces and cards that you need to configure to collect PM data.
• Configure the profiles to specify the threshold levels at which log events are 

generated for the PM groups to be monitored on the NE.
• Configure each of the interfaces and cards on the NE for which you need to 

collect PM statistics. Configure the PM statistics to collect, the interval period 
over which they are collected, and the profile used for each interval period.

Viewing PM data

PM data is recorded in logs or bins. Logs record all of the TCAs that occur on the 
NE. The bins store data collected on a specific card or interface over a specific 
interval. In addition a raw bin for each PM group collects data until the data is 
cleared.

Note 1 � Only EC cards can be assigned to a PM TCA profile.

Note 2 � You can assign unique profiles for 15m intervals and 24h 
intervals for each EC card and port. 

Note �  When PM data is not available, PM parameter names are 
displayed with blank values.
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Cards and ports that support PM data
Table 8-3 lists the transmission cards and ports that support PM data.

Table 8-3 Transmission cards and ports

Note �  The 11STMM10 hardware does not support GbE PM 
statistics in the egress direction. TX side of the PM data is not 
displayed for the 4DPA2 client or line ports.

Cards Ports

112SA1L
112SCA1

L1, C1

112SCX10
112SX10L

L1, C {1 to 10}

112SNA1 L1, C1

112SNX10 L1, C {1 to 10}

11DPE12
11DPE12A
11DPE12E

L {1, 2}, VA {1, 2}, C {1 to 12}

11DPM12 L {1, 2}, VA {1, 2}, C {1 to 12}

11QPA4 L {1 to 4}, VA {1 to 4}, C {1 to 4}

11QPE24 X {1 to 4}, C {1 to 11, 24}, VA {1 to 4}

11QPEN4 L {1 to 4}, C {1 to 4}, VA {1 to 4}

11STAR1 L1, C1

11STAR1A L1, C1

11STGE12 L1, C {1 to 10}

11STMM10 L1, C {1 to 10}

43STA1P L1, C1

43STX4
43STX4P

L1, C {1 to 4}

43SCA1 L1, C1

43SCX4
43SCX4E
43SCX4L

L1, C {1 to 4}

4DPA2 L {1, 2}, C {1, 2}

4DPA4
(Card Mode = FlexMux)

L {1, 2}, C {1 to 4}, VA {1, 2}

4DPA4
(Card Mode = DualTran)

L {1, 2}, C {1, 3}, VA {1, 2}

PSS1GBE L {1, 2}, C {1 to 12}

PSS1MD4
(Card Mode = FlexMux)

L {1, 2}, C {1 to 4}

(1 of 2)
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Table 8-4 lists the dedicated cards that are required to boot the 1830 PSS.

Table 8-4 Dedicated cards and ports

PSS1MD4
(Card Mode = DualTran)

L {1, 2}, C {1, 3}

PSS1P21 L1, C {1 to 21}

A2325A
ALPHG
AHPHG
AHPLG
AM2017B
AM2325B

OSC, LINE, LINE- {9170~9605}

ALPFGT OSCSFP, LINE, SIG, LINE- {9170~9605}

AM2318A and AM2125A OSCSFP, LINEIN, LINEIN- {9170~9605}, 
LINEOUT, LINEOUT- {9170~9605}

AM2125B OSCSFP, LINEIN, LINEOUT

EC No port, PM data collected on the EC 
card and not on the port level

OSCT OSCSFP, LINE, LINE- {9170~9605}

MVAC G {1 to 8}

MVAC8B L {1 to 8}
C {1 to 9}

RA2P LINEIN

SVAC L1, C1

CWR8
CWR8-88

CLS {1 to 8}

43SCGE1 L1, C1

WR2-88 SIG, THRU, DROPOUT, ADDIN

WR8-88A
WR8-88AF

MESHOUT{1 to 3}, ADDIN{1 to 8}, SIG, 
THRU, DROPOUT

Cards Ports

FAN No ports

USRPNL OAMP, VOIP, E1, E2

EC CIT (Local Ethernet Port), AUX, ES1, 
ES2

PFDC50 50A No ports

PFDC60 60A No ports

Cards Ports

(2 of 2)
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Displaying PM data for an EC card
You can display PM data only for an EC card.

Procedure 8-17  To enable PM TCA alerts

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE

3 Right-click on NE and choose Properties from the menu.

4 The Network Element [Edit] form opens. Click on the NE Specifics tab. The 
General tab is displayed. 

5 From the Performance Management panel, select the Enable PM TCA Alerts check 
box to enable the 5620 SAM to raise all TCA alerts.

6 Click the OK button. A dialog box is displayed.

7 Click on the Yes button to accept the changes. 

8.16 Procedures to configure LAGs

Use the following procedures to manage LAGs using the navigation tree.

Procedure 8-18  To create a LAG on an 11DPE12A card

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE→Shelf→Card Slot→LAGs.

3 Right-click on the LAGs icon and choose Create LAG from the contextual menu. 
The Create LAG step form with the Define General Properties step appears. 

Note �  Card-level PM is not supported for other card types.

Note �  If the check box is disabled the 5620 SAM will not raise the TCA 
alerts.
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4 Configure the following parameters:

• LAG ID
• Auto Assign ID
• Description
• Administrative State
• MTU (bytes)

5 Click on the Next button. The Configure LAG Parameters step appears.

6 Configure the parameters:

• Size
• SVLAN Tag Protocol ID
• LOS Propagation
• LPT Consequent Action

7 Click on the Next button. The Configure LACP step appears.

8 Configure the parameters:

• Actor Administration Key
• Actor System Priority

9 Click on the Next button. The Configure LAG Members step appears.

10 Click on the Create button to add client ports to the LAG. The Create LAG Member 
step form with Only show compatible ports step appears.

11 Configure the parameters:

• Show only Compatible Ports
• Class

12 Click on the Next button. The Select Ports panel appears.

13 Select one or more compatible ports from the list and click on the Next button. 
The Specify the Member Properties step appears.

14 Configure the parameters:

• Priority
• Admin State

15 Click on the Finish button. A list of the selected ports appears in the Configure 
LAG members panel of the Create LAG step form.

The Specify Member Properties form closes and the Configure LAG Members form 
reappears. A dialog box appears.

16 Click on the OK button.

Note �  LACP is always enabled.
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17 Click on the Finish button. The Configure LAG Members form closes and the Create 
LAG form reappears.

18 Click on the Close button.

19 Choose Network→NE→Shelf→Card Slot→LAGs→LAG. Right-click on the created 
LAG and choose Properties from the contextual menu to view information about 
the created LAG or to modify LAG parameters.

• The General tab displays the LAG ID, description, and the configured MAC 
address.

• The Link Aggregation Group tab displays the parameters selected during LAG 
creation, including Number of selected ports, Number of attached ports, size, 
SVLAN Protocol ID, LOS propagation, LPT Consequent action and Bandwidth 
Attributes.

• The States tab displays the administrative state, which is the LAG enabled or 
disabled state on the node.

• The LACP tab displays the LACP parameters such as LACP mode, Actor 
Administration Key, Actor Operational Key, Partner Operational Key, Actor 
System ID, Partner System ID, Actor System Priority and Partner System 
Priority.

• The LAG Members tab allows you to add the LAG member ports.
• The VTS map tab displays the VTS map parameters such as VTS Map Number, 

VTS Direction, Classification Mode, CE-VLAN ID, and SVLAN ID.
• Statistics, terminations, and fault information is available from the 

appropriate tabs.

20 Expand the LAG object in the navigation tree to display the created LAG. 

21 Expand the LAG object to display LAG members.

Procedure 8-19  To create a LAG on an 11QPE24 card

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE→Shelf→Card Slot→LAGs.

3 Right-click on the LAGs icon and choose Create LAG from the contextual menu. 
The Create LAG step form with the Define General Properties step appears. 

4 Configure the following parameters:

5 Click on the Next button. The Configure LACP step appears.

• LAG ID
• Auto Assign ID
• Description
• Configured Address

• L2Uplink
• Mode
• Encap Type
• Administrative State
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6 Configure the parameters:

7 Click on the Next button. The Configure LAG Members step appears.

8 Click on the Create button to add client ports to the LAG. The Create LAG Member 
step form with the Only show compatible ports step appears.

9 Configure the parameters:

• Show only Compatible Ports
• Class

10 Click on the Next button. The Select Ports step appears.

11 Choose one or more compatible ports from the list and click on the Next button. 
The Specify the Member Properties step appears.

12 Configure the parameters:

• Priority
• Sub-Group ID

13 Click on the Finish button. A list of the selected ports appears in the Configure 
LAG members step of the Create LAG step form.

The Specify Member Properties form closes and the Configure LAG Members form 
reappears. A dialog box appears.

14 Click on the OK button.

15 Click on the Finish button. The Configure LAG Members form closes and the Create 
LAG form reappears.

16 Click on the Close button.

• LACP Transmit Interval
• LACP Transmit Standby
• Actor System ID
• Partner System ID

• Actor System Priority
• Partner System Priority
• Active Sub-Group selection Criteria
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17 Choose Network→NE→Shelf→Card Slot→LAGs→LAG. Right-click on the created 
LAG and choose Properties from the contextual menu to view information about 
the created LAG or to modify LAG parameters.

• The General tab displays the LAG ID, description, and the configured MAC 
address.

• The Link Aggregation Group tab displays the parameters selected during LAG 
creation, Number of selected ports, Number of attached ports, and size.

• The States tab displays the administrative state, which is the LAG enabled or 
disabled state on the node.

• The LACP tab displays the LACP parameters, such as LACP mode, Actor 
Administration Key, Actor Operational Key, Partner Operational Key, Actor 
System ID, Partner System ID, Actor System Priority and Partner System 
Priority.

• LAG Members tab allows you to add the LAG member ports.
• Statistics, terminations, and fault information is available from the 

appropriate tabs.

18 Expand the LAG object in the navigation tree to view the created LAG. 

19 Expand the LAG object to view LAG members.
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9 � 1830 PSS equipment navigation tree

9.1 Equipment navigation tree overview 9-2
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9.1 Equipment navigation tree overview

The view selector in the 5620 SAM navigation tree is a drop-down menu that lists 
the physical and logical network views that are available. You can use the contextual 
menu for an object in the navigation tree to create, configure, and manage specific 
parameters for the object and child objects. 

Using the 1830 PSS external element manager
You can start the 1830 PSS external element manager, Zero Install Craft (ZIC) 
interface, from the 5620 SAM GUI. The ZIC interface provides a web-based user 
interface (WebUI) to access the NE. The WebUI supports provisioning, 
administration, performance monitoring, and displaying alarms and conditions from 
the NE. For more information about using the WebUI with the 1830 PSS, see the 
Alcatel-Lucent 1830 Photonic Service Switch 36/32/16 (PSS-36/PSS-32/PSS-16) 
User Provisioning Guide. Procedure 9-1 describes how to start the 1830 PSS 
external element manager from the 5620 SAM GUI.

Procedure 9-1  To launch the 1830 PSS external EMS browser

1 Choose Equipment from the view selector in the navigation tree. The navigation 
tree displays the Equipment view.

2 Right-click on a discovered 1830 PSS device in the Equipment view and choose 
Launch External EMS Browser from the contextual menu. The ZIC main view screen 
appears.

Note 1 � The 1830 PSS external EMS browser is supported on Internet 
Explorer 6.0 or later or FireFox 3.6.

Note 2 � If the 1830 PSS device is in encrypted mode, you cannot 
launch a web session.

Note 3 � If the 1830 PSS device is in secure mode, the Launch External 
EMS Browser is disabled.
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10.1 Routing and forwarding overview

You can view, create, modify and delete the routing and forwarding parameters on 
the 1830 PSS device. You can use the Routing view in the 5620 SAM GUI 
navigation tree to manage these functions. See the chapter, “NE routing and 
forwarding” in the 5620 SAM User Guide for more information.

The following protocols are supported on the 1830 PSS devices:

• OSPFv2
• IGMP

OSPFv2
OSPFv2 is a hierarchical link-state interior gateway protocol that operates within 
ASs and is used in IP networks. OSPF packets are routed based on the destination IP 
address of the IP packets. The 1830 PSS devices, 1830 PSS-32 and 1830 PSS-16 
support multi-area OSPFv2 to improve DCN set-up and scalability. You can create, 
modify or delete a multi-area OSPFv2. The 1830 PSS devices will support creating 
and deleting system-level OSPF areas. See the section, “OSPF configuration 
procedures” in the 5620 SAM User Guide for information about how to configure 
OSPF.

IGMPv2
IGMP is a multicast protocol which service providers can use to establish multicast 
group memberships on a LAN. Within the LAN, end users use IGMP to 
communicate with a local multicast router, which then uses PIM to distribute the 
IGMP messages to other local and remote multicast routers. Multicast routers send 
regular membership queries to IGMP hosts which respond with membership reports. 
Multicast routers can use these reports to determine which hosts are interested in 
receiving particular multicast messages. IGMP operates above the network layer on 
IPv4 networks. See the section, “IGMP configuration procedures” in the 5620 SAM 
User Guide for more information about how to configure IGMP.

10.2 Workflow to configure protocols

Prerequisites:

• You know the 32-bit unique router ID prior to configuring OSPF.

Use the 5620 SAM navigation tree to create, modify and delete an OSPF.

1 To create an OSPF, see Procedure 10-1 for more information.

2 To modify an OSPF, see Procedure 10-2 for more information.

3 To delete an existing OSPF, see Procedure 10-3 for more information.
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10.3 Routing and forwarding procedures

The following procedures describe how to create, modify and delete a multi-area 
OSPF. See the 5620 SAM Optical Parameter Reference for more information on 
parameter descriptions.

Procedure 10-1  To create a Multi-area OSPFv2

1 In the 5620 SAM navigation tree, choose Routing from the view selector.

2 Choose Network→1830 PSS NE→Routing Instance→OSPFv2. 

3 Right-click on OSPFv2 and choose Create Area. The Area Site [Create] form opens. 
The NE has a default area.

4 Configure the parameters in the Routing Instance panel:

• Area ID
• Type 

• Normal 
Configure Virtual Link IP 

• NSSA
Configure NSSA Router Translation 
Configure ABR Default Route Cost 

• NSSA Totally Stub
Configure NSSA Router Translation 
Configure ABR Default Route Cost 

• Stub
Configure ABR Default Route Cost

• Totally Stub
Configure ABR Default Route Cost

• Area Index
• DNS Opaque LSAs Distributed
• Wavekey Opaque LSAs Distributed

5 Click on the Apply button. The area site is created.

Note �  Multi-area OSPF is supported only on nodes 1830 PSS-32, 
and 1830 PSS-16 from Release 3.6.5 or later. 

Note �  The DNS Opaque LSAs Distributed and Wavekey Opaque LSAs 
Distributed parameters can be enabled for only one of the OSPF areas 
on the 1830 PSS. By default, the backbone area ID (0.0.0.0) will have 
these options enabled and it cannot be enabled for the other types. This 
will result in an error message. If you set the parameter to No on the 
backbone area ID, you will be allowed to enable these parameters for 
other area IDs created. You can create up to three OSPF areas, in 
addition to the default backbone area (0-0-0-0).
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6 Click on the OK button. The Area Site [Create] form closes, and a dialog box 
appears.

7 Click on the Yes button to confirm the action.

Procedure 10-2  To modify a Multi-area OSPFv2

1 In the 5620 SAM navigation tree, choose Routing from the view selector.

2 Choose Network→1830 PSS NE→Routing Instance→OSPFv2. 

3 Select the area to be modified on the NE. Right-click on Area and select 
Properties, the Area Site [Edit] form opens.

4 Modify the parameters in the Routing Instance panel:

• Type
• DNS Opaque LSAs Distributed
• Wavekey Opaque LSAs Distributed

5 Click on the Apply button. The area site is modified.

6 Click on the OK button. The Area Site [Edit] form closes, and a dialog box appears.

7 Click on the Yes button to confirm the action.

Procedure 10-3  To delete a Multi-area OSPFv2

1 In the 5620 SAM navigation tree, choose Routing from the view selector.

2 Choose Network→1830 PSS NE→Routing Instance→OSPFv2→Area. 

3 Right-click on the selected area and choose Delete. A Confirm dialog box is 
displayed.

4 Click on the Yes button to confirm the action. The selected area is deleted.

Note �  If you modify the Type, update the appropriate options that 
are displayed based on the selected type. See Procedure 10-1 for more 
information.
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11.1 Service tunnel overview

A service tunnel is an entity used to unidirectionally direct traffic from one device to 
another device. The service tunnel is provisioned to use a specific encapsulation 
method, such as GRE or MPLS, and the services are then mapped to the service 
tunnel.

On the Optical Transport Service (Edit) form, the Service Tunnels tab lists all objects 
considered as service tunnels (SDPs, Ethernet rings, Ethernet tunnels, other services, 
and so forth) that are currently used by the service you are querying. The associated 
Discover Service Tunnels button removes any previously discovered service tunnels 
on the service and triggers a manual re-discovery of these, based on direct usage and 
current service configurations.

The Flow-through Services tab lists all other services that are currently using the 
object you are querying as a service tunnel. The associated Discover Flow-through 
Services button removes any previously discovered flow-through services and 
triggers a manual re-discovery of these, based on direct usage and current service 
configurations.

You can manage service tunnels on the 1830 PSS device. See the section, 
“Configuring service tunnel procedures” in the 5620 SAM User Guide for more 
information about how to configure and manage service tunnels.

11.2 Ethernet (G.8032) ring protection

The 5620 SAM supports Ethernet ring protection on the Ethernet Optical transport 
services on the 11QPE24 card for the 1830 PSS-32, 1830 PSS-16 and 1830 PSS-4 
devices. ERP is used for network protection of Ethernet services. See the section, 
“Ethernet (G.8032) rings” in the 5620 SAM User Guide for more information.

ERP
ERP switching offers ITU-T G.8032 specification compliance to achieve resiliency 
for carrier ethernet networks. Like STP networks, ERP keeps one link in the ring 
blocked to user traffic, but also like MSTP, it is possible to run multiple ring sessions 
on the same physical ring, with different blocked links in each. This enables load 
balancing on the ring when traffic patterns allow.

Stand-alone rings are supported, only on uplink (NNI) ports, but multiple 
non-interworking ring instances are supported.

VPLS services can use ERP (Epipes behaves as two-node ERPs). All VPLS services 
may be protected by one ethernet ring instance, or divided among several rings.

Note �  11QPE24 cards support ERP. ODU trails are added as 
tunnels for ERP. To create ODU trails between the cards, see 
Procedure 12-19. 
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ERP is represented on uplink (NNI) ports. ERP switching is triggered by NNI port 
failures, and optionally by Ethernet OAM CCM link faults detected by Down MEPs 
on the ring ports, for a ring topology in which links are not directly connected. 
Although ring switching can be held off to allow underlying protection to operate 
first, the advantage of ERP is its (~50 ms) protection switching. 

Ethernet rings use the G.8032 standard protocol for control, and participating nodes 
exchange protocol messages using Y.1731 defined OAM frames called R-APS. 
R-APS frames are sent by MEPs belonging to an MA not associated with a service, 
and positioned on ring paths. R-APS frames are tagged and should be configured 
with a unique (not shared with a service or other rings) VID when the ring port has 
dot1q encapsulation, and with a unique outer VID when the ring port has QinQ 
encapsulation. Ethernet rings are only on individual NNI ports which use QinQ 
encapsulation.

Service provisioning on Ethernet (G.8032) rings
The 5620 SAM accelerates the provisioning of VPLS instances on Ethernet (G.8032) 
rings by automatically creating the Control and Data services on the rings. Services 
are configured on Ethernet (G.8032) rings in the same method as service tunnels. 
You can create Ethernet (G.8032) rings using the 5620 SAM GUI. See the 
procedure, “To create an Ethernet (G.8032) ring” in the 5620 SAM User Guide for 
more information about how to create an Ethernet ring, its associate control service, 
data service, and assign ring elements to the ring.
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12.1 Optical transport services overview

An optical transport service is a wavelength that traverses the network between two 
endpoints, which can be tandem wavelengths in some cases. The path the service 
takes through the network is defined by 5620 SAM using shortest path algorithm and 
the knowledge of the NE adjacencies.

An XC is the path that the service takes through an NE. A cross-connect is defined 
by the ingress and egress points for the service on the NE.

The NE physical topology defines the internal path that the service takes through the 
NE.

The 5620 SAM supports the following:

• identification of adjoining XCs and management of linked XCs as an optical 
transport service

• creation, deletion, and discovery of optical transport services, where there are no 
XCs

• discovery of optical transport service between OTs of the vendor network

Each service is assigned a trail identifier and a pair of Wavelength Tracker wave 
keys. The trail identifier, the ITU channel number (wavelength) and wave key pair 
are unique in the network. See Tables 12-4, 12-5, and 12-6 for more information. 

Optical transport services create transport connectivity between router ports and 
hence they must be created before any IP services.

Services are created by selecting the endpoints, the 5620 SAM is then applied to 
complete the service creation.

The 5620 SAM supports optical transport services between:

• two 1830 PSS NEs
• two non-PSS NEs, that is, 7750 SR, 7450 ESS, 7705 SAR, 7210 SAS E,M,X,D, 

and 7950 XRS.
• an 1830 PSS NE and a non-1830 PSS NE, that is, 7750 SR, 7450 ESS, 

7705 SAR, 7210 SAS E, M, X, D, and 7950 XRS.

Protection schemes:

• provisioning of diverse route service
• provisioning and discovery of OPS and Y-cable, and Regen protected services 
• discovery of E-SNCP protected service, and Regen services
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For OPS service provisioning, you can only specify the following ports as 
termination points:

12.2 Y-cable protection

Y-cable protection is a network side protection mechanism that protects line card, 
client side laser, network side laser, and network side fibers. Y-cable protection is 
based on a pair of OT cards at the near-end and far-end of the network. Y-cable 
protection can be used with any supported type of OT, but the near-end working OT 
must be connected to the far-end working OT and the near-end protection OT must 
be connected to the far-end protection OT. The working and protection ports must be 
provisioned for the same signal rate and format and must be configured with the 
same threshold values, at both ends of the network. 

Y-cable support on working and protection OTs

43SCX4E card

The 43SCX4E is a double width variant, full height card that is supported on the 
1830 PSS-32 device. This card is similar in all its functionalities to the 43SCX4 card.

11QPEN4 card

Y-cable protection is supported on the 11QPEN4 OT card.  The working and 
protection OTs must be the same type at the near and far end. For example, there 
should be an 11QPEN4 card at each end, and near-end port C1 must be connected to 
the far-end port C1, port C2 to port C2. Unidirectional Y-cable is supported with 
CBR client mapping, but is not supported with GFP-F client mapping. On the 
11QPEN4 card, up to two protection groups can be created. A protection group 
consists of two line ports and one client port. Each protection group operates 
independently of the other, with its own protection state.

• 11STAR1 client port
• 11STAR1A client port
• 11STGE12 client port
• 11STMM10 client port
• 11QPA4 client port
• 11QPEN4 client port

• OPSA SIG
• 112SNX10 client port
• 112SNA1 client port
• 112SCA1 client port
• 112SCX10 client port

Note �  The E-SNCP and Y-cable should not coexist on the 
11QPEN4 card. For example, if there is at least one E-SNCP 
protection group created on a board, the Y-cable protection should not 
be on the board and vice versa.

Note 1 � The working and protection OTs must be the same type. 
The 5620 SAM does not allow service creation when card types are 
different.

Note 2 � The near-end and far-end OTs must be the same type. The 
5620 SAM allows service creation when card types are different.
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The 11QPEN4 and the 11QPA4 cards, are channels in the Y-cable protection group 
and are independent channels on working and protection boards. The channel 
numbering at one end may not be the same as the channel numbering at the other end. 
For example, channel C1 and L1 in the near-end working and protection pairs can 
connect to channel L2 and C2 at the far-end working. The protection pairs form an 
end-to-end protected service.

A 11QPEN4 OTU2 client port (OT A) can be connected to 11DPE12 and 11DPE12E 
line ports (OT B). Up to four 11DPE12 and 11DPE12E OTs can be connected to one 
11QPEN4. This configuration is encrypted for GbE services.

A 11QPEN4 OTU2 client port (OT A) can be connected to a 11DPM12 line port (OT 
B). Up to four 11DPM12 OTs can be connected to one 11QPEN4. This configuration 
is encrypted for GbE, FC100, FC200 and FC400 services.

12.3 Dual stage multiplexing

Dual stage multiplexing is supported on the 1830 PSS-16 and 1830 PSS-32 shelves. 
A signal is added to an OT client port and multiplexed on a line port with a larger 
bandwidth. The signal is added a second time at a higher rate OT and multiplexed to 
the line port. The reverse path is followed if the signal is dropped. See 
Procedure 12-5 and the Alcatel-Lucent 1830 Photonic Service Switch User 
Provisioning Guide for more information.

12.4 Regeneration services on the 1830 PSS

The 1830 PSS supports provisioning, discovery and a topological view of the 
following regeneration services. To provision these services, see Procedure 12-1. To 
discover these services, see Procedure 12-11. To view these services in the 
topological view, see the 5620 SAM User Guide.

• DWDM–DWDM
• DWDM–CWDM
• CWDM–Black & White
• DWDM–Black & White

Note 1 � The operational mode on the 11QPEN4 line port is 
Add/Drop only.

Note 2 � The client ports on the 11QPEN4 cannot be assigned to the 
OC192/STM64 rate.

Note �  The Regen check box is automatically checked when a regen 
service is created. You can view this on the General tab on the Service 
Path form.
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DWDM�DWDM
DWDM–DWDM single channel OEO regeneration is supported with back-to-back 
OTs connected through the client ports. Keyed and unkeyed services are supported 
on this configuration. The following OTs are supported:

• 11STAR1
• 11STAR1A
• 43STA1P
• 43STX4
• 43STX4P

DWDM–DWDM single channel OEO regeneration is supported with two single port 
OTs that have line port operational modes configured for regeneration. Client ports 
are not used in this configuration. The following OTs are supported:

DWDM�CWDM
The 1830 PSS-32 supports single channel regeneration for CWDM and DWDM 
connections and configurations for CWDM bidirectional transmission with 
DWDM-CWDM (dual-fiber) regeneration, where regeneration OTs are supported. 
The Rate supported for this service is FC200. Keyed and unkeyed services are 
supported on this configuration. The following OTs are supported:

• 11STAR1 and 11STAR1A OT—line port is connected to the DWDM signal and 
the client port is connected to the CWDM signal

• 4DPA4 OT (FlexMux only)—one line and an eVOA port is connected to the 
DWDM signal and the other line and eVOA port is connected to the CWDM 
signal. The line ports are configured for CrossRegen mode

Note �  For regeneration on the 43STA1P, the client port rate must 
be OC768 or STM256. Do not use OTU3.

• 112SA1L (drop shelf only)
• 112SCA1
• 112SNA1
• 112SCX10
• 112SNX10
• 43SCGE1

• 112SX10L (drop shelf only)
• 43SCA1
• 43SCX4
• 43SCX4E
• 43SCX4L (drop shelf only)

Note �  For this configuration, the channels can be different on each 
SFD or CWR port.
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• 11QPA4 OT—a line and an eVOA port is connected to the DWDM signal and 
the associated client port is connected to the CWDM signal

CWDM�Black & White
CWDM-Black & White single channel OEO regeneration is supported during the 
working of the 1830 PSS-32 and 1830 PSS-1 GBEH devices. The rate supported for 
this service is 1Gbe. Unkeyed service is supported on this configuration and no cross 
connects are created. The following OTs are supported:

• 4DPA4 OT (FlexMux only)—one line and an eVOA port is connected to the 
CWDM signal and the other line port is connected to the Black &White signal. 
The line ports are configured for CrossRegen mode

• 11QPA4 OT—a line port is connected to the CWDM signal and the associated 
client port is connected to the Black & White signal

CWDM�FOADM
Degree-2 CWDM-FOADM is supported on the 1830 PSS. Any symmetrical 
combination of OMD-based end terminal configuration is supported. 

The following configurations are supported:

• SFC-2—SFC-2
• SFC-4—SFC-4
• SFC-8—SFC-8

The following OTs are supported:

• 4DPA4
• 11DPE12

DWDM�Black & White
DWDM-Black &White single channel OEO regeneration is supported during the 
working of the 1830 PSS-32, and 1830 PSS-1 GBEH devices. The Rate supported 
for this service is 1Gbe. The following OTs are supported:

• 11STAR1 and 11STAR1A OT—the line port is connected to the DWDM signal 
and the client port is connected to the Black &White signal. Regeneration takes 
place from client to line.

• 4DPA4 OT (FlexMux only)—one line and an eVOA port is connected to the 
DWDM signal and the other line port is connected to the Black and White signal. 
The line ports are configured for CrossRegen mode

Note �  11QPEN4 supports regeneration services with the 11QPA4 
as the A end and Z end of the service.

Note �  11QPEN4 supports regeneration services with the 11QPA4 
as the A end and Z end of the service.
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• 11QPA4 OT—a line and an eVOA port is connected to the DWDM signal and 
the associated client port is connected to the Black &White signal

12.5 Ethernet service management

VPLS management on the 1830 PSS
VPLS is a class of virtual private network multipoint L2 service that allows multiple 
customer sites to be connected in a single bridged domain contained within the 
service provider-managed IP/MPLS network. Customer sites in the VPLS appear to 
be on the same LAN, even if the sites are geographically dispersed. You can create, 
and delete a VPLS service on the 11QPE24 card. You can also modify a service from 
the topology view. See the 5620 SAM User Guide and the 5620 SAM Parameter 
Guide for more information.

Mirroring
In a mirror service, packets from one or more sources are forwarded to their 
configured destinations. A copy of the entire packet, or a specified portion of the 
packet, is sent to the mirror destination. The mirrored packet can be viewed using a 
packet-decoding device, typically called a sniffer, that is attached to the destination 
port. The 5620 SAM does not limit the number of destination and source sites that 
can be added under a mirror service. The mirrored packets are transported 
unidirectionally through the core network using IP or MPLS tunneling. For more 
information about mirror services, see 5620 SAM User Guide.

Note �  11QPEN4 supports regeneration services with the 11QPA4 
as the A end and Z end of the service.

Note 1 � On the 11QPE24 card, VPLS services are configured at the 
card level and not at the NE level.

Note 2 � A VLAN ID is only applicable when the SAP type is equal 
to dot1q-preserve.

Note 3 � A VPLS service cannot be deleted if there are SAPs defined 
for the service.

Note 4 � A VPLS must have the Admin State set to Down to be 
deleted from the service.
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12.6 Workflow to configure optical transport services

This workflow is used to configure optical transport services:

1 The EPT, and CPB tools are non-5620 SAM tools which must be first used for 
transport network power balancing and commissioning tasks. See the 
Alcatel-Lucent 1830 Photonic Service Switch (PSS) Engineering and Planning Tool 
User Guide and the Alcatel-Lucent 1830 Photonic Service Switch (PSS) 
Commissioning and Power Balancing Tool User Guide for more information.

2 Use the 5620 SAM GUI to:

• Create optical links that represent the external 1830 PSS/ 7750 SR adjacencies 
and the internal topological links within the 1830 PSS NEs. See Procedure 8-8 
for more information.

• Create an optical transport service. See Procedure 12-1.
• Discover the optical transport services. See Procedure 12-11.
• Unmanage an optical transport service. See Procedure 12-12. 
• Create a multipoint transport service. See Procedure 12-2.
• Create and delete a drop site on an unprotected multipoint service in a 

11DPM12 card. See Procedures 12-3 and 12-4.
• Create dual stage multiplexing service on the 1830 PSS for keyed and unkeyed 

services. See Procedure 12-5.
• Create single fiber bidirectional support on the 1830 PSS for unkeyed services. 

See Procedure 12-6.
• Create, configure and delete ODU trails. See Procedures 12-19, 12-20 

and 12-21.
• View the optical channel usage. See Procedure 12-22.
• Create and delete ODUk XCs on 11DPM12 cards. See Procedures 12-23 

and 12-24.

12.7 Procedures to configure optical transport services

Procedure 12-1  To create an optical transport service using 
configuration forms

1 Choose Create→Service→Optical→Create Transport Service from the 5620 SAM 
main menu. The Optical Transport Service Subscriber [Create] form opens.

2 Click on the Select button to choose a customer to associate with the optical 
transport service. The Select Customer - Optical Transport Service form opens.
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3 Choose a customer for the optical transport service and click on the OK button. 
The Select Customer - Optical Transport Service form closes and the Optical 
Transport Service [Create] form reappears with the customer information 
displayed on the General tab.

4 Configure the parameters:

• Service Name
• Description
• Service ID
• Auto-Assign ID
• Direction

• Bidirectional�creates bidirectional cross-connects and displays hops from A 
to Z and Z to A after service creation

• Unidirectional�creates unidirectional cross-connects and displays hops from 
A to Z after service creation

• Service Priority
• Wavekey Assign Mode

• Auto Keying (NE)
• Auto Keying (NMS)
• Unkeyed

• States
• Administrative State
• Operational State

5 Configure the Rate parameter, or a SubRate service or a QinQ service, by setting 
the Rate parameter to SubGigE and configure the parameters on the VLAN 
Configuration Details panel, if required. See table 12-1 for more details.

Table 12-1 Rate parameter value

Note �  You can create a template for the service at every stage by 
using the Apply or OK button before you specify the optical sites and 
termination points. You can use the service template to create a service 
by adding optical sites and termination points. See steps 12 to 18 to 
create an optical site.

Rate Service

SubGigE SubRate:
• CE-VLANID
• Committed Info Rate (Mbps)
• Excess Info Rate (Mbps)
• Committed Burst Size (Kbytes)
• Excess Burst Size (Kbytes)

(1 of 2)
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Notes
(1) For line SVID configuration with a QinQ Service Stack-VLAN Tagging Configuration of Push-Pop, the 

value of A-Ingress-Z-Egress CE-VLANID and Z-Ingress-A-Egress CE-VLANID must be the same.
(2) For line SVID configuration, the value of A-Egress-Z-Ingress Stack-VLANID and A-Ingress-Z-Egress 

Stack-VLANID must be the same.

See the 5620 SAM Optical Parameter Reference guide for specific rates applicable 
for various cards.

6 Configure the Protection Type parameter. See Table 12-2 for more information:

• Unprotected
• Diverse Route
• ESNCP Protected
• OPS Protected
• Y-Cable Protected

SubGigE QinQ�Perform steps 15-24.
• Is SubGigeService QinQ
• Is SVLAN Push-Pop/Keep Capable QinQ Service
• QinQ Service Stack-VLAN Tagging 

Configuration
• Push-Pop
• Keep

• A-Ingress-Z-Egress CE-VLANID (1)

• Z-Ingress-A-Egress CE-VLANID (1)

• A-Egress-Z-Ingress Stack-VLANID (2)

• A-Ingress-Z-Egress Stack-VLANID (2)

• Committed Info Rate (Mbps)
• Excess Info Rate (Mbps)
• Committed Burst Size (Kbytes)
• Excess Burst Size (Kbytes)

SubGigE Full Rate:
• Is SubGigeService QinQ
• Is SubGige Full Rate Service
• A-Egress-Z-Ingress Stack-VLANID 
• A-Ingress-Z-Egress Stack-VLANID 

Rate Service

(2 of 2)
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Table 12-2 Protection Type parameter options

Notes
(1) You can also create a diverse route service by choosing two termination points on the A end site, 

and two termination points on the Z end site.
(2) Diverse route services can only be created by using the 5620 SAM and the services are not part of 

the service discovery operation.
(3) If you unmanage a diverse route and run the discover transport services operation, the 5620 SAM 

discovers two unprotected services instead of a diverse route service.

7 Click on the Path Constraints tab and choose Create. The Constraint [Create] form 
opens. 

Option Description

Diverse Route Diverse Route Details panel: (1) (2) (3)

• Select the Use Existing Unprotected Services check box and 
choose up to two existing unprotected services. 

• Choose a Service Name for the Working Path Service
• Choose a Service Name for the Protection Path Service

A Diverse Route service is created and the existing unprotected 
services are deleted.

ESNCP Protected ESNCP service supports the following cards and configurations:

• 4DPA2
• 4DPA4
• 11QPA4
• 11QPEN4
• 11DPM12
• 11DPE12

• 11DPE12A
• 11DPE12E
• 1830 PSS-1 GBE
• 1830 PSS-1 MD4H

OPS Protected OPS service supports the following cards:

• 11STAR1
• 11STAR1A 
• 11STGE12 
• 11STMM10
• 11QPA4
• 11QPEN4

• OPSA
• 112SNX10 
• 112SNA1 
• 112SCA1 
• 112SCX10

Y-Cable Protected Configure the parameters in the APS Group panel:
• Revert Mode
• APS Direction
• Wait to Restore (minutes)
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8 Configure the parameters:

• Constraint Type
• Inclusion
• Exclusion

• Constraint Element
• Port
• Site 
• Trail

• Service Path Type

9 Click on the Select button. When you specify Port, Site or Trail as the Inclusion or 
Exclusion element, the Select Port Constraint form opens.

10 Choose the Ports, Sites or Trails to be included or excluded.

11 Click on the OK button. The Port Constraint or Site Constraint form closes.

12 Click on the Service Sites tab and choose Create Optical Site. The Select Network 
Elements - Optical Transport Service form opens with a list of available sites. 

13 Choose a site. Press the CTRL key, and choose another site. Click on the OK 
button. 

14 Right-click on the selected site and click on Properties, the Optical Site [Create] 
form opens with the General tab displayed.

15 Click on the Termination Point tab to configure the termination point for the NE. 

16 Click on Create on the right panel. The Termination Point [Create] form opens.

17 Click on Select. The Select Port - Termination Point form opens. 

Note 1 � You can include or exclude ODU trails in a service. See steps 
7-11.

Note 2 � The selected constraint is applicable to unprotected, working 
or protection service paths. 
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18 Choose a port and click on the OK button. The Select Port - Termination Point form 
closes and the Termination Point [Create] form reappears.

Prerequisites to configure an OPTSG client. To configure the OPTSG client, see 
option a. See Procedure 12-10 for more information about configuring timeslots.

• Provision timeslots on line ports, to create a line port ODUk facility object.
• Associate ODU1PTF object with the line port ODUk facility object to create the 

cross connect. The ODU1PTF can be associated only with the Odu1 container 
(with 2 timeslots) on a line port.

• Provision timeslots on ODU1PTF to create OPTSG objects.
• Provision the service with OPTSG clients.

Note 1 � In this form, only the termination points that can be 
configured with the specified service rates are displayed.

Note 2 � If a termination point is used in another service, the 
termination point is not displayed (except for SubGigE services).

Note 3 � If a termination point is configured with another valid rate, 
the termination point is not displayed.

Note 4 � Steps 19a, 20a to 23 apply to QinQ service only.

Note 5 � Steps 19b, 20b apply to CWDM, DWDM and Black & White 
services.

Note 1 � Repeat points 1 to 3 of the prerequisites on the source and 
destination ports.

Note 2 � Automatic provisioning of timeslots on the line ports to 
create a line port ODUk facility object is supported on the 11DPM12 
cards.

Note 3 � This is applicable to Keyed and Unkeyed services.

Note 4 � Line port ODUk Facility objects are created when timeslots 
are configured on line ports. See Procedure 12-10 for more information 
about configuring timeslots manually. When the service is provisioned, 
the ODUk cross connects are created between client and line Port ODUk 
facility objects.
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a If the selected client port is configured in OPTSG mode, the Optsg 
Termination Point panel opens. Click on Select. The Select Optsg - 
Termination Point form opens. Choose the appropriate OPTSG object and 
click on the OK button. The Select Optsg - Termination Point form closes and 
returns to the Termination Point [Create] form.

19 Configure the parameters: 

a In the Client Port Virtual Time Slot (PSS Endpoint) panel:

• Client Port
• Ingress VTS Number
• Egress VTS Number

b In the Optical Access Port Virtual Time Slot panel:

• Client VTS Number
• Ingress VTS Number
• Egress VTS Number

If the Flow Continuity Monitoring value for the OT Card is CCM, then the 
value of the Ingress VTS Number and Egress VTS Number parameters must 
be the same. See Alcatel-Lucent 1830 Photonic Service Switch User 
Provisioning Guide for more information.

Note 1 � This termination point panel also appears if the selected 
client port is an SR end point and if it is connected to a 11DPM12 client 
port configured in OPTSG mode.

Note 2 � Option a applies only to 11DPM12 cards and to client ports 
configured in the OPTSG mode. The OPTSG mode is supported only for 
OC3/STM1 and OC12/STM4 client rates.

Note 3 � This is applicable for Keyed services.
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20 Configure the parameters: 

a In the Line Port Virtual Time Slot (PSS Endpoint) panel:

• Line Port
• Line Port Number
• Line VTS Number
• Ingress VTS Number
• Egress VTS Number

If the Flow Continuity Monitoring value for the OT Card is CCM, then the 
value of the Ingress VTS Number and Egress VTS Number parameters must 
be the same. See the Alcatel-Lucent 1830 Photonic Service Switch User 
Provisioning Guide for more information.

b In the Optical Working Network Port Virtual Time Slot panel:

• Line Port
• Line VTS Number
• Ingress VTS Number
• Egress VTS Number

If the Flow Continuity Monitoring value for the OT Card is CCM, then the 
value of the Ingress VTS Number and Egress VTS Number parameters must 
be the same. See the Alcatel-Lucent 1830 Photonic Service Switch User 
Provisioning Guide for more information.

21 For line SVID configuration, configure the Line Port parameter in the Optical 
Protection Network Port Virtual Time Slot panel.

22 After you configure the termination point for the NE, click on Optical Transport 
Service in the navigation tree. The General tab is displayed.

23 Configure the parameters in the VLAN Configuration Details panel:

• A-Ingress-Z-Egress CE-VLANID
• Z-Ingress-A-Egress CE-VLANID
• A-Egress-Z-Ingress Stack-VLANID
• A-Ingress-Z-Egress Stack-VLANID

Note �  For a Protected Service, the Protection Port VTS Parameters 
should be same as Line Port VTS Parameters.

Note �  The A-Ingress-Z-Egress CE-VLANID and Z-Ingress-A-Egress 
CE-VLANID are not valid for a SubGige Full Rate Service.
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24 Click on the OK button to save the configuration.

See section 8.8 for more information about configuring the Card Rate Mode.

25 Repeat steps 15 to 24 for the other specified sites.

Procedure 12-2  To create a multipoint transport service

Multipoint transport service is a drop and continue service which is primarily used to 
transmit video signals to multiple destinations. The client signals to be transmitted are 
added at the add Site. Some signals are dropped at the intermediate drop and continue 
sites. The remaining signals are dropped at the drop site.

1 Choose Create→Service→Optical→Create Multipoint Transport Service from the 
5620 SAM main menu. The Multipoint Transport Service [Create] form opens.

2 Click on the Select button to choose a customer to associate with the multipoint 
transport service. The Select Customer - Multipoint Transport Service form opens.

3 Choose a customer for the multipoint transport service and click on the OK button. 
The Select Customer - Optical Transport Service form closes and the Multipoint 
Transport Service [Create] form reappears. The customer information appears in 
the Customer panel of the General tab.

Note 1 � Only 11DPE12 cards support the following Card Rate Mode:

• FullRate
• SubRate
• QinQ

Note 2 � 11DPE12E and 11DPE12A cards support QinQ.

Note 3 � QinQ properties are displayed only after the termination 
points are created on the following cards.

• 11DPE12
• 11DPE12A
• 11DPE12E

Note �  Up to two sites can be specified to create an optical transport 
service. These are respectively named an A end site and a Z end site by 
the 5620 SAM.

Note �  You can create a template for the service at operational state 
by using the Apply or OK button before you specify the optical sites and 
termination points. You can use the service template to create a service 
by adding optical sites and termination points. See the 5620 SAM Scripts 
and Templates Developer Guide for the procedure to create a service 
from a template.
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4 Configure the parameters:

• Service ID
• Auto-Assign ID
• Service Name
• Description
• Rate

Only the following rates are supported on 11DPM12 cards:
• unspecified
• 1GbE
• HDSDI
• SDSDI

• Service Priority
• Protection Type

• Unprotected
• ESNCP Protected

• Wavekey Assign Mode
• Auto Keying (NE)
• Auto Keying (NMS)
• Unkeyed

• States
• Administrative State
• Operational State

5 Right-click on the Sites menu option in the Navigation tree and choose Create Add 
Site. The Select Network Elements - Multipoint Transport Service form opens with 
a list of available sites.

6 Choose a site. Click on the OK button.

7 Click on the site on the navigation tree. The Optical Site [Create] form opens and 
the General tab appears.

8 Click on the Termination Point tab to configure the termination point for the site. 

9 Click on the Create button. The Termination Point [Create] form opens.

10 Click on the Select button. The Select Port - Termination Point form opens. 

11 Choose a port and click on the OK button. The Select Port - Termination Point form 
closes and the Termination Point [Create] form reappears.

12 Click on Multipoint Transport Service in the navigation tree. 

Note 1 � The form displays only the termination points that can be 
configured with the specified service rates.

Note 2 � The termination point does not appear in the Navigation tree 
when a termination point is:

• used in another service
• configured with another rate
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13 Repeat steps 5 to 11 to add drop and continue sites and drop sites. For ESNCP 
service, add two drop sites. Click on the drop site and perform one of the following 
to set the type of path to working or protection path:

a Choose Working from the Path Type drop-down menu on the General tab of 
the Optical Site [Create] form.

b Choose Protection from the Path Type drop-down menu on the General tab 
of the Optical Site [Create] form.

14 To create path constraints, right-click on the drop site and choose Properties. The 
Optical Site [Create] form opens and the General tab appears.

15 Click on the Path Constraints tab. Optical Path Constraint [Create] form appears.

16 Click on the Select button. The Select Site - Optical Path Constraint form appears.

17 Choose the drop and continue sites as path constraints.

18 Click on the OK button. The select Site - Optical Path Constraint form closes.

19 Click on the OK button. The Optical Path Constraint [Create] form closes.

Procedure 12-3  To add a drop site on an unprotected multipoint 
service in a 11DPM12 card

1 On the navigation tree, right-click on the drop site and choose Extend Drop Site. 
The Select Network Elements form opens.

2 Choose the site to add as drop site and click on the OK button. The dialog box 
opens displaying the IP address of the new drop site.

3 Click on the OK button. The dialog box closes and Multipoint Transport Service 
[Edit] form reappears. The new drop site is added on the navigation tree.

4 Right-click on the Termination point of the new site and choose Create 
Termination Point. The Termination Point [Create] form opens.

5 Repeat steps 10 and 11 of Procedure 12-2 to add the termination point. Click on 
the Apply button on the Multipoint Transport Service [Edit] form. The previous 
drop site becomes a drop and continue site, and the path constraints are updated 
automatically.

Note 1 � If the termination points are not added for any of the drop 
and continue sites during service creation, repeat steps 7 to 11 to add 
the termination points after the service is created. The path constraints 
are updated automatically.

Note 2 � If you need to delete any of the termination points in a drop 
and continue site, right-click on the termination point and choose 
Delete. The path constraints are updated automatically.
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Procedure 12-4  To delete a drop site on an unprotected multipoint 
service in a 11DPM12 card

1 On the navigation tree, right-click on the drop site and choose Delete. The drop 
site is removed from the navigation tree. 

2 Click on the Apply button of the Multipoint Transport Service [Create] form. The 
dialog box opens

3 Click on the Yes button. The drop and continue site that is linked to the deleted 
drop site becomes the new drop site. The path constraints are updated 
automatically.

Procedure 12-5  To create dual stage multiplexing services on the 
1830 PSS for keyed and unkeyed services

This procedure describes the dual stage multiplexing service support on the 1830 PSS 
16/32 shelves for the following cards:

• 11STMM10 OTU1 client port (OT A) connected to a 4DPA4 line port (OT B). Up 
to four 4DPA4 OTs can be connected to one 11STMM10.

• 112SCX10 OTU2 client port (OT A) connected to a 11DPM12 line port (OT B). Up 
to ten 11DPM12 OTs can be connected to one 112SCX10.

• 112SNX10 OTU2 client port (OT A) connected to a 11DPM12 line port (OT B). 
Up to ten 11DPM12 OTs can be connected to one 112SNX10.

• 11DPM12 OTU1 client port (OT A) connected to a 4DPA4 line port (OT B). Up to 
four 4DPA4 OTs can be connected to one 11DPM12.

• 43SCX4 and 43SCX4E OTU2 client port (OT A) connected to a 11DPM12 line port 
(OT B). Up to four 11DPM12 OTs can be connected to one 43SCX4 or 43SCX4E.

• 43STX4P OTU2 client port (OT A) connected to a 11DPM12 line port (OT B). Up 
to four 11DPM12 OTs can be connected to one 43STX4P.

Prerequisites:

• An internal topological link is provisioned between the OT A client port and the 
OT B line port.

• The cross-connect terminates on the OT A line port. The OT B is not included 
in the cross-connect.

• Because there is no wave key encoding on OT B, the eVOA port is not used.
• There is no alarm correlation between OT A and OT B.

See Procedure 12-1 to create an optical service.

Note 1 � Dual Trans mode and Flex Mux mode are supported on the 
4DPA4 card.

Note 2 � Keyed and Unkeyed services are supported in the Wavekey 
Assign Mode.
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Figure 12-1 shows the dual stage multiplexing.

Figure 12-1  Dual stage multiplexing

Procedure 12-6  To create single fiber bidirectional support on the 
1830 PSS-4/16/32 for unkeyed services

This procedure describes the CWDM single fiber bidirectional service support for the 
following fiber and OT cards:

Prerequisites:

• The SFC should be connected in a OneFiber MuX mode. The default is 
TwoFiberMux. You must set the mode before you create an optical link. The 
mode can be configured on the Card Specifics tab of the Card [Edit] form. See 
Procedure 8-4 for more information.

• You can only create unidirectional internal optical links between the OT and 
filter channels.

• External optical links are always bidirectional. After the service is created, you 
can view the channel, frequency used, and direction in the topology view. 

See Procedure 12-1 to create an optical service.

• SFC-2
• SFC-4
• SFC-8
• 4DPA4

• 11STAR1
• 11STAR1A
• 11STMM10
• 11DPE12(E)

CWR or SFD

OT A

OT B

Line

Line

Client

Client

22756
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Administrative State
The transport service administrative state represents the aggregate value of the 
following:

• administrative states of the OCH cross connects in the service
• administrative state of the ports in service

If one of the administrative state values is not Up, the administrative state is set to 
Down. If all of the administrative state values are Up, the service administrative state 
is set to Up.

For unprotected services, you cannot change the administrative state of the service if 
there is a missing OCH cross connect for the service.

For protected services, you cannot change the administrative state of the service if 
there is a missing OCH cross connect on the working path and on the protecting path.

If the ODU trail is set to Admin Down or Admin Up, this sets the Admin down or 
Admin up on the OCH trails and the OCH cross connects.

Operational State
Transport service operational state and state causes are assigned separately for 
working paths and for protection paths. The operational state for a path represents the 
aggregate operational state of the OCH cross connects on the path and of the ports 
on that path. If any of the ports or the OCH cross connect is not Up on a path, the 
operational state for the path is Down. 

The operational state of a path can be down due to the following state causes:

• Cross Connect Down—at least one of the cross connections on the path has an 
operational state set to Down

• Missing Cross Connect—there is a missing cross connect on the path
• Wavekey Mode Mismatch—there is a wavekey mismatch on the path
• Port (that is not part of CrossConnect) Down—a port that is not part of the cross 

connect is operationally down
• VTS Connection is Down
• Missing VTS Connection
• Missing ODUk Connection

The Complete Service button re-creates the cross connections and APS groups if 
there are missing entities and completes the creation of the service.

Note 1 � For OSPF configuration, see the Protocol Configuration 
chapter in the 5620 SAM User Guide.

Note 2 � After an optical transport service is created, you can view 
the hops (ports) and OCH cross connects on the service path under 
working path, and protection path tabs.

Note 3 � You can view the Operational state causes on the General 
tab in the Protection or Working paths in the Services Path.
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Procedure 12-7  To create an APS group

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE.

3 Right-click on the NE and choose Properties from the contextual menu. The 
Network Element [Edit] form opens with the General tab displayed.

4 Click on the APS Groups tab.

5 Click on the Create button. The APS Group [Create] form opens. Configure the 
parameters:

• Description
• Protection Mode

• ESNCP
• OPS
• Optical Splitter

• Card Sub Type

• Direction
• Type
• Wait To Restore (minutes)

a When you set the Protection Mode parameter to ESNCP, configure the 
parameters based on the card sub type selected:

Note �  Configure the parameters based on the card sub type. This is 
applicable only to ESNCP and Optical Splitter. See the 5620 SAM Optical 
Parameter Reference for more information.

• Card Sub Type
• Connection Direction

- Bidirectional
- Unidirectional

• ODUk Protected Interface 
Type:
- Client Port
- ODU1PTF

• ODU1 PTF
• Client Port
• Working LO-ODUk facility

• Protection LO-ODUk facility
• Client Channel
• Working Port
• Working VTS (if the 11DPE12-11G 

Dual Port Pluggable GBE Mux card is 
selected)

• Protection Port
• Protection VTS (if the 11DPE12-11G 

Dual Port Pluggable GBE Mux card is 
selected)

Note 1 � Connection Direction and ODUk parameters are applicable 
only to 11DPM12 cards.

Note 2 � ODU1 PTF is applicable only if the ODUk Protected Interface 
Type is set to ODU1PTF)
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b When you set the Protection Mode parameter to OPS, configure the 
parameters:

• Working Port
• Protection Port

c When you set the Protection Mode parameter to Optical Splitter, configure 
the parameters:

• Card Sub Type
• Direction
• Working Port
• Protection Port

6 Click on the OK button. The APS Group [Create] form closes.

7 Click on the Close Window button. The Network Element [Edit] form closes.

Procedure 12-8  To change the protection switch for an APS group 
member

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Choose Network→NE.

3 Right-click on the NE and choose Properties from the contextual menu. The 
Network Element [Edit] form opens with the General tab displayed.

4 Click on the APS Groups tab.

5 The APS Group [Edit] form opens.

6 Choose an APS Group on the working or the protected paths and click on the 
Properties button.

7 Click on the APS Group Members tab.

8 Choose an APS Group that has been created on the Working or the Protected paths 
and the members that are attached to these paths, and click on the Properties 
button. 

9 The APS Group Member [Edit] form opens with the General tab displayed.
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10 Change the Protection Switch based on whether you specify a working or 
protected path.

• Protection Switch
• Clear
• Forced Switch to Protection
• Forced Switch to Working
• Manual Switch to Protection
• Manual Switch to Working
• No Cmd
• Protection Lockout

11 Click on the OK button. The APS Group [Create] form closes.

12 Click on the Close Window button. The Network Element [Edit] form closes.

Procedure 12-9  To configure a port-timeslot assignment on 
channelized cards

1 Right-click on a channelized port and choose Properties.The Physical Port [Edit] 
form opens with the General tab displayed.

2 Click on the Port Specifics tab.

3 Configure the Assigned Rate parameter. See the 5620 SAM Optical Parameter 
Reference.

4 Click on the Configure Timeslots button. The Timeslot Assignments form opens.

5 Choose the required timeslot configuration. Click on the OK button. The Timeslot 
Assignments form closes.

6 Click on the OK button. The Physical Port [Edit] form closes. 

Procedure 12-10  To manually configure an ODU timeslot assignment 
for 11DPM12 cards

The 11DPM12 card supports 12 client ports, three ports form a port group. Each port 
group has 5Gb/s capacity. If the capacity is reached, the 5620 SAM displays a 
deployment error (1xODU0+1xODU1+1xODU0= 5Gb/s).

Note �  You can view the active path from A to Z and Z to A directions 
on the General tab of the Optical Transport Service [Edit] form.
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Prerequisites:

• ODU1PTF and port group association, with OPTSF mapping container for 
STM-1/OC-3 and STM-4/OC-12 clients:

• ODU1PTF-1 and ODU1PTF-2 are used with port group 1 (C1, C2, and C3)
• ODU1PTF-2 and ODU1PTF-3 are used with port group 2 (C4, C5, and C6)
• ODU1PTF-3 and ODU1PTF-4 are used with port group 3 (C7, C8, and C9)
• ODU1PTF-7 and ODU1PTF-8 are used with port group 4 (C10, C11, and 

C12)
• A port group should not be configured as an OPTSG and LO-ODUk mapping. 

1 Choose Network→NE→Shelf→Card→Port to navigate to a client port.

2 Right-click on the port and choose Properties.The Physical Port [Edit] form opens 
with the General tab displayed.

3 Click on the Port Specifics tab. 

4 Configure the Assigned Rate parameter. See the 5620 SAM Optical Parameter 
Reference.

5 Click on the Configure Timeslots button. The Timeslot Assignments form opens.

6 Specify the required timeslot configuration. Table 12-3 lists the timeslot mapping. 

Note �  Alcatel-Lucent recommends that the OPTSG and LO-ODUk 
mapping within a port group is not configured. If you need to 
configure mixed OPTSG and LO-ODUk mapping within a port 
group, provision the ODU1PTF XC and OPTSG mapping and then 
provision the LO-ODUK mapping. For example, if C1 and C2 
ports are provisioned within an ODU1PTF, and C3 in an ODU1 
container, you must first provision the associated ODU1PTF XC. 
Next provision the client C1/C2 OPTSG XC. The final step is to 
provision C3 with LO-ODUk mapping. The system software can 
then calculate and allocate resources efficiently.

Note 1 � You do not need to assign a container for client ports. The 
container is automatically assigned after you configure the Assigned 
Rate parameter. By default the OPTSG container is listed for OC3 and 
OC12 clients. You can also configure the ODU0 container from the 
drop-down based on the requirement. 

Note 2 � You cannot configure timeslots on client ports.

Note 3 � You can configure timeslots on line ports. The default is 
OTU2.
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Table 12-3 12xANY timeslot mapping

7 Click on the OK button. The Timeslot Assignments form closes.

8 Click on the OK button. The Physical Port [Edit] form closes. 

Procedure 12-11  To discover the optical transport services

Transport Services are not discovered automatically during NE discovery. Perform this 
procedure after all 1830 PSS NEs are synchronized in 5620 SAM.

1 Choose Manage→Service→Services from the 5620 SAM main menu. The Manage 
Services form opens.

2 Click on the Discover Transport Services button. The Discover Transport Services 
form opens. A list of topology groups are displayed.

3 Choose the appropriate physical topology group that contains 1830 PSS services 
that require discovery.

Client signal type ODU0 XC 
(default)

ODU1 XC (TS) ODUFlex XC (TS) OPTSG XC (TS)

FC100 1 � � �

OC3/STM1 1 � � 1

OC12/STM4 1 � � 4

GbE 1 � � �

SDSDI 1 � � �

FE 1 � � �

OTU1 � 2 � �

OC48/STM64 � 2 � �

HDSDI � 2 � �

FC200 � 2 � �

FC400 � � 4 �

3GSDI � � 3 �
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4 Click on the OK button to discover the service. All services within the group are 
discovered. The discovered 1830 PSS services are displayed on the Manage 
Services form.

Procedure 12-12  To unmanage an optical transport service

The user can unmanage an optical transport service using the 5620 SAM. The Unmanage 
Service operation will remove the Transport Service from the 5620 SAM. The service 
configuration on the NE is maintained as is.

1 Choose Manage→Service→Services from the 5620 SAM main menu.

2 Choose Optical Transport Service from the drop-down menu.

3 The Unmanage Service button appears. 

4 Choose one or more transport services, and click on the Unmanage Services 
button.

Procedure 12-13  To display services riding on external or internal 
optical links

1 From the Physical Topology - Network view, double-click on an external or 
internal optical link.

2 The Physical Link Group List form opens.

3 Select an external or internal optical link and click on Properties. The Optical link 
[Edit] form opens.

Note 1 � For very large networks, this process may take time to 
complete.

Note 2 � The following services can be discovered by the 5620 SAM:

• ESNCP Protected
• OPS Protected
• Unprotected 
• Y-cable Protected

Note �  Before unmanaging the 1830 PSS NE, the user must unmanage 
or delete all transport services on that NE. The user needs to re-enter 
the service name once the service is re-discovered.
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4 Choose the Optical Services tab and click on Search. A list of optical services riding 
on the selected link, are displayed.

5 Select a service and click on Properties, the Optical Transport Service [Edit] form 
opens and displays the properties of the service.

12.8 Managing optical power levels using the Wavelength 
Tracker

The wavelength tracker is an Alcatel-Lucent technology that allows the 1830 PSS 
NE to manage wavelengths at different stages of an optical path.

Each wavelength can be traced as it passes through the network, which allows you 
to ensure that the network connections are correct. A unique identifier, known as a 
wave key pair, is encoded onto each wavelength that enters the network through a 
1830 PSS device. By detecting and identifying the encoded wave keys, the 
wavelength can be traced through the network. Tables 12-4, 12-5, and 12-6 list the 
ITU channel numbers and corresponding ALU wave keys for the L-band, C-band, 
and S-band channels.

Table 12-4 L-band channel wavekeys

Note 1 � You can view optical services on an OCH cross connect. Right 
click on the NE→Properties→OCH CrossConnects→Select a cross 
connect→Properties. The OCH Cross Connect [Edit] form is displayed. 
Choose the Optical Services tab to view the optical services on the 
selected cross connect.

Note 2 � You can also view optical services on ports from the Physical 
Port [Edit] form by selecting the Optical Services tab.

Note 3 � The services must be discovered in 5620 SAM to be able to 
view services on the external and internal optical links, the OCH cross 
connect and the ports.

ITU channel 
number 
(THz)

nm ALU channel 
number

ITU channel 
number 
(THz)

nm ALU channel 
number

100 GHz Grid 50 GHz Offset

186.00 1611.79 8600 186.05 1611.35 8605

186.10 1610.92 8610 186.15 1610.49 8615

186.20 1610.06 8620 186.25 1609.62 8625

186.30 1609.19 8630 186.35 1608.76 8635

186.40 1608.33 8640 186.45 1607.90 8645

186.50 1607.47 8650 186.55 1607.04 8655

(1 of 3)
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186.60 1606.60 8660 186.65 1606.17 8665

186.70 1605.74 8670 186.75 1605.31 8675

186.80 1604.88 8680 186.85 1604.46 8685

186.90 1604.03 8690 186.95 1603.60 8695

187.00 1603.17 8700 187.05 1602.74 8705

187.10 1602.31 8710 187.15 1601.88 8715

187.20 1601.46 8720 187.25 1601.03 8725

187.30 1600.60 8730 187.35 1600.17 8735

187.40 1599.75 8740 187.45 1599.32 8745

187.50 1598.89 8750 187.55 1598.47 8755

187.60 1598.04 8760 187.65 1597.62 8765

187.70 1597.19 8770 187.75 1596.76 8775

187.80 1596.34 8780 187.85 1595.91 8785

187.90 1595.49 8790 187.95 1595.06 8795

188.00 1594.64 8800 188.05 1594.22 8805

188.10 1593.79 8810 188.15 1593.37 8815

188.20 1592.95 8820 188.25 1592.52 8825

188.30 1592.10 8830 188.35 1591.68 8835

188.40 1591.26 8840 188.45 1590.83 8845

188.50 1590.41 8850 188.55 1589.99 8855

188.60 1589.57 8860 188.65 1589.15 8865

188.70 1588.73 8870 188.75 1588.30 8875

188.80 1587.88 8880 188.85 1587.46 8885

188.90 1587.04 8890 188.95 1586.62 8895

189.00 1586.20 8900 189.05 1585.78 8905

189.10 1585.36 8910 189.15 1584.95 8915

189.20 1584.53 8920 189.25 1584.11 8925

189.30 1583.69 8930 189.35 1583.27 8935

189.40 1582.85 8940 189.45 1582.44 8945

189.50 1582.02 8950 189.55 1581.60 8955

189.60 1581.18 8960 189.65 1580.77 8965

189.70 1580.35 8970 189.75 1579.93 8975

189.80 1579.52 8980 189.85 1579.10 8985

189.90 1578.69 8990 189.95 1578.27 8995

ITU channel 
number 
(THz)

nm ALU channel 
number

ITU channel 
number 
(THz)

nm ALU channel 
number

100 GHz Grid 50 GHz Offset

(2 of 3)
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Table 12-5 C-band channel wavekeys

190.00 1577.86 9000 190.05 1577.44 9005

190.10 1577.03 9010 190.15 1576.61 9015

190.20 1576.20 9020 190.25 1575.78 9025

190.30 1575.37 9030 190.35 1574.95 9035

190.40 1574.54 9040 190.45 1574.13 9045

190.50 1573.71 9050 190.55 1573.30 9055

190.60 1572.89 9060 190.65 1572.48 9065

190.70 1572.06 9070 190.75 1571.65 9075

190.80 1571.24 9080 190.85 1570.83 9085

190.90 1570.42 9090 190.95 1570.01 9095

ITU channel 
number 
(THz)

nm ALU channel 
number 

ITU channel 
number 
(THz)

nm ALU channel 
number

100 GHz Grid 50 GHz Offset

191.00 1569.59 9100 191.05 1569.18 9105

191.10 1568.77 9110 191.15 1568.36 9115

191.20 1567.95 9120 191.25 1567.54 9125

191.30 1567.13 9130 191.35 1566.72 9135

191.40 1566.31 9140 191.45 1565.90 9145

191.50 1565.50 9150 191.55 1565.09 9155

191.60 1564.68 9160 191.65 1564.27 9165

191.70 1563.86 9170 191.75 1563.45 9175

191.80 1563.05 9180 191.85 1562.64 9185

191.90 1562.23 9190 191.95 1561.83 9195

192.00 1561.42 9200 192.05 1561.01 9205

192.10 1560.61 9210 192.15 1560.20 9215

192.20 1559.79 9220 192.25 1559.39 9225

192.30 1558.98 9230 192.35 1558.58 9235

192.40 1558.17 9240 192.45 1557.77 9245

192.50 1557.36 9250 192.55 1556.96 9255

192.60 1556.55 9260 192.65 1556.15 9265

192.70 1555.75 9270 192.75 1555.34 9275

(1 of 2)

ITU channel 
number 
(THz)

nm ALU channel 
number

ITU channel 
number 
(THz)

nm ALU channel 
number

100 GHz Grid 50 GHz Offset

(3 of 3)
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192.80 1554.94 9280 192.85 1554.54 9285

192.90 1554.13 9290 192.95 1553.73 9295

193.00 1553.33 9300 193.05 1552.93 9305

193.10 1552.52 9310 193.15 1552.12 9315

193.20 1551.72 9320 193.25 1551.32 9325

193.30 1550.92 9330 193.35 1550.52 9335

193.40 1550.12 9340 193.45 1549.72 9345

193.50 1549.32 9350 193.55 1548.91 9355

193.60 1548.51 9360 193.65 1548.11 9365

193.70 1547.72 9370 193.75 1547.32 9375

193.80 1546.92 9380 193.85 1546.52 9385

193.90 1546.12 9390 193.95 1545.72 9395

194.00 1545.32 9400 194.05 1544.92 9405

194.10 1544.53 9410 194.15 1544.13 9415

194.20 1543.73 9420 194.25 1543.33 9425

194.30 1542.94 9430 194.35 1542.54 9435

194.40 1542.14 9440 194.45 1541.75 9445

194.50 1541.35 9450 194.55 1540.95 9455

194.60 1540.56 9460 194.65 1540.16 9465

194.70 1539.77 9470 194.75 1539.37 9475

194.80 1538.98 9480 194.85 1538.58 9485

194.90 1538.19 9490 194.95 1537.79 9495

195.00 1537.40 9500 195.05 1537.00 9505

195.10 1536.61 9510 195.15 1536.22 9515

195.20 1535.82 9520 195.25 1535.43 9525

195.30 1535.04 9530 195.35 1534.64 9535

195.40 1534.25 9540 195.45 1533.86 9545

195.50 1533.47 9550 195.55 1533.07 9555

195.60 1532.68 9560 195.65 1532.29 9565

195.70 1531.90 9570 195.75 1531.51 9575

195.80 1531.12 9580 195.85 1530.72 9585

195.90 1530.33 9590 195.95 1529.94 9595

ITU channel 
number 
(THz)

nm ALU channel 
number 

ITU channel 
number 
(THz)

nm ALU channel 
number

100 GHz Grid 50 GHz Offset

(2 of 2)
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Table 12-6 S-band channel wavekeys

ITU channel 
number 
(THz)

nm ALU channel 
number

ITU channel 
number 
(THz)

nm ALU channel 
number

100 GHz Grid 50 GHz Offset

196.00 1529.55 9600 196.05 1529.16 9605

196.10 1528.77 9610 196.15 1528.38 9615

196.20 1527.99 9620 196.25 1527.60 9625

196.30 1527.22 9630 196.35 1526.83 9635

196.40 1526.44 9640 196.45 1526.05 9645

196.50 1525.66 9650 196.55 1525.27 9655

196.60 1524.89 9660 196.65 1524.50 9665

196.70 1524.11 9670 196.75 1523.72 9675

196.80 1523.34 9680 196.85 1522.95 9685

196.90 1522.56 9690 196.95 1522.18 9695

197.00 1521.79 9700 197.05 1521.40 9705

197.10 1521.02 9710 197.15 1520.63 9715

197.20 1520.25 9720 197.25 1519.86 9725

197.30 1519.48 9730 197.35 1519.09 9735

197.40 1518.71 9740 197.45 1518.32 9745

197.50 1517.94 9750 197.55 1517.55 9755

197.60 1517.17 9760 197.65 1516.78 9765

197.70 1516.40 9770 197.75 1516.02 9775

197.80 1515.63 9780 197.85 1515.25 9785

197.90 1514.87 9790 197.95 1514.49 9795

198.00 1514.10 9800 198.05 1513.72 9805

198.10 1513.34 9810 198.15 1512.96 9815

198.20 1512.58 9820 198.25 1512.19 9825

198.30 1511.81 9830 198.35 1511.43 9835

198.40 1511.05 9840 198.45 1510.67 9845

198.50 1510.29 9850 198.55 1509.91 9855

198.60 1509.53 9860 198.65 1509.15 9865

198.70 1508.77 9870 198.75 1508.39 9875

198.80 1508.01 9880 198.85 1507.63 9885

198.90 1507.25 9890 198.95 1506.87 9895

199.00 1506.49 9900 199.05 1506.12 9905

199.10 1505.74 9910 199.15 1505.36 9915

199.20 1504.98 9920 199.25 1504.60 9925

(1 of 2)
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In addition, the Wavelength Tracker can measure the optical power level at each 
detection point for each encoded channel that passes through a port on a 1830 PSS 
device. The 5620 SAM power management feature uses the wavelength tracker 
feature and other equipment readings to provide a graphical representation of power 
levels and a mechanism to track changes in the network. 

For more information about the Wavelength Tracker tool, see the Alcatel-Lucent 
1830 Photonic Service Switch User Provisioning Guide and the Alcatel-Lucent 
1830 Photonic Service Switch Product Information and Planning Guide.

Service power graph
The Service power management graph displays all the points along the service path, 
on a single channel, for the selected direction. See Figure 12-2 for more information.

199.30 1504.23 9930 199.35 1503.85 9935

199.40 1503.47 9940 199.45 1503.10 9945

199.50 1502.72 9950 199.55 1502.34 9955

199.60 1501.97 9960 199.65 1501.59 9965

199.70 1501.21 9970 199.75 1500.84 9975

199.80 1500.46 9980 199.85 1500.09 9985

199.90 1499.71 9990 199.95 1499.34 9995

200.00 1498.96 2000 200.05 1498.59 2000

200.10 1498.21 2001 200.15 1497.84 2001

200.20 1497.46 2002 200.25 1497.09 2002

200.30 1496.72 2003 200.35 1496.34 2003

200.40 1495.97 2004 200.45 1495.60 2004

200.50 1495.22 2005 200.55 1494.85 2005

200.60 1494.48 2006 200.65 1494.11 2006

200.70 1493.73 2007 200.75 1493.36 2007

200.80 1492.99 2008 200.85 1492.62 2008

200.90 1492.25 2009 200.95 1491.88 2009

ITU channel 
number 
(THz)

nm ALU channel 
number

ITU channel 
number 
(THz)

nm ALU channel 
number

100 GHz Grid 50 GHz Offset

(2 of 2)
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AutoKeying (NMS) is the only wavekey assign mode, (see Procedure 12-1 for more 
information), supported for services originating on the SR and traversing through a 
network of PSSs. The 5620 SAM assigns the wavekeys on the SR DWDM ports and 
on the PSS cross connects to ensure that the encoded wavekeys on the SR DWDM 
ports are the same as on the PSS. If the user changes the wavekeys using the WebUI 
or CLI interface, the user needs to ensure that the same wavekeys are assigned to 
respective SR source ports, in order to view the power levels accurately on the 
1830 PSS encoder and decoder points. 

The color legends used on the service power graph are as follows:

• Green indicates it is within range
• Orange indicates out of range (OoR but within the graph interval which ranges 

from -30 to +10
• White indicates, the power levels are -99 and less than -30
• Black indicates the power levels are -99

Figure 12-2  Service power graph

Note �  The 5620 SAM does not allow manual modification of wave 
keys. This modification has to be done using the WebUI or CLI 
interface. 
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Port power graph
The port power graph displays three power values for each wavelength (direction (IN 
or OUT) and a port) as follows:

• measured power—a measurement that provides the current power level
• expected power—a provisioned value that indicates to the NE what power level 

should be achieved
• expected power deviation—a provisioned value that represents the deviation 

from the expected power level that is considered healthy

In automatically powered equipment, the expected power and deviation values are 
determined by SCOT. In manually powered equipment, the user can change these 
values.

Optical power levels are represented by bars, and the high and low watermarks are 
represented by a Z bar. Figure 12-3 shows a port optical power graph.

The color legends used on the port power graph are as follows:

• Green for within range
• Orange for out of range (OoR, but within the graph interval which ranges from 

–30 to +10)

Figure 12-3  Port power graph
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12.9 Procedures to manage optical power levels

The following procedures describe how to manage optical power levels. 

Procedure 12-14  To display optical power levels along a service path

1 Choose Manage→Service→Services from the 5620 SAM main menu. The Manage 
Services form opens.

2 Choose Optical Transport Service from the object type drop-down menu and click 
on the Search button. A list of managed optical transport services is displayed.

3 Choose a service and click on the Properties button. The Optical Transport Service 
[Edit] form opens.

4 Choose Service Paths→Service Path. The Service Path properties form opens. Click 
on one of the following buttons:

• Power A to Z
• Power Z to A

If these buttons are not visible, click on the More Actions button and choose the 
corresponding option from the drop-down menu.

The optical power level graph opens, displaying all the points along the service 
path for the selected direction.

Note �  Power adjustments are supported for the following 
configurations:

• SR–PSS services (also supports SR DWDM tunable OTs)
• PSS–PSS services, where there is a drop shelf OT at the endpoints 

of the service
• PSS–PSS services, where there is an internal PSS OT but has a 

manual power adjustment
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Procedure 12-15  To refresh the optical power graph display

1 Open an optical power graph. See Procedure 12-14 for more information.

2 Choose the number of seconds between refreshes from the Real-time Polling 
Interval (Seconds) drop-down menu.

3 Perform one of the following:

a To configure an automatic refresh, choose the number of seconds between 
refreshes from the Real-Time Polling Interval (Seconds) drop-down menu and 
click on the Auto-refresh power chart icon.

The optical power graph updates at the configured time interval.

b To manually refresh the optical power graph, click on the Refresh power 
chart button, the latest power readings for all points, are displayed.

The optical power graph is refreshed and the Last refresh time is displayed.

Procedure 12-16  To configure auto power adjustment rules

The Auto Power Adjustment Rules allow users to configure parameters to adjust power 
levels for optical transport services between the source port and the target port. 

1 Choose Manage→Service→Services from the 5620 SAM main menu. The Manage 
Services form opens.

2 Choose Optical Transport Service from the object type drop-down menu and click 
on the Search button. A list of managed optical transport services is displayed.

3 Choose a service and click on the Properties button. The Optical Transport Service 
[Edit] form opens.

4 Choose Service Paths→Service Path. The Service Path properties form opens.

5  Click on the Search button in the Auto Power Adjustment Rules panel. A list of 
rules is displayed. 

6 Choose a rule and click on the Properties button. The Power Adjustment Rule 
[Edit] form opens.

7 Configure the parameters:

• Source Port
• Target Port

Note �  Power converge parameters for source and destination ports 
can be configured using the auto power adjustment rules. For example, 
the 7750 SR source port, which is the SR DWDM tunable power control 
enabled transponder port that can encode wavekeys, and the 1830 PSS 
target port which is the cross-connected egress amplifier port that can 
decode wavekeys, for a channel in A→Z or Z→A. 
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In the Source Port panel, configure:

• Initial Target Power (dB)
• Power Converge Wait Time (seconds)
• Power Converge Retries
• Power Converge Deviation (dB)

In the Target Port panel, configure:

• Power Converge Deviation (dB)

8 Click on OK to apply the changes and close the Power Adjustment Rule [Edit] form.

9 Click on the Power Working A to Z or Power Working Z to A button. If these buttons 
are not visible, click on the More Actions button and choose the corresponding 
option from the drop-down menu. The Discovered Service Power A to Z or Z to A 
form opens.

10 Click on the Auto Power Adjustment button to implement automatic power 
adjustment. A dialog box opens. 

11 Click on the Yes button. The automatic power adjustment process starts and the 
status button next to the Auto Power Adjustment button changes from Not 
Executed to In Progress.

Procedure 12-17  To manage expected power level and deviation at 
a Wavelength Tracker detection point

1 Choose Equipment from the view selector in the navigation tree. The navigation 
tree displays the Equipment view.

2 Right-click on a port object in the Equipment view and choose Properties from the 
contextual menu. The Physical Port (Edit) form opens with the General tab 
displayed.Table 12-7 lists the ports that support the Wavelength Tracker.

Table 12-7 Wavelength Tracker-enabled ports

Note �  To terminate the automatic power adjustment process, click 
on the Auto Power Adjustment button. A dialog box opens. Click Yes and 
the automatic power adjustment process stops. The Auto Power 
Adjustment button now changes to Abort Power Adjustment and the 
status button changes from In Progress to Aborted.

Card Port Direction

Decoder Ports

(1 of 2)
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A2325A
AHPHG
AHPLG
ALPHG
AM2017B
AM2325B

LINE IN, OUT

SIG OUT

DCM OUT

AM2125A LINEIN IN

LINEOUT OUT

CWR8
CWR8-88

SIG IN, OUT

THRU OUT

OMD IN

CLS (1 to 8) IN, OUT

OPSA, Protection Mode = OCHP or OMSP only SIG IN

A IN

B IN

Encoder Ports

112SCA1 L1 OUT

112SCX10 L1 OUT

11DPE12
11DPE12E

VA (1 to 2) OUT

11QPA4 VA (1 to 4) OUT

11STAR1 L1 OUT

11STAR1A L1 OUT

11STGE12 L1 OUT

11STMM10 L1 OUT

43SCX4
43SCX4E

L1 OUT

43STA1P L1 OUT

43STX4
43STX4P

L1 OUT

4DPA4 VA (1 to 2) OUT

MVAC G (1 to 8) OUT

SVAC L1 OUT

Other Ports

WTOCM IN (1 to 4) IN

Card Port Direction

(2 of 2)
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3 Perform one of the following:

a Click on the Choose Power Management In button to view the detection point 
power levels for the inbound optical light path. The Port Power Management 
power chart for the inbound optical light path opens.

b Click on the Choose Power Management Out button to view the detection 
point power levels for the outbound optical light path. The Port Power 
Management power chart for the outbound optical light path opens.

If these buttons are not visible, click on the More Actions button and choose the 
corresponding option from the drop-down menu.

4 To set the expected power level for a channel, right-click and choose properties 
or double click on the Z bar to set the expected power levels so that the expected 
power level value falls in the middle of the Z bar.

5 Right-click on the Z bar and choose Set Power Deviation from the contextual 
menu. The Set Power Deviation for channel form is displayed.

6 To set the power deviation, perform one of the following:

a Enter a deviation value between 0 and 5 and click the Apply button.

b Drag the slide bar left or right to choose a deviation value and click the Apply 
button.

The Set Power Deviation for channel form closes and the size of the Z bar increases or 
decreases based on the configured deviation value.

Procedure 12-18  To export optical power graph data to a CSV file

1 Choose Equipment from the view selector in the navigation tree. The navigation 
tree displays the Equipment view.

2 Right-click on a port object in the Equipment view and choose Properties from the 
contextual menu. The Physical Port (Edit) form opens with the General tab 
displayed.

3 Perform one of the following:

a Click on the Choose Power Management In button to view the detection point 
power levels for the inbound optical light path. The Port Power Management 
power chart for the inbound optical light path opens.

b Click on the Choose Power Management Out button to view the detection 
point power levels for the outbound optical light path. The Port Power 
Management power chart for the outbound optical light path opens.

If these buttons are not visible, click on the More Actions button and choose the 
corresponding option from the drop-down menu.
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4 Click on the export power values to CSV file button. The Save As window opens.

5 Choose the appropriate location for the file and click the Save button. The Save 
As window closes and the CSV file that contains the optical power level data is 
saved.

12.10 OTN Trails

The OTN is a fiber-optic network designed to transport customer traffic through an 
SDH or a SONET network. You can manage, create, or delete OTN trails using the 
5620 SAM GUI. 

Procedure 12-19  To create an ODU trail

1 Choose Manage→OTN Trails from the 5620 SAM main menu. The Manage OTN 
Trails form opens.

2 Choose the Create→Create ODU Trail. The Optical Connection, ODU Trail Creation 
[Create] form opens.

3 Configure the parameters in the Connection Info panel:

• Rate
• OTU1
• OTU2
• OTU3
• OTU4

• Wave Key Assign Mode
• Auto Keying (NE)
• Auto Keying (NMS)
• Unkeyed

• Bidirectional
• Admin State
• Protection State 

4 Choose the endpoints for Port A and Port Z in the EndPoint Ports A and Z panel.

5 Click on Select Port A or Port Z button. The Select Port A or Z- Optical Connection 
- ODU Trail Creation form opens. 

6 Click on the Search tab. A list of ports are displayed

7 Choose a port and click on the OK button. The Select Port A or Z- Optical 
Connection - ODU Trail Creation form closes and the Optical Connection, ODU 
Trail Creation [Create] form reappears.

Note 1 � You can create ODU trails between 1830 PSS NEs and between 
core NEs such as the 7750 SR.

Note 2 � Auto Keying (NE) is not supported on the 7750 SR.
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8 Choose Create in the Path Constraints panel. The Constraint [Create] form opens. 

9 Configure the parameters:

• Constraint Type
• Exclusion
• Inclusion

• Constraint Element
• Port 
• Site
• Trail

10 Choose one of the following:

a Port

i Click on the Select tab. The Select Port�Constraint null form opens.

ii Click on the Search button. A list of ports are displayed.

iii Choose a port and click on the OK tab. The form closes and the 
Constraint null [Create] form reappears.

b Site

i Click on the Select tab. The Select Site�Constraint null form opens.

ii Click on the Search button. A list of sites are displayed.

iii Choose a site and click on the OK tab. The form closes and the 
Constraint null [Create] form reappears.

c Trail

i Click on the Select tab. The Select Trail�Constraint null form opens.

ii Click on the Search button. A list of trails are displayed.

iii Choose a trail and click on the OK tab. The form closes and the 
Constraint null [Create] form reappears.

11 Click on the OK button. The Optical Connection, ODU Trail Creation [Create] form 
closes. 

Note �  Path Constraint configuration is optional to the user.

Note �  When the ODU trail is created, the OCH trails are automatically 
created.
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Procedure 12-20  To delete an ODU trail

1 Choose Manage→OTN Trails from the 5620 SAM main menu. The Manage OTN 
Trails form opens.

2 Choose ODU Trail (Optical Management) from the OTN Trail (Optical Management) 
drop-down menu. 

3 Click on the Search button. The ODU trails are listed. 

4 Choose the trail that you need to delete and click on the Delete button. A dialog 
box opens if the services are riding on an ODU trail.

5 Click on the Yes button. The ODU trail is deleted.

Procedure 12-21  To configure an ODU trail

1 Choose Manage→OTN Trails from the 5620 SAM main menu. The Manage OTN 
Trails form opens.

2 Choose ODU Trail (Optical Management) from the OTN Trail (Optical Management) 
drop-down menu.

3 Click on the Search button to list the ODU trails. 

4 Choose an ODU trail and click on the Properties tab. The ODU Trail [Edit] form 
opens.

5 Configure the parameters as required. See the 5620 SAM Optical Parameter 
Reference and the 5620 SAM Parameter Guide for more information.

6 Click on the Apply button to save the changes. 

7 Click on the OK button to close the ODU Trail [Edit] form.

Note 1 � When an ODU trail is deleted, OCH trails and OCH cross 
connects are deleted. Services are not deleted.

Note 2 � If services are riding on an ODU trail, the ODU trail is not 
deleted. An error message is displayed.
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Procedure 12-22  To view the optical channel usage

1 Choose Manage→OTN Trails from the 5620 SAM main menu. The Manage OTN 
Trails form appears.

2 Choose Optical Channel Usage (Optical Management) from the OTN Trail (Optical 
Management) drop-down menu, and click on the Search button. The optical 
channel usage list appears.

Procedure 12-23  To create an ODUk XC on the 11DPM12 card

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Right-click on the NE where you want to create the ODUk cross connects and select 
Properties from the contextual menu. The Network Element (Edit) form opens 
with the General tab displayed.

3 On the Network Element [Edit] form navigation tree, expand the Shelf icon.

4 Right-click on the card and select Properties from the contextual menu. The Card 
Slot [Edit] form opens. 

5 Click on the ODU1PTF Objects tab. A list of ODU1PTF cross connects are displayed.

6 Select an ODU1PTF cross connect and click on Properties. The ODU1PTF [Edit] 
form opens.

7 Click on the Associate Line Side LO-ODUk Facility tab. The ODU1Ptf Association 
with Line side LO-ODUk [Create] form opens. 

8 Click on Select in the Line Side LO-ODUk Facility panel. The Select Line Side 
LO-ODUk Facility form opens with a list of available Line Side LO-ODUks.

9 Select a Line Side LO-ODUk Facility and click the OK button. The ODU1Ptf 
Association with Line side LO-ODUk [Create] form reappears.

10 Choose a Direction from the drop-down menu.

11 Click on the OK or Apply button. A dialog box appears. Select the check box and 
click on Yes. This action results in changing the cross-connects on the NE, 
associates the client port and the line port, and creates the ODUk XC.
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Procedure 12-24  To delete an ODUk XC on the 11DPM12 card

1 Choose Equipment from the navigation tree view selector. The navigation tree 
displays the Equipment view.

2 Right-click on the NE where you want to delete the ODUk XC and select Properties 
from the contextual menu. The Network Element (Edit) form opens with the 
General tab displayed.

3 Click on the ODUk Cross Connects tab. A list of ODUk XCs are displayed. Select the 
cross connect to be deleted and click on the Delete button. A dialog box appears. 
Select the check box and click on Yes. This action results in deleting the ODUk XC 
which disassociates the client port from the line port. 
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13.1 Troubleshooting overview

Fault management is a set of functions that allows detection, isolation, and correction 
of abnormal operations in a telecommunication network. Alarm reporting is the 
notification sent to external management systems for internally detected faults. The 
fault processing and alarm reporting functions are part of the supervision function of 
the NE that monitors and manages the NE transmission resources (logical or physical 
facilities and the associated equipment modules).

13.2 Fault management

The 1830 PSS-32 / 1830 PSS-16 is provisionable on a per-port basis to detect 
process, report faults, failures, and performance. Equipment faults can be diagnosed 
down to an FRU or interface. 

There is one system default alarm profile that contains all alarms or conditions 
supported in the system and their severity, Critical, Major, Minor. The user can 
change the severity of alarms on each port or facility independently or point to the 
system profile. The system profile can be modified or reset to factory defaults.

The 5620 SAM correlates the events and alarms against the managed equipment and 
configured services and policies. The 5620 SAM applies the alarms against the 
appropriate equipment and services. A correlated alarm refers to an alarm that causes 
fault conditions for many objects. For example, if an alarm occurs because a port 
goes down, all services that use the port receive notification of the alarm. 

You can view the alarm from the service configuration form or from the subscriber 
information form that lists the affected service. All object information forms contain 
a faults tab, which lists the alarms that affect the object. All alarms appear in the 
alarm list of the 5620 SAM GUI. See the 1830 Photonic Service Switch 36/32/16 
Product Information and Planning Guide, the 5620 SAM User Guide, and the 
5620 SAM Troubleshooting Guide for more information about fault and alarm 
management. See the 5620 SAM Alarm Reference for a list of the alarms that the 
5620 SAM can raise against the 1830 PSS.

User activity logging

The 5620 SAM logs each GUI and OSS user action, such as 1830 PSS object 
configuration, in the 5620 SAM database. The User Activity form lists the recent 
actions; older actions are purged according to configurable retention limits. For more 
information about the user activity log and configuring the log retention, see the 
5620 SAM User Guide.
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13.3 Ethernet OAM

The 5620 SAM supports Ethernet OAM on the 11QPE24 card on the Ethernet 
Optical transport services, such as 802.1ag, Y.1731 and 802.3ah. Ethernet OAM 
defines the Operations, Administration, and Maintenance sub-layer, which is used 
for monitoring link operations such as remote fault indication and remote loopback 
control. OAM provides network operators the ability to monitor the health of the 
network and determine the location of failing links or fault conditions. EFM OAM 
provides data link layer mechanisms that complement applications that may reside 
in higher layers.

OAM information is transported in slow protocol frames which are called OAM 
protocol data units (OAMPDUs). OAMPDUs contain the appropriate control and 
status information used to monitor, test and troubleshoot EFM OAM-enabled links. 
OAMPDUs traverse a single link, that is passed between peer OAM entities, and are 
not forwarded by MAC clients (like bridges or switches), unless configured.

The following EFM OAM functions are supported on the11QPE24 card:

See the 5620 SAM User Guide for more information.

Ethernet CFM
Ethernet Connectivity Fault Management (CFM) supports end-to-end service 
management in an L2 network. CFM tools provide path discovery and fault 
detection, isolation, and notification. See the 5620 SAM User Guide for more 
information about how to configure an IEEE 802.1ag-enabled network for Ethernet 
CFM.

Table 13-1 lists the supported Ethernet CFM test types, the objects against which the 
tests can be performed, the test types, and the network layer being tested.

Table 13-1 Ethernet CFM test types and test objects

The following CFM diagnostic tests detect connectivity failure.

• EFM OAM capability discovery
• active and passive modes
• remote failure indication

• local and remote loopbacks
• EFM OAMPDU tunneling
• high-resolution EFM OAM timers 

(500 ms interval)

Network level Test type Network object or service 
component for test

Ethernet CFM Loopback SAP or Ethernet Ring Path End 
Point

CFM Link trace

CFM Two Way Delay

CFM Two Way Synthetic Loss 
Measurement (SLM)
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CFM loopback

CFM loopback messages are sent to a unicast destination MAC address. The MEP at 
the destination responds to the loopback message with a loopback reply. A MEP or 
a MIP can reply to a loopback message if the destination MAC address matches the 
MAC address of the MEP or MIP. CFM loopback tests verify connectivity to a 
specific MEP or MIP.

CFM link trace

CFM link trace messages that contain a target unicast MAC address are sent to 
multicast destination MAC addresses. Each MIP at the same MD level replies with 
a link trace response. Messages are forwarded to the next hop until they reach the 
destination MAC address. The originating MEP collects the replies to determine the 
path.

CFM two-way delay

The CFM two-way delay test applies only to Y.1731 MEPs. In this test, the frame 
delay is defined as the time elapsed since the start of transmission of the first bit of 
the frame by the source site until the frame is received by the same site after passing 
through the destination site. The frame delay represents the round-trip time between 
the source and destination sites.

CFM two-way SLM

The CFM two-way SLM test provides Synthetic Loss Measurement and it is used to 
check the packet loss.

13.4 Alarm management

The alarm-based fault management system provides the following:

• the correlation of alarms with equipment- and service-affecting faults
• updates to the managed-object operational status of equipment, services and 

interfaces in near-real-time
• alarm policy control that allows a network administrator to specify how to 

process alarms and how to create and store the alarm logs
• point-and-click alarm management using the 5620 SAM GUI dynamic alarm list 

and object properties forms
• the ability to log the actions taken to correct the associated fault by adding notes 

to the alarm
• an alarm history for performing trend analysis

See the 5620 SAM User Guide, the 5620 SAM Alarm Reference, and 1830 Photonic 
Service Switch 36/32/16 User Provisioning Guide for more information.
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Alarm status, severity, and aggregation

Alarm status for the network is indicated in the navigation tree, the dynamic alarm 
list, and on the topology maps. You can use the navigation tree to view the status of 
an alarm raised against a specific object and to view the aggregated alarm status. The 
aggregated alarm status is also available on the Faults tab of an object property form. 
See the 5620 SAM User Guide for more information about aggregation and object 
alarms.

Alarm severity profiles can be configured at the NE, shelf, card slot and interface 
level. See the 5620 SAM User Guide for more information.

Alarm suppression

The 5620 SAM does not raise alarms when numerous SNMP traps are sent in quick 
succession for the same type of event. This prevents alarm storms during intermittent 
outages in the network caused by bouncing NEs; for example, when links go up and 
down rapidly. The 5620 SAM continues to resynchronize the network, and if the 
bouncing NEs continue to send down state SNMP traps, the 5620 SAM eventually 
receives the trap and generates the appropriate alarm.

To indicate how often an alarm is raised, the number of occurrences of each instance 
of the alarm is tracked within the alarm record of the initial alarm. Click on the 
Statistics tab of an individual Alarm Info form to see how often the alarm was raised. 
See the 5620 SAM User Guide for more information.
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Customer documentation and product support

Customer documentation
http://www.alcatel-lucent.com/myaccess
Product manuals and documentation updates are available at 
alcatel-lucent.com. If you are a new user and require access to this 
service, please contact your Alcatel-Lucent sales representative.

Technical Support
http://support.alcatel-lucent.com

Documentation feedback
documentation.feedback@alcatel-lucent.com
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